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Введение 
В настоящее время имеется обширная литература по теории и методам синтеза раз-

личных типов фильтров СВЧ. Разработанные методы синтеза многих структур фильтров 
СВЧ (например, на основе фильтров-прототипов нижних частот, ступенчатых трансформа-
торов, использования частотного преобразования Ричардса) позволяют синтезировать 
фильтры с высокой точностью на уровне электрических параметров (волновые сопротивле-
ния, электрические длины). Однако при переходе от электрических параметров фильтра к 
геометрическим параметрам топологии возникают определённые трудности, связанные с не-
достаточной точностью существующих моделей отрезков линий передач и различных неод-
нородностей, а также с проблемами учёта дисперсии, влияния корпуса, проводимости мате-
риала проводников и т.п., особенно в верхней части СВЧ диапазона. Это приводит к необхо-
димости экспериментальной отработки топологии на макетах фильтров. 

С появлением программных продуктов, позволяющих выполнять анализ топологии 
устройств СВЧ на электродинамическом уровне, ситуация изменилась. Появилась возмож-
ность так смоделировать топологию проектируемого фильтра, чтобы экспериментальная ха-
рактеристика хорошо совпадала с расчётной. 

Одним из популярных программных продуктов, используемых для проектирования 
микрополосковых устройств СВЧ, является Microwave Office компании Applied Wave Re-
search (AWR). Проектирование СВЧ фильтров в этом программном продукте в общем случае 
можно разделить на три этапа: 

• Выбор структуры фильтра в первом приближении. 
• Уточнение параметров выбранной структуры в линейном моделировании. 
• Окончательная доводка параметров топологии в электромагнитном моделировании. 

Поскольку Microwave Office является программой анализа, для начала работы в ней 
необходимо предварительно выбрать структуру фильтра и определить её параметры хотя бы 
в достаточно грубом приближении. Для некоторых структур фильтров, например, фильтров 
на четвертьволновых шлейфах, это сделать достаточно просто. Но для большинства структур 
(фильтров с боковыми электромагнитными связями, встречноштыревых и др.) необходимо 
сделать какие-то предварительные расчёты. Для некоторых типов фильтров можно исполь-
зовать встроенный в Microwave Office мастер синтеза фильтров (Filter Synthesis Wizard) или 
интегрированный модуль NuHertz Filter. 

После выбора структуры фильтра создаётся электрическая схема фильтра с учётом 
неоднородностей и выполняется анализ созданной схемы. Затем изменяются параметры эле-
ментов схемы до получения требуемой характеристики. Для этого можно использовать оп-
тимизацию схемы. Если полученная первоначально характеристика далека от требуемой, оп-
тимизация может не сработать. В этом случае лучше использовать инструмент ручной на-
стройки схемы, который сделан очень удобным и работает в режиме реального времени. 

Когда требуемая характеристика получена, создаётся электромагнитная структура то-
пологии фильтра с учётом реальных размеров корпуса и материалов диэлектрика и провод-
ников. Полученные в линейном моделировании размеры топологии округляются так, чтобы 
они были кратными выбранным размерам клеток сетки электромагнитной структуры. Вы-
полняется анализ созданной электромагнитной структуры. Полученная характеристика мо-
жет довольно существенно отличаться от характеристики, полученной в линейном модели-
ровании. 

После этого делаются изменения (подбор) размеров топологии и выполняется анализ 
после каждого изменения до тех пор, пока будет получена требуемая характеристика фильт-
ра. Не всегда очевидно, какие параметры топологии нужно изменять и в какую сторону, что-
бы приблизить полученную характеристику к требуемой. Если необходимо сдвинуть харак-
теристику по частоте, ясно, что нужно изменить резонансную частоту резонаторов (т.е. их 
длину). Чтобы изменить ширину полосы пропускания, необходимо изменить величину свя-
зей между резонаторами (например, величину зазоров в фильтрах с электромагнитной свя-
зью). Обычно, чем ближе характеристика к желаемой, тем сложнее определить, что нужно 



изменить в топологии, чтобы правильно подобрать соотношения между резонансными час-
тотами отдельных резонаторов, связями между ними и волновыми сопротивлениями. Эта 
процедура кропотливого подбора размеров топологии является наиболее трудоёмкой и дли-
тельной. Анализ электромагнитной структуры может занимать значительное время. Для ус-
корения процедуры электромагнитного моделирования можно рекомендовать вначале вы-
полнять анализ с относительно крупной сеткой и меньшим числом частотных точек. Затем 
увеличить количество клеток в сетке, уменьшив их размер, и увеличить число частот. При 
окончательной доводке топологии можно перейти от графика вносимого ослабления к гра-
фику коэффициента стоячей волны, который более чувствителен к изменениям параметров 
топологии. Затраченные усилия на кропотливый подбор размеров топологии окупается вы-
сокой точностью моделирования, при которой отпадает необходимость в экспериментальной 
отработке или она сводится к минимуму. 

Следует иметь в виду, что высокая точность электромагнитного моделирования обес-
печивается при условии, когда проводники топологии параллельны сетке разбиения, а раз-
меры топологических форм кратны размерам клеток сетки. Структуры типа, показанной на 
рис. 1, когда проводники расположены под углом к сетке, для получения точных результатов 
анализа требуют очень мелкой сетки. Это может привести к такому увеличению времени 

анализа, что оно становится непри-
емлемым. В таком случае подобные 
структуры лучше моделировать в 
программных продуктах с более гиб-
кой сеткой, например, в IE3D компа-

нии Zeland или CST Microwave Studio компании Computer Simulation Technology. 
Для широкополосных фильтров, если они спроектированы с запасом по ширине поло-

сы пропускания и крутизне скатов, обычно настройка не требуется. Узкополосные фильтры 
гораздо более чувствительны к технологическим разбросам и требуют настройки. При этом 
сдвинуть характеристику фильтра вверх по частоте сложнее, т.к. это требует укорочения 
(подрезки) резонаторов. Проще сдвинуть характеристику вниз по частоте, т.к. это можно 
сделать, например, приклеиванием узкой пластины из того же материала подложки, накла-
дываемой на все резонаторы фильтра. Поэтому узкополосные фильтры лучше проектировать 
заведомо выше требуемой полосы пропускания. Кроме того, должен быть предусмотрен за-
пас по ширине полосы пропускания. Регулировать ширину полосы пропускания характери-
стики можно, изменяя высоту от подложки до верхней крышки корпуса. При уменьшении 
этой высоты полоса пропускания уменьшается (обычно больше сдвигается в область верхних 
частот нижний скат характеристики фильтра). Однако этот метод не удобен для практиче-
ского применения. Оценить возможный разброс характеристики можно, выполнив статисти-
ческий анализ, имеющийся в линейном моделировании Microwave Office. 

Наиболее распро-
странённым материалом для 
подложек микрополосковых 
фильтров является поликор. 
Это анизотропный материал. 
Однако в Microwave Office 
не предусмотрено примене-
ние анизотропных материа-
лов. Поэтому в приводимых 
примерах проектирования 
фильтров на поликоре ис-
пользуются значения ди-
электрической проницаемо-
сти из графика (рис. 2), по-
лученного эксперименталь-
ным путём. Эти значения 
нельзя считать абсолютно 

Рис. 1 

Рис. 2 
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точными, поскольку результирующая диэлектрическая проницаемость зависит как от часто-
ты, так и от конструктивных параметров (размеров и структуры топологии, ширины полосок, 
расстояния между полосками в связанных линиях, толщины подложки). Для поликоровых 
пластин толщиной 0,5 и 1,0 мм значения, взятые из графика рис. 2, обычно дают расчётную 
характеристику более близкую к экспериментальной по сравнению со стандартным значени-
ем 9,8. Для более тонких пластин значения результирующей диэлектрической проницаемо-
сти, взятые из этого графика, видимо, будут завышены. Такая неопределённость в выборе 
значения диэлектрической проницаемости может стать одной из причин необходимости экс-
периментальной проверки спроектированного фильтра. Обычно для этого достаточно изго-
товления одного макета. 

В большинстве приводимых примерах проектирования фильтров СВЧ для подложек 
используются пластины из поликора. В этих примерах материал подложек не указывается. 
Если для подложки используется другой материал, то он указывается в примере проектируе-
мого фильтра. 

В некоторых примерах используется оптимизация схемы. При попытке повторить 
описанную процедуру оптимизации, её результат может отличаться от результата, получен-
ного в примере. Результат оптимизации зависит от выбора метода оптимизации, от началь-
ных установок для оптимизации и от принципа работы оптимизатора. Если оптимизатор вы-
бирает начальную точку случайным образом, то процесс оптимизации может сходиться к 
другому минимуму. Процедура синтеза фильтра путём подбора значений параметров схемы 
(что и делает оптимизатор) не является однозначной и характеристика, удовлетворяющая по-
ставленным требованиям, может быть получена при различных значениях этих параметров. 
При необходимости можно выполнить несколько вариантов оптимизации, используя различ-
ные методы оптимизации и при различных начальных значениях параметров. В Microwave 
Office имеется возможность запомнить все выполненные варианты оптимизации и затем вы-
брать лучший из них. Аналогично можно запомнить несколько вариантов ручной настройки 
схемы и выбрать лучший из них. Выполнять всё это имеет смысл в том случае, если есть 
уверенность, что схема с хорошей точностью отражает реальную топологию фильтра и мож-
но надеяться на уменьшение времени на доработку элементов топологии. 

В ряде примеров приводятся экспериментальные результаты для сравнения с расчёт-
ными данными. Характеристики макетов фильтров снимались на измерителе модуля коэф-
фициента передачи и отражения Р2М-18. Файл S-параметров, полученный на этом измерите-
ле, затем импортировался в Microwave Office для сравнения с расчётной характеристикой. 

Для моделирования фильтров в описываемых примерах использовалась Microwave 
Office версии 6.5.3. Обратите внимание, что при работе в Microwave Office раскладка клавиа-
туры должна быть английской. Использовать русские буквы можно в пояснениях к проекту, 
дважды щёлкнув мышкой по Design Notes в левом окне проекта. 

 
Е.Е. Дмитриев 

 



1. Заграждающие фильтры 

1.1. Фильтр с полосой заграждения 14 – 18 ГГц 
Спроектировать заграждающий фильтр, обеспечивающий ослабление сигнала не ме-

нее 35 дБ в диапазоне 14 – 18 ГГц и с полосой пропускания 1 – 10 ГГц. Для решения этой за-
дачи выберем трёхрезонаторный фильтр на четвертьволновых разомкнутых шлейфах на под-
ложке из поликора толщиной 0,5 мм. 

1.1.1. Определение параметров микрополосковой линии. 
Для создания в первом приближении схемы фильтра достаточно знать длину и шири-

ну четвертьволновых отрезков линии с волновым сопротивлением 50 Ом на средней частоте 
заграждения 16 ГГц. Эти параметры можно определить в Microwave Office следующим обра-
зом. 

1. Загрузите программу. Выберите в меню команду File>New Project и затем команду 
File>Save Project As… Сохраните проект под именем, например, Fz14-18. Это имя 

появится в строке заго-
ловка основного окна 
программы. 
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2. Выберите в меню ко-
манду Tools>TXLine и в 
появившемся диалого-
вом окне (рис. 1.1) от-
кройте вкладку Micro-
strip. 

3. В области Material Pa-
rameters введите сле-
дующие значения. В по-
ле ввода Dielectric Con-
stant введите значение 
диэлектрической прони-

цаемости 10.73, в поле Loss Tangent – тангенс потерь 0.0001, в поле Conductor – 
материал проводника Copper (щёлкнув по кнопке в правой стороне этого поля). В 
области Electrical Characteristics введите: в поле Impedance – 50 Ом, в поле Fre-
quency – частоту 16 ГГц, в поле Electrical Length – электрическую длину 90 граду-
сов. Единицы измерения можно изменять, щёлкнув по кнопке в правой стороне со-
ответствующего поля. В области Physical Characteristics в поле Height(H) введите 
толщину подложки 0.5, а в поле Thickness(T) – толщину проводника 0.005 мм. 

Рис. 1.1 

4. Нажмите на кнопку со стрелкой вправо , чтобы электрические параметры пере-
считать в физические. 

5. В области Physical Characteristics в поле Physical Length(L) отображается длина 
четвертьволнового отрезка (примерно 1,7 мм), а в поле Width(W) – ширина провод-
ника (примерно 0,45 мм). 

1.1.2. Создание электрической схемы. 
Теперь можно создать электрическую схему фильтра. 

1. Выберите в меню команду Project>Add Schematic>New Schematic или щёлкните 
по значку New Schematic  на панели инструментов. 
В открывшемся окне Create New Schematic (рис. 1.2) 
введите имя схемы или оставьте имя по умолчанию. На 
рабочем поле основного окна Microwave Office откро-
ется окно схемы. 

Рис. 1.2



2. В нижней части левого окна проекта щёлкните по кнопке Elem, чтобы открыть 
вкладку с перечнем элементов. Раскройте группу Microstrip, щёлкнув по значку “+” 
слева от этой группы или дважды щёлкнув мышкой по этой группе. Затем щёлкните 
по подгруппе Lines. В нижней части левого окна буду отображены все имеющиеся 
элементы микрополосковой линии. Если установить курсор мышки на линию, раз-
деляющую левое и правое окна проекта так, чтобы курсор отображался в виде двой-
ной стрелки, можно, нажав кнопку мышки и сдвигая курсор вправо, несколько уве-
личить ширину левого окна так, чтобы список элементов отображался в две колон-
ки. 

3. Найдите элемент MLIN, установите на него курсор мышки, нажмите левую кнопку 
мышки и, не отпуская кнопки, переместите этот элемент в окно схемы, отпустите 
кнопку. 

4. Перемещая элемент в окне схемы мышкой, установите его в любом удобном месте 
окна и щёлкните левой кнопкой мышки, чтобы закрепить элемент. 

5. Щёлкните по подгруппе Junctions (Разветвления) в верхней части левого окна, вы-
берите элемент Т-соединения MTEE, перетащите его в окно схемы, как описано вы-
ше. Поместите этот элемент в окне схемы так, чтобы его левый конец соединился с 
правым концом ранее установленного элемента отрезка линии, и щёлкните левой 
кнопкой мышки. В точке соединения элементов должен появиться зелёный квадра-
тик, говорящий о том, что соединение создано. В противном случае установите кур-

сор на элемент Т-соединения, нажмите левую 
кнопку мышки и переместите элемент так, 
чтобы соединение произошло. 
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6. Щёлкните по элементу MLIN на создаваемой 
схеме, чтобы выделить его. Щёлкните по 
значку Copy  на панели инструментов и за-
тем по значку Paste . Альтернативно, можно 
использовать команды меню Edit>Copy и 
Edit>Paste. Перемещая мышку, поместите 
скопированный элемент в окно схемы, три 
раза щёлкните правой кнопкой мышки, чтобы 
развернуть скопированный элемент на 270 
градусов, и соедините его с плечом 3 элемента 
MTEE, как описано выше. 

7. Щёлкните по группе Other (Другие) в верх-
ней части левого окна. Найдите элемент MOPEN, перетащите его в окно схемы, три 
раза щёлкните мышкой, чтобы развернуть этот элемент. Соедините элемент MOPEN 
с нижним концом элемента MLIN (ID=TL3). Должна получиться схема, показанная 
на рис. 1.3. 

Рис. 1.3 

8. Установите курсор мышки левее и выше этой схемы, нажмите левую кнопку мышки 
и, не отпуская кнопки, переместите курсор мышки по диагонали правее и ниже схе-
мы так, чтобы все элементы схемы попали в образующийся прямоугольник. Отпус-
тите кнопку мышки, все элементы схемы будут выделены. Или выберите в меню 
Edit>Select All. 

9. На панели инструментов щёлкните по значку Copy и затем по значку Paste. Соеди-
ните скопированные элементы с правым концом схемы. Если после этого в окне 
схемы видна только часть схемы, выберите в меню команду View> View All или 
щелкните по значку View All (Показать всё)  на панели инструментов. Или мож-
но, пользуясь скроллингом, сдвинуть схему влево так, чтобы видеть правый конец 
схемы. 

10. Щёлкните по значку Paste на панели инструментов снова, чтобы скопировать эле-
менты ещё раз, и подключите их к правому концу схемы. 

11. Щёлкните по первому в схеме элементу MLIN (ID=TL1), скопируйте его, перемес-
тите в окно схемы и подключите к правому концу схемы. 



12. Выберите в меню команду Draw>Add Port или щёлкните по значку Port . Пере-
местите порт в окно схемы и соедините его с левым концом схемы. 

правым концом 

, перетащите его в окно схемы и разместите в любом свободном месте 

Схема фильтра должна быть симметричной, т.е. параметры крайних шлейфов и отрез-
жны быть одинаковыми и при настройке или оптими-

зации 

13. Снова щёлкните по значку Port, переместите порт в окно схемы, два раза щёлкните 
правой кнопкой мышки, чтобы повернуть порт, и соедините его с 
схемы. 

14. Щёлкните по группе Substrates (Подложки) в верхней части левого окна. Найдите 
элемент MSUB
схемы. Схема должна выглядеть, как показано на рис. 1.4. 

1.1.3. Добавление переменных. 

Рис. 1.4

ков линий между этими шлейфами дол
должны изменяться одинаково. Чтобы обеспечить это, введите в схему переменные 

следующим образом. 
1. Выберите в меню команду Draw>Add Equation или щёлкните по значку Equation 

(Уравнение)  на панели инструментов. Переместите курсор в любое свободное 

1. Дважды щёлкните по первому элементу MLIN схемы. Откроется диалоговое окно 
ameters в поле W введите 0.45, а в поле L 

место в окне схемы и щёлкните левой кнопкой мышки. 
2. В образовавшемся поле ввода введите WS1=0.45 и щёлкните левой кнопкой мышки 

где-либо на свободном месте в окне схемы. 
3. Повторите шаги 1 и 2 и аналогично введите LS1=1.7. 
4. Аналогично добавьте переменные WS2=0.45, LS2=1.7, WL=0.45 и LL=1.7. 

1.1.4. Редактирование элементов схемы. 

свойств элемента рис. 1.5. На вкладке Par
введите 3. Нажмите OK. 

2. Дважды щёлкните по элементу MLIN (ID=TL5) между первым и вторым шлейфа-
ми. В открывшемся окне 

 L
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в поле W введите W , а 
в поле L введите LL. 
Нажмите OK. 

3. Дважды щёлкните по 
первому шлейфу (эле-
мент MLIN, ID=TL3). В 
открывшемся окне в по-
ле W введите WS1, а в 
поле L введите LS1. 
Нажмите OK. 

Рис. 1.5 
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енту MTEE. Откроется диалоговое окно свойств 

е OK. 

а в поле L введите 

элементы схемы. 
емся окне свойств эле-

4. Дважды щёлкните по первому элем
элемента рис. 1.6. В поле 
W1 введите 0.45, в поле W2 
введите WL, в поле W3 
введите WS1. Обратите 
внимание, ширина провод-
ников узлов элемента 
MTEE должна быть такой 
же, как ширина соответст-
вующих подсоединённых 
проводников. Нажмите OK. 

5. Дважды щёлкните по пер-
вому элементу MOPEN и в 
поле W введите WS1. На-
жмит

6. Дважды щёлкните по вто-
рому шлейфу (элемент MLIN, ID=TL6). В поле W введите WS2, 

Рис. 1.6 

LS2. 
7. Аналогично отредактируйте все остальные 
8. Дважды щёлкните по элементу подложки MSUB. В открывш

мента  в поля Er и ErNom введите 10.73, в поле H введите 0.5, в поле T введите 
0.005,  в поле Tand введите 0.0001. Нажмите OK. 

Должна получиться схема, показанная на рис 1.7. 
Замечание. В схеме использованы элементы MTEE и MOPEN только для того, что-

бы показать пример редактирования параметров подобных элементов. На практике обычно 
лучше использовать вместо них элементы MTEE$ и MOPEN$. По своему назначению это 
точно такие же элементы, но они являются ‘интеллектуальными’, т.е. для них не требуется 
ввода никаких параметров. Все необходимые значения эти элементы получают автоматиче-
ски из подсоединённых к ним отрезков линий. Чтобы изменить схему, откройте вкладку эле-
ментов в левом окне, нажав на кнопку Elem. Щёлкните по элементу MTEE в схеме и нажми-
те клавишу Delete, чтобы удалить этот элемент. Из списка элементов в левом окне перетащи-
те в окно схемы элемент MTEE$, как описывалось ранее, и установите его вместо удалённо-
го элемента. Аналогично замените все элементы MTEE и MOPEN на элементы MTEE$ и 
MOPEN$. Переменные WS2 и LS2 были введены только потому, что эти параметры средне-
го шлейфа при оптимизации или настройке должны изменяться одинаково в трёх элементах: 
MTEE, MLIN и MOPEN. Поскольку теперь элементы MTEE$ и MOPEN$ получают значе-
ния параметров автоматически, от этих переменных можно отказаться. Щёлкните по пере-
менной WS2 и нажмите клавишу Delete. Аналогично удалите переменную LS2. Щёлкните по 
элементу MLIN среднего шлейфа (ID=TL6) и измените параметры W на 0.45 мм и L на 1.7 

Рис. 1.7 



мм. Изменённая схема с элементами MTEE$ и MOPEN$, полностью идентичная предыду-
щей схеме, показана на рис. 1.8. В дальнейшем мы будем использовать эту схему. 

Рис. 1.8 

1.1.5. Создание графика. 
1. Выберите в меню команду Project>Add Graph или 

щёлкните по значку New Graph на панели инструмен-
тов. В открывшемся окне Create Graph (рис. 1.9) в поле 
Graph name введите имя графика, например, LdB. В 
области Graph Type отметьте Rectangular (Прямо-
угольный). Нажмите OK. На рабочем поле откроется 
окно графика, а в левом окне в группе Graphs появится 
значок созданного графика с именем LdB. 

2. Откройте в левом окне вкладку Proj. Щёлкните правой 
кнопкой по значку графика LdB в левой части окна и в 
появившемся всплывающем меню выберите команду 
Add Measurement (Добавить измерение) или щелкните 
по значку Add Measurement  на панели инструмен-

тов. Откроется диалого-
вое окно Add Measure-
ment to ‘LdB’ (рис. 
1.10). 

Рис. 1.9 

3. В области Meas. Type 
отметьте Port Parame-
ters, в области Meas-
urement отметьте S. В 
поле Data Source Name 
(Имя источника данных) 
можно, щёлкнув по 
кнопке в правом конце 
этого поля, установить 
имя созданной схемы. В 
этом случае всегда будет 
отображаться график 

только для этой схемы. Учитывая, что в дальнейшем мы будем создавать электро-
магнитную структуру, оставьте значение по умолчанию All Sources (Все источни-

Рис. 1.10 
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ки), чтобы отображать графики и для схемы, и для электромагнитной структуры 
чтобы их можно было сравнивать. 

4. В поле To Port Index (Индекс входного порта) введите 2, в поле From Port Index 
(Индекс выходного порта) введите 1, щёлкая по кнопкам в правом конце поля. В об-
ласти Complex Modifier (Форма комплексного числа) отметьте Mag (Модуль). В 
области Result Type (Тип результата) отметьте dB. Нажмите кнопки Apply (Приме-
нить) и затем OK. 
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1.1.6. Определение диапазона частот и про е
ject 

зоне заграждения лучше 

н-

ведени  анализа. 
1. Дважды щёлкните по Pro

Options. Откроется диалоговое 
окно Project Options (рис. 1.11). 

2. В области Modify Range (Изме-
нить диапазон) отметьте Re-
place (Заменить). В поле 
Start(GHz) введите 1, в поле 
Stop(GHz) введите 12, в поле 
Step (Шаг) введите 1. Нажмите 
Apply. 

3. В диапа
характеристику отобразить по-
точнее, т.е. с более мелким ша-
гом. Поэтому отметьте Add 
(Добавить) и затем в поле 
Start(GHz) введите 12.5, в поле 
Stop(GHz) введите 18 и в поле 
Step введите 0.5 (рис. 1.12). На-
жмите Apply и затем OK. 

4. Для проведения анализа созда

Рис. 1.11

ной схемы выберите в меню ко-
манду Simulate>Analyze или 
щёлкните по значку Analyze  
на панели инструментов. Полу
ченный график показан на рис. 
1.13. 

В прямоугольнике на графике 

-

отобра

Рис. 1.12 

жается измеряемая величина 
DB(|S(2,1)|) и имя схемы, для которой соз-
дан график (Schematic 1). Если щёлкнуть по 
этому прямоугольнику, чтобы выделить его, 
затем установить на него курсор, нажать ле-
вую кнопку мышки и, не отпуская кнопку, 
перемещать мышку, можно переместить 
этот прямоугольник в любое место, удобное 
для отображения характеристики. В выде-
ленном прямоугольнике на серединах сто-
рон отображаются небольшие ромбики, а по 
углам квадратики. Установив курсор на ром-
бик или квадратик так, чтобы он отображал-
ся в виде двойной стрелки, можно, нажав 
левую кнопку мышки, изменять размеры 

этого прямоугольника. При этом параметры шрифта внутри прямоугольника изменяются ав-
томатически. 

Рис. 1.13 



Параметры графика, включая тип и цвет кривых, пределы и шаг переменных по осям, 
шрифты и т.д., можно изменить в любое время. Для этого окно графика должно быть актив-

ным. 
Установите курсор в любое ме-

сто в окне графика и щёлкните правой 
кнопкой мышки. В открывшемся меню 
выберите команду Properties (Свойст-
ва). Или щёлкните по значку Properties 

.Откроется диалоговое окно свойств 
графика, вид которого зависит от типа 
графика. В нашем случае это будет ок-
но Rectangular Plot Properties (Свой-
ства прямоугольного графика), пока-
занное на рис. 1.14. Здесь, например, 
можно сделать следующее. 

1. На вкладке Axes (Оси) в об-
ласти Choose axis (Выбрать 
ось) отметьте x. В области Di-
visions (Деления) снимите 
“галочку” в Auto divs и вве-
дите в поле Step значение 1, 
нажмите Apply. 

Рис. 1.14 

2. На вкладке Axes в области  
Choose axis отметьте Left 1 
(Левая 1). В области Divisions 
снимите “галочку” в Auto 
divs и введите в поле Step 
значение 5, нажмите Apply. 
Нажмите OK. 

Полученный график показан на 
рис. 1.15. 

Рис. 1.15 

1.1.7. Назначение переменных и параметров элементов для оптимизации. 
В процессе оптимизации должны изменяться длина и ширина шлейфов и отрезков ли-

нии между шлейфами. Т.е. мы должны назначить для оптимизации все добавленные к схеме 
переменные и параметры элемента 
MLIN среднего шлейфа. 
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1. Откройте окно схемы, дваж-
ды щёлкнув по её имени в 
левом окне проекта. Щёлкни-
те правой кнопкой по пере-
менной WS1, в открывшемся 
меню выберите Properties. 
Откроется диалоговое окно 
Edit Equation (рис. 1.16). 
В 2. области Tun-
ing/Optimization Mode (Ре-
жим настройки/оптимизации) 
отметьте Optimize и Con-

strain (Ограничить). В поле Upper bound (Верхняя граница) введите 0.7. В поле 
Lower bound введите 0.1. Нажмите OK. 
Аналогично назначьте для оптимизации

Рис. 1.16 

3.  переменную WL и определите такие же 
границы изменений значения для этой переменной, как и для переменной WS1. 



4. Аналогично назначьте для 
оптимизации переменные 
LS1 и LL и определите для 
них верхнюю границу 3 и 
нижнюю границу 1. 

5. Дважды щёлкните по эле-
менту MLIN среднего 
шлейфа (ID=TL6). Откроет-
ся диалоговое окно свойств 
элемента (рис. 1.17). Отметь-
те столбцы Opt и Limit для 
параметров W и L. Устано-
вите нижний предел (Lower) 
0.1 для W и 1 для L. Устано-

вите верхний предел (Upper) 0.7 для W и 3 для L. Нажмите OK. 
Рис. 1.17 

1.1.8. Определение целей оптимизации. 
В качестве целей оптимизации для данного фильтра установим диапазоны полос про-

пускания и заграждения и допустимое значение модуля S21 в этих диапазонах. Откройте ок-
но графика, дважды щёлкнув по его имени LdB в левом окне проекта. 

1. Сначала введём цель в полосе про-
пускания. Щёлкните правой кноп-
кой мышки по группе Optimizer 
Goals (Цели оптимизации) на 
вкладке Proj в левом окне проекта. 
В открывшемся меню выберите 
Add Opt Goal. Откроется диалого-
вое окно New Optimization Goal 
(рис. 1.18). 

2. Здесь характеристика должна быть 
расположена выше допустимого 
значения, поэтому отметьте 
Meas>Goal. В области Range сни-
мите “галочку” Max и в поле Stop 
введите 10 GHz (верхняя частота 

полосы пропускания). В поле Goal введите -1 (допустимое ослабление в полосе 
пропускания). Нажмите OK. 

Рис. 1.18

3. Теперь введём цель в полосе заграждения. Снова щёлкните правой кнопкой мышки 
по группе Optimizer Goals и в открывшемся меню выберите Add Opt Goal. 

4. Здесь характеристика должна быть 
расположена ниже допустимого зна-
чения, поэтому в открывшемся окне 
отметьте Meas<Goal. В области 
Range снимите “галочки” в Max и 
Min. В поле Start введите 14 GHz, а 
в поле Stop введите 18 GHz. В поле 
Goal введите -35. Нажмите OK. 
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После установки целей, их имена ото-
бражаются как подгруппы в группе Opti-
mizer Goals, а сами цели отображаются на 
графике, как показано на рис. 1.19. Обратите 
внимание, что направление штриховки ука-
зывает на недопустимые значения характери-
стики. Рис. 1.19 



Установленные ошибочно цели можно изменить. Для этого щёлкните правой кнопкой 
мышки по имени цели в левом окне проекта и выберите Properties. Откроется диалоговое 
окно, аналогичное рис. 1.18, в котором можно изменить установки цели. 

Отредактировать цель можно и непосредственно на графике. Для этого щёлкните по 
цели левой кнопкой мышки, чтобы выделить её. Если установить курсор на выделенную 
цель и нажать левую кнопку мышки, можно перемещать цель по графику. Если установить 
курсор на синий прямоугольник в углу выделенной цели и нажать левую кнопку мышки, 
можно изменять границы цели. 

1.1.9. Выполнение оптимизации. 
Для выполнения оптимизации: 

1. Выберите в меню команду Simulate>Optimize. Откроется окно Optimizer (рис. 
1.20). 
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2. Щёлкнув по кнопке в правом 
конце поля ввода Optimiza-
tion Methods, выберите один 
из методов оптимизации, на-
пример, Random (Local). 

3. В поле Maximum Iterations 
введите желаемое максималь-
ное количество итераций при 
оптимизации или оставьте 
значение по умолчанию. На-
жмите Start. 

В процессе выполнения опти-
мизации в области Relative Goal Cost 
отображается относительная значи-
мость целей. В нашем случае видно, 
что значимость одной из целей (в по-

лосе заграждения) намного превышает значимость другой, настолько, что второй цели про-
сто не видно. Это объясняется тем, что в полосе пропускания характеристика почти удовле-
творяет цели оптимизации. 

Рис. 1.20 

В области Cost History отобра-
жается график изменения целевой функ-
ции в процессе оптимизации. 

Полученный после оптимизации 
график показан на рис. 1.21. Из этого 
графика видно, что поставленные в за-
дании требования выполняются. В зави-
симости от выбранного метода оптими-
зации и других установок в окне рис. 
1.20 результаты оптимизации могут не-
сколько отличаться от полученных 
здесь. 

Щёлкните по подгруппе схемы 
(Schematic 1) в группе Circuit Schemat-

ics в левом окне проекта, чтобы сделать активным окно схемы. Полученная после оптимиза-
ции схема показана рис. 1.22. В нашем случае переменные получили значения WS1=0.3404, 
LS1=1.779, WL=0.3852 и LL=1.922. Параметры среднего шлейфа получили значения 
W=0.6488 и L=1.505. При создании электромагнитной структуры размеры элементов тополо-
гии должны быть кратны размерам клеток в сетке. Предварительно примем размер клеток 
0,05 мм. Соответственно мы должны округлить значения переменных и параметров среднего 
шлейфа. Изменим эти значения следующим образом: WS1=0.35, LS1=1.8, WL=0.35, LL=1.9, 
W=0.65 и L=1.5. Дважды щёлкните по переменной WS1=0.3404 и измените её значение на 

Рис. 1.21 



Рис. 1.22
0.35, затем щёлкните на свободном 
месте в окне схемы. Аналогично из-
мените значения остальных перемен-
ных. Дважды щёлкните по параметру 
W в среднем шлейфе, измените его 
значение на 0.65 и щёлкните на сво-
бодном месте в окне схемы. Анало-
гично измените значение параметра L 
на 1.5. Щёлкните по имени графика 
LdB в левом окне проекта, чтобы сде-
лать активным окно графика (он будет 
отображаться бледным цветом, ука-
зывающим, что с новыми параметра-
ми анализ не проводился). Щёлкните 
по значку Analyze  а панели инст-

рументов. Полученный график показан на рис. 1.23. 
Рис. 1.23 н

. 
оманду 

1.1.10. Создание электромагнитной структуры. 
Электромагнитная структура топологии фильтра может быть создана различными 

способами. Мы здесь рассмотрим два: 
• Использование топологии схемы с последующим копированием её и вставкой в ре-

дактор электромагнитных структур. 
• Черчение топологии непосредственно в редакторе электромагнитных структур. 

Чтобы получить топологию схемы: 
1. Щёлкните по имени схемы (Schematic 1) в группе Circuit Schematics в левом окне 

2. Выберите в меню к
проекта, чтобы сделать активным окно схемы

Options> Layout Options. 
Откроется окно установки 
опций топологии (рис. 1.24). 
На вкладке Layout этого 
окна в поле ввода Snap to-
gether (Связать вместе) вве-
дите опцию Auto snap pa-
rameter changes (Автомати-
чески изменять параметры 
привязки), щёлкнув по 
кнопке в правом конце этого 
поля, и нажмите OK. Выбе-
рите в меню команду 
View>New Layout View или 

Рис. 1.24 
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щёлкните по значку New Schematic Layout View  на панели инструментов. От-
кроется окно с топологией схемы (рис. 1.25). Элементы топологии могут распола-
гаться беспорядочно, но соединения между ними указываются правильно (красны-
ми пунктирными линиями). Чтобы исправить топологию, выделите все элементы 

топологии, выбрав в меню 
команду Edit> Select All. 
Затем выберите в меню 
команду Edit>Snap To-
gether или щёлкните по 
значку Snap Together  
на панели инструментов. 
Исправленная тополо
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гия 
показана на рис. 1.26. 

3. Щёлкните по кнопке в 
правом конце поля Set 
Grid Snap Multiple (Ус-
тановить кратность при-
вязки сетки)  на па-
нели инструментов и ус-
тановите 0.1. 

4. На полученной топологии 
можно обозначить разме-
ры, которые в данном 

случае нужны для определения 
необходимых размеров корпуса 
в электромагнитной структуре и 
для черчения топологии, если её 
чертить непосредственно в ре-
дакторе электромагнитной 
структуры. Сначала определи-
те размер стрелок и шрифтов 
для удобного наблюдения 
размеров топологии. Выберите 
в меню команду Options> 
Layout Options. Откроется 
окно установки опций тополо-
гии. На вкладке Dimension 
Lines (Измерительная линия) 
этого окна (рис. 1.27) в поле 
Font height (Высота шрифта) 
введите 0.25. В поле Arrow 
size (Размер стрелки) введите 
0.2. В поле Precision (Точ-
ность, т.е. количество знаков 

после запятой) введите 2. Нажмите OK. Выберите в меню команду 
Draw>Dimension Line или щёлкните по значку Dimension Line  на панели инст-
рументов. Чтобы определить полную длину топологии, установите курсор на левую 
верхнюю точку входного проводника, нажмите на левую кнопку мышки и, не от-
пуская кнопки, переместите курсор на правую верхнюю точку выходного провод-
ника. Отпустите кнопку. Двигая мышку, установите измерительную линию в пози-
цию, удобную для наблюдения, и щёлкните левой кнопкой мышки. Аналогично 
можно определить любые размеры топологии. Топология фильтра с установленны-

Рис. 1.25 

Рис. 1.26 

Рис. 1.27 

ми размерами показана на рис. 1.28. 



5. Выберите в меню команду Project>Add EM Structure>New EM Structure или 
щёлкните по значку New 
EM Structure  на панели 
инструментов. Откроется 
окно New EM Structure 
(рис. 1.29). В поле Enter a 
name for the EM Structure 
введите имя структуры, 
например FZ, и нажмите 
Create. На рабочем поле 

откроется окно редактора электромагнитной структуры, а в левом окне проекта в 
даваемой структуры с именем FZ. 

6. В этой же группе EM Struc-
tures имеется подгруппа

Рис. 1.28 

группе EM Structures появится подгруппа соз

 Ma-

толщиной 0.1 и проводимостью 3.53e7. Эти

e In-

terials, в которой отобража-
ются все используемые в про-
екте материалы. Если дважды 
щёлкнуть по имени любого 
материала или щёлкнуть по 
нему правой кнопкой мышки 
и выбрать Properties, можно 
отредактировать свойства 
этого материала. Также мож-
но добавить в проект любое 
количество других материа-
лов. Щёлкните правой кноп-

кой мышки по подгруппе Materials и 
выберите Add New Material. Откро-
ется окно Create New Material (рис. 
1.30). В поле Material name введите 
имя материала Copper (Медь). От-
метьте Physical parameters. В поле 
Conductor thickness (Толщина про-
водника) введите 0.005 мм. В поле 
Material conductivity (Проводимость 
материала) введите 5.88e7. Щёлкнув 
по кнопке Edit, можно изменить цвет 
материала. Нажмите OK. Аналогич-
но добавьте материал Aluminum 

 материалы появятся в подгруппе Mate-
rials. 

7. Выберите в меню команду Struc-
ture>Substrate Information или 
щёлкните по значку Substrat

Рис. 1.29 

Рис. 1.30 
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formation  на панели инстру-
ментов. Откроется окно Substrate 
Information. 

8. На вкладке Enclosure (Корпус, 
рис. 1.31) в поле X-Dimension(mm) 
введите 11.15 (размер корпуса по 

Xоси ). В поле X-Divisions введите 
223 (количество делений по оси X, при котором размер клетки по этой оси будет 
0,05 мм). В поле Y-Dimension(mm) введите 5, а в поле Y-Divisions введите 100. 

Рис. 1.31 



9. На вкладке Dielectric Layers (Диэлектрические слои, рис. 1.32) отметьте верхнюю 
строку и в нижней строке редактирования в поле Thickness (Толщина) введите 6. 

Отметьте вторую строку и в ниж-
ней строке редактирования в поле 
Thickness введите 0.5, в поле er 
введите 10.73, в поле Loss Tan-
gent введите 0.0001 и в поле View 
Scale (Масштаб отображения) 
введите 4 (чтобы при просмотре 
трёхмерного отображения струк-
туры этот слой не был слишком 
тонким). 

10. На вкладке Boundaries (Границы, 
рис. 1.33) в области Enclosure Top 
(Верх корпуса) отметьте Specify 
material и в поле Top ground 
plane material введите Aluminum, 
щёлкнув по кнопке в правом кон-
це этого поля. В области Enclo-
sure Bottom (Низ корпуса) от-
метьте Specify material и в поле 
Bottom ground plane material 
введите Copper, щёлкнув по 
кнопке в правом конце этого поля. 
Нажмите OK. 

Рис. 1.32 

11. Сделайте активным окно тополо-
гии схемы. Это окно не отобража-

ется в левом окне проекта, поэтому сделать его активным можно, щёлкнув по нему 
мышкой (если это окно открыто). Если открытого окна топологии схемы на рабочем 
поле не видно, выберете в меню какую-нибудь команду упорядочения расположе-

ния окон, например 
Window>Cascade. Устано-
вите курсор мышки левее и 
выше топологии, нажмите 
левую кнопку мышки и, не 
отпуская кнопки, перемес-
тите курсор правее и ниже 
топологии, чтобы выделить 
все элементы топологии. 
Или выберите в меню ко-
манду Edit>Select All. Затем 
щёлкните по значку Copy на 
панели инструментов. Сде-
лайте активным окно элек-
тромагнитной структуры, 
дважды щёлкнув по её име-
ни в левом окне проекта или 

по окну электромагнитной структуры на рабочем поле. Щёлкните по значку Paste 
на панели инструментов, поместите скопированную топологию в электромагнитную 
структуру так, чтобы края входного и выходного проводников точно совпадали с 
границами корпуса (рис. 1.34). Обратите внимание, границы проводников тополо-
гии должны точно совпадать с сеткой разбиения. Для этого размеры клеток сетки в 
редакторе топологии схемы и в редакторе электромагнитной структуры должны 
быть одинаковыми или кратными. 

Рис. 1.33 

Рис. 1.34
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Чтобы продемонстрировать второй способ создания электромагнитной структуры 
фильтра мы не будем создавать новой структуры. Выделите все элементы топологии, 
например, выбрав в меню команду Edit>Select All, и удалите их, нажав клавишу Delete. 
Теперь начертим топологию непосредственно в окне редактора электромагнитной 
структуры, используя значения параметров элементов схемы. Чертить также можно 
различными способами. Можно, например, начертить сразу всю топологию, используя 
инструмент Polygon Conductor. Или можно чертить отдельными прямоугольниками. При 
этом начерченная топология не обязательно должна абсолютно точно совпадать с 
полученной ранее. 

Проводники топологии чертятся точно по сетке. Поэтому удобнее, если сетка видна. 
Если сетка мелкая и её не видно, щёлкните по значку View Area на панели инструментов или 
выберите в меню команду View>View Area и выделите тот участок электромагнитной 

структуры, на котором будет выполняться черчение. 
1. Выберите в меню команду Draw>Add Rect Conductor или 

щёлкните по значку Rectangle Conductor  на панели 
инструментов. Поместите курсор в окно электромагнитной 
структуры и нажмите клавишу Tab. В открывшемся окне 
Enter Coordinates (Ввод координат) в поле x введите 0, а 
поле y введите 1.3 (рис. 1.35). Нажмите OK. Нажмите 
клавишу Tab снова. В новом открывшемся окне в поле dx 
введите длину входного проводника 3, а в поле dy введите 
ширину проводника 0.45 (рис. 1.36) и нажмите OK. 
Входной прямоугольный проводник отобразится на 

электромагнитной структуре (рис. 1.37). 

Рис. 1. 35 

Рис. 1.36 

2. Если пользоваться координатным вводом не очень 
удобно, можно использовать инструмент для 
создания многоугольников. Выберите в меню 
команду Draw> Add Conductor или щёлкните по 
значку Polygon Conductor  на панели 
инструментов. Поместите курсор на правую 
сторону входного проводника на 0,05 мм ниже 

правого верхнего угла (т.е. на одну 
клетку сетки) и щёлкните левой 
кнопкой мышки, чтобы закрепить эту 
точку. Переместите курсор вправо на 
dx: 5.15 (смещение отображается рядом 
с курсором) и снова щёлкните мышкой. 
Если топология выходит за пределы 
окна и при этом курсор выходит за 

границу рабочего поля, можно использовать клавиши перемещения курсора для 
скроллинга отображаемой топологии, не отпуская кнопки мышки. Переместите 

курсор вниз на dy: 0.35 и снова 
щёлкните мышкой. Переместите курсор 
влево на dx: -5.15 и дважды щёлкните 
мышкой, чтобы замкнуть 
прямоугольник. Альтернативно, можно 
щёлкнуть один раз, переместить курсор 

на dy: -0.35 вверх и снова щёлкнуть мышкой. Полученная топология показана на 
рис. 1.38. 

Рис. 1.37 

Рис. 1.38

Рис. 1.39

3. Щёлкните по входному проводнику, чтобы выделить его. Щёлкните по значку Copy 
на панели инструментов и затем по значку Paste. Переместите скопированный 
прямоугольник в окно электромагнитной структуры, соедините его с правым 
концом второго прямоугольника и щёлкните мышкой. Полученная топология 
показана на рис. 1.39. 
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4. Щёлкните по значку Polygon Conductor на панели инструментов. Поместите курсор 
на левый нижний угол второго проводника и щёлкните левой кнопкой мышки. Пе-

реместите курсор вправо на dx: 
0.35 и щёлкните мышкой. Пере-
местите курсор вниз на dy: 1.85 и 
щёлкните мышкой. Переместите 
курсор влево на dx: -0.35 и дваж-
ды щёлкните мышкой. Получен-
ная топология с первым шлейфом 
показана на рис. 1.40. 
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а по значку Paste. Поместите скопированный прямоугольник в конце среднего 

шки по любому элементу 

топологии можно, используя инструмент Measure, 

1.1.11. Установка портов и анализ электромагнитной структуры. 
Выберите в 

5. Щёлкните по последнему создан-
ному прямоугольнику, чтобы его 
выделить (если он не выделен). 

Щёлкните по значку Copy на панели инструментов и затем по значку Paste. Помес-
тите скопированный прямоугольник примерно посредине среднего проводника так, 
чтобы его верхняя сторона касалась нижней стороны среднего проводника, и щёлк-
ните мышкой. Измерьте расстояние между шлейфами. Для этого щёлкните по знач-
ку Measure (Измерение) на панели инструментов или щёлкните правой кнопкой 
мышки в любом месте рабочего поля и выберите команду Measure. Поместите кур-
сор на верхний правый угол первого шлейфа, нажмите левую кнопку мышки и, не 
отпуская кнопки, переместите курсор на верхний левый угол второго шлейфа и за-
метьте расстояние между шлейфами. Допустим, это расстояние оказалось равным 
2,3 мм. Поместите курсор на второй шлейф, нажмите левую кнопку мышки и, не от-
пуская кнопки, переместите шлейф влево на dx: -0.4, чтобы расстояние между 
шлейфами было равно 1,9 мм. Дважды щёлкните по второму шлейфу. Поместите 
курсор на ромбик посередине правой стороны шлейфа так, чтобы он отображался в 
виде двойной стрелки. Нажмите левую кнопку мышки и, не отпуская кнопки, пере-

местите правую сторону 
шлейфа вправо на dx: 0.3, 
чтобы ширина шлейфа была 
равна 0,65 мм. Поместите 
курсор на ромбик посередине 
нижней стороны шлейфа так, 
чтобы он отображался в виде 
двойной стрелки. Нажмите 
левую кнопку мышки и, не 
отпуская кнопки, переместите 
нижнюю сторону шлейфа 
вверх на dy: -0.35, чтобы дли-
на шлейфа была равна 1,5 мм. 

6. Снов

Рис. 1.40 

Рис. 1.41 

проводника. Полученная топология показана на рис. 1.41. 
7. Выделите всю топологию, Щёлкните правой кнопкой мы

топологии и выберите Mesh/Material Properties. В открывшемся окне выберите ма-
териал 1/2oz Cu и нажмите OK. 

Проверить правильность размеров 
как указывалось выше. 

1. Щёлкните по входному проводнику топологии, чтобы выделить его. 
меню команду Draw>Add Edge Port или щёлкните по значку Edge Port (Порт гра-
ни), поместите курсор на левую сторону входного проводника так, чтобы на ней 
появился небольшой прямоугольник, и щёлкните мышкой. 
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ите по выходному про-

й 

2. Теперь нужно установить референсную плоскость на некотором расстоянии от ле-
вого края корпуса. Это расстояние должно быть таким, чтобы возникшие на левом 

краю высшие типы волн за-
тухли к референсной плоско-
сти. Обычно это расстояние 
рекомендуют не менее толщи-
ны подложки. Щёлкните левой 
кнопкой мышки по прямо-
угольнику порта. Установите 
курсор на правую сторону это-
го прямоугольника так, чтобы 
курсор отображался в виде 
двойной стрелки. Нажмите ле-
вую кнопку мышки и перемес-

тите курсор вправо на dx: 1. 
3. Щёлкн

Рис. 1.42 

воднику топологии и аналогично 
установите второй порт, сдвинув 
референсную плоскость на 1 мм 
влево. Окончательная топология 
фильтра показана на рис. 1.42. 

4. Щёлкните правой кнопко
мышки по имени электромаг-
нитной структуры (FZ) в левом 
окне проекта и выберите коман-
ду Options. В появившемся окне 
Options отройте вкладку Fre-
quencies (Частоты). В этом окне 
(рис. 1.43) для каждой электро-

магнитной структуры можно установить свои частоты для анализа, отличные от 
частот проекта. Это бывает полезно, если частот для анализа в проекте много и вре-
мя электродинамического анализа слишком большое. Чтобы установить частоты 
только для данной структуры, нужно снять “галочку” в Use project defaults (Ис-
пользовать значения проекта по умолчанию) и затем ввести значения частот обыч-
ным образом. Мы для анализа будем использовать частоты проекта, поэтому эта 
“галочка” должна быть установлена. 

Рис. 1.43 

5. Дважды щёлкните левой кнопкой мышки по имени графика (LdB) в левом окне 
проекта, чтобы сделать окно графика активным. Выберите в меню команду 
Simulate>Analyze или щёлкните по значку Analyze  на панели инструментов. 
Анализ начнёт выполняться и откроется окно, в котором отображается процесс ана-

Рис. 1.44 Рис. 1.45. 



лиза (рис. 1.44). Щёлкнув по кнопке Cancel в этом окне, выполнение анализа можно 
остановить в любое время. Полученная характеристика показана на рис. 1.45. Как 
видно из графиков, эта характеристика заметно отличается в полосе заграждения от 
полученной в линейном моделировании и не удовлетворяет заданным требованиям. 

1.1.12. Редактирование электромагнитной структуры. 
На этом этапе необходимо подобрать такие размеры 

топологии, чтобы характеристика фильтра удовлетворяла 
предъявляемым требованиям. Чтобы удобнее было вер-
нуться к предыдущему варианту в случае неудачной по-
пытки, обычно лучше сделать копию электромагнитной 
структуры и редактировать её. 

1. Установите курсор на подгруппу электромагнит-
ной структуры FZ в левом окне проекта, нажмите 
левую кнопку мышки и, не отпуская кнопки, пе-
реместите курсор на группу EM Structures, от-
пустите кнопку. В группе EM Structures появит-

ся подгруппа Copy of FZ (рис.1.46), а на рабочем поле откроется окно созданной 
копии нашей структуры. 

Рис. 1.46 

2. Полученную копию структуры мож-
но переименовать. Щёлкните правой 
кнопкой мышки по подгруппе Copy 
of FZ и выберите Rename EM Struc-
ture. В открывшемся окне в поле 
New name введите новое имя скопи-
рованной структуры, например, FZ1 
и нажмите OK. 

Начнём редактирование скопирован-
ной структуры с изменения размеров среднего 
шлейфа.  Рис. 1.47

1. Дважды щёлкните по среднему шлейфу, установите курсор на синий ромбик посре-
дине нижней стороны шлейфа так, чтобы курсор отображался в виде двойной 
стрелки. Нажмите левую кнопку мышки и, не отпуская кнопки, переместите курсор 
вверх на величину dy:-0.1 (рис. 1.47), отпустите кнопку. 

2. Дважды щёлкните по имени графика в левом окне проекта, чтобы сделать активным 
окно графика. 

Рис. 1.49 
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3. Щёлкните по значку Analyze  на панели инструментов, чтобы выполнить анализ 
структуры с укороченным шлейфом. Полученный график показан на рис. 1.48. Как 

Рис. 1.48



видно, новая характеристика ближе к требуемой, поэтому продолжим укорочение 
среднего шлейфа. 

4. Сначала удалите структуру FZ, имеющую худшую характеристику. Для этого 
щёлкните правой кнопкой мышки по под-
группе FZ в левом окне проекта и выберите 
Delete EM Structure. Затем создайте копию 
структуры FZ1, как описано выше. Этой ко-
пии можно присвоить прежнее имя FZ. 

5. В новой структуре FZ дважды щёлкните по 
среднему шлейфу и снова укоротите его на 

0.1, как описано выше на шаге 1. 
Рис. 1.50 

6. Выполните анализ новой структуры. Полученный график показан на рис. 1.49. По-
лученная характеристика ближе к требуемой, но не удовлетворяет требованию на 

частоте 18 ГГц. 
7. Удалите предыдущую структуру FZ1 и сде-

лайте копию последней структуры FZ, её 
можно снова переименовать в FZ1. Умень-
шите ширину микрополоски, с которой со-
единены шлейфы на 0,1 мм. Для этого два-
жды щёлкните по этой микрополоске. Уста-
новите курсор на синий ромбик посредине 

верхней стороны этой микрополоски и сместите её вниз на 0.05. Затем поместите 

курсор на синий ромбик посредине нижней стороны и сместите её вверх на 0.05 
(рис. 1.50). Установите курсор на первый шлейф, нажмите левую кнопку мышки и, 
не отпуская кнопки, сдвиньте шлейф вверх так, чтобы он соединился с микрополос-
кой. Аналогично соедините второй и третий шлейфы с микрополоской (рис. 1.51). 
Выполните анализ полученной структуры. График показан на рис. 1.52. Получен-
ный график уже близок к требуемому, но немного сдвинут вверх по частоте. 

Рис. 1.51 

Рис. 1.52 Рис. 1.53 

8. Удалите предыдущую структуру FZ и сделайте копию последней структуры FZ1, её 
можно снова переименовать в FZ. Дважды щёлкните по первому шлейфу в новой 
структуре, установите курсор на ромбик посредине нижней стороны этого шлейфа и 
сместите эту сторону вниз на 0.05. Аналогично удлините на 0.05 третий шлейф. Вы-
полните анализ новой структуры. Полученная характеристика показана на рис. 1.53. 
Эта характеристика несколько уже по полосе заграждения и не удовлетворяет тре-
бованиям на верхней частоте 18 ГГц. 

9. Удалите предыдущую структуру FZ1 и сделайте копию последней структуры FZ, её 
можно снова переименовать в FZ1. Дважды щёлкните по микрополоске, с которой 
соединены шлейфы, установите курсор на ромбик посредине верхней стороны и 
сместите её вниз на 0.05. Выполните анализ этой структуры. Полученная характери-
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ная в результате электромагнитного моделирования топология фильтра пока-
зана н

итными связями, обеспе-
чиваю

1.2.1. Создание электрической схемы. 
 именем FZ4. 

енем FilZ. 
дважды щёлкнув 

нт 

кните по подгруп-

стика (рис. 1.54) удовлетворяет поставленным требованиям. Чтобы не затемнять 
график, можно щёлкнуть правой кнопкой мышки в группе графика LdB по имени 

кривой All Sources:DB(|S(2,1)|) в левом 
окне проекта и выбрать Properties. В 
открывшемся окне в поле Data Source 
Name (см. рис. 1.10) введите имя по-
следней электромагнитной структуры 
FZ1, щёлкнув по кнопке в правом кон-
це этого поля, и нажмите OK. Или 
можно просто удалить схему (Sche-
matic 1) и предыдущую электромагнит-
ную структуру (FZ) из проекта. Харак-

теристика последнего варианта электромагнитной структуры показана на рис. 1.55. 
Получен

Рис. 1.54 Рис. 1.55 

Рис. 1.56 

а рис. 1.56. Как видно, размеры элементов топологии несколько отличаются от соот-
ветствующих размеров, полученных в линейном моделировании. 

1.2. Фильтр с частотой заграждения 4 ГГц 
Требуется спроектировать фильтр с боковыми электромагн
щий ослабление на частоте 4 ГГц не менее 50 дБ. 

1. Создайте новый проект и сохраните его под
2. Щёлкните по значку New Schematic и создайте схему с им
3. Откройте в левом окне вкладку Elem. Раскройте группу Microstrip, 
по ней мышкой или щёлкнув по значку “+” слева от этой группы. Затем щёлкните по 

подгруппе Lines. 
4. В нижней части левого окна выберите элеме

MLIN и перетащите его в окно схемы. Затем в верх-
ней части левого окна щёлкните по подгруппе Cou-
pled Lines (Связанные линии), в нижней части левого 
окна найдите элемент MCLIN, перетащите его в окно 
схемы и соедините с правым концом элемента MLIN, 
как показано на рис. 1.57. 

5. В верхней части левого окна щёл
Рис. 1.57 

пе Bends (Изгибы). Найдите элемент MBENDA$ и подключите его к узлу 4 элемента 
MCLIN. 

6. В верхней части левого окна щёлкните по подгруппе Lines, выберите элемент MLIN, 
перетащите его в окно схемы, три раза щёлкните правой кнопкой мышки, чтобы раз-
вернуть элемент на 270 градусов и подключите его к элементу MBENDA$. 



7. В верхней части левого окна щёлкните по подгруппе Other (Другие), выберите эле-
мент MOPEN$, перетащите его в окно схе-
мы, два раза щёлкните правой кнопкой мыш-
ки, чтобы развернуть элемент на 180 граду-
сов и подключите его к узлу 2 элемента 
MCLIN. Снова выберите элемент MOPEN$, 
перетащите его в окно схемы, три раза 
щёлкните правой кнопкой мышки, чтобы 
развернуть элемент на 270 градусов и под-
ключите его к последнему элементу MLIN. 
Полученная схема первого резонатора по-

казана на рис. 1.58. Теперь приступим к созданию 
следующих двух резонаторов. 

1. Щёлкните по значку Zoom Out  на па-
нели инструментов, чтобы уменьшить раз-

мер схемы. Используя горизонтальную полосу скроллинга, сдвиньте схему в левую 
часть окна. 

Рис. 1.58 

2. Выделите все элементы схемы. Для этого поместите курсор выше и левее схемы, на-
жмите левую 
кнопку мышки и 
переместите кур-
сор правее и ниже 
последнего эле-
мента схемы. Или 
выберите в меню 

команду 
Edit>Select All. 

3. Выберите в меню 
команду 

Edit>Mirror (Ре-
дактиро-

вать>Создать зер-
кальное отобра-
жение) и щёлкни-
те левой кнопкой 
мышки на свобод-
ном месте окна 

схемы. Будет создано зеркальное отображение схемы относительно оси Y. Щёлкните 
правой кнопкой мышки по зеркальному отображению и выберите Rotate (Повернуть) 
или выберите в меню команду Edit> Rotate. Установите курсор на входной узел эле-
мента MLIN, нажмите левую кнопку мышки и поверните схему на 180 градусов. Во 
время всех этих операций все элементы второго резонатора должны быть выделены. 
Результат должен быть таким, как показано на рис. 1.59. 

Рис 1.59 

4. Выделите все элементы первого резонатора и щёлкните по значку Copy на панели ин-
струментов. Затем выделите все элементы второго резонатора и соедините его входной 
узел элемента MLIN с выходным узлом 3 элемента MCLIN первого резонатора. Теперь 
щёлкните по значку Paste на панели инструментов и соедините входной узел элемента 
MLIN скопированного резонатора с выходным узлом 3 элемента MCLIN второго резо-
натора. 

5. Щёлкните по первому элементу MLIN полученной схемы, щёлкните по значку Copy и 
затем по значку Paste на панели инструментов. Подключите скопированный элемент 
отрезка линии к узлу 3 элемента MCLIN последнего резонатора. Полученная схема 
должна выглядеть, как показано на рис. 1.60. Напомним, что если при вставке элемента 
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в схему значения его параметров отображаются так, что читать схему не удобно, то их 
можно переместить. Для этого установите курсор на параметры, нажмите левую кнопку 
мышки и переместите параметры в любое удобное место. 

Рис. 1.60 

6. Щёлкните по значку Port на панели инструментов и подключите порт ко входу 
фильтра. Снова щёлкните по значку Port на панели инструментов, переместите курсор 
в окно схемы, дважды щёлкните правой кнопкой мышки, чтобы развернуть порт, и 
подключите его к выходу схемы. 

7. Щёлкните по группе Substrates в левом окне проекта, выберите элемент MSUB и по-
местите его в окне схемы на свободном месте. Полученная схема фильтра показана на 
рис. 1.61. 

Рис. 1.61 
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1.2.2. Добавление переменных и редактирование элементов схемы. 
Добавим следующие переменные в схему. 

1. Щёлкните по значку Equation  на панели инструментов, переместите курсор в ок-
но схемы на свободное место и щёлкните мышкой. В открывшемся поле введите L1=14 
(примерно длина полуволны на частоте 4 ГГц) и щёлкните мышкой вне этого поля. 
Аналогично добавьте переменную L2=14. Затем добавьте переменные LS1=L1/2 и 

LS2=L2/2. Добавьте также переменные 
LS1: и LS2:, чтобы отобразить значения 
этих переменных после выполнения ана-
лиза схемы. Так же добавьте переменные 
WS1=1, WS2=1, S1=0.1, S2=0.1, LL=3. 
Добавленн
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ые переменные показаны на 

ведите для выходного элемен-

рис. 1.62. 
2. Дважды щёлкните по входному элемен-
ту MLIN и введите W=1 и L=3. Эти же 
значения в
та MLIN. 

3. Дважды щёлкните по элементу MCLIN 
первого резонатора и введите W=1, S=S1 

 введите для элемента MCLIN третьего резона-
тора. Для элемента MCLIN второго резонатора введите W=1, S=S2 и L=LS2. 
и L=LS1. Эти же значения параметров

Рис. 1.62 

4. Для элемента MLIN первого резонатора, соединённого с элементом уголкового изгиба 
MBENDA$, введите W=1, и L=LS1. Эти же значения параметров введите для анало-
гичного элемента MLIN третьего резонатора. Для аналогичного элемента MLIN второ-
го резонатора введите W=1, и L=LS2. 

5. Для элементов MLIN, соединяющих первый резонатор со вторым и второй с третьим, 
введите W=1 и L=LL. 

6. Дважды щёлкните по элементу MSUB и введите Er=10.28, H=1, T=0.005, 
Tand=0.0001 и ErNom=10.28. 

Окончательная отредактированная схема фильтра показана на рис. 1.63. 

Рис. 1.63 



1.2.3. Определение частот, добавление графика и анализ схемы. 
1. Откройте вкладку Proj в левом окне проекта и дважды щёлкните по Project Options 
или выберите в меню команду Options> Project Options. В открывшемся окне на 
вкладке Frequencies в поле Start(GHz) введите 2, в поле Stop(GHz) введите 6 и в поле 
Step(GHz) введите 0.2. Нажмите Apply и затем OK. 

2. Щёлкните по значку New Graph на панели инструментов. В открывшемся окне введи-
те имя графика LdB и нажмите OK. 

3. В левом окне проекта щёлкните по появившемуся имени графика LdB правой кнопкой 
мышки и выберите Add Measurement. В открывшемся окне в поле To Port Index вве-
дите 2, щёлкая по кнопке в правом конце этого поля. В поле From Port Index введите 
1. В поле dB установите “галочку”. Нажмите Apply и затем OK. 

4. Щёлкните по значку Analyze  на панели инструментов, чтобы выполнить анализ. 
5. Щёлкните правой кнопкой мышки по графику и выберите Properties. На вкладке Axes 
открывшегося окна в области Choose axis отметьте x. В области Divisions снимите “га-

лочку” в Auto divs и в поле Step вве-
дите 0.2. Нажмите Apply. Масштаб по 
левой оси по умолчанию определяется 
автоматически. При настройке схемы 
может быть удобным зафиксировать 
этот масштаб, чтобы он не изменялся в 
процессе настройки. Поэтому в облас-
ти Choose axis отметьте Left 1. В об-
ласти Limits снимите “галочку” в Auto 
limits и в поле Min введите -80. В об-
ласти Divisions снимите “галочку” в 
Auto divs и в поле Step введите 5. На-
жмите Apply и затем OK. Полученный 
график показан на рис. 1.64. Рис. 1.64 

1.2.4. Настройка схемы. 
1. Чтобы точнее отобразить график в полосе заграждения, добавьте частоты от 3.85 до 

4.25 с шагом 0.05, дважды щёлкнув по Project Options в левом окне проекта и отметив 
Add в открывшемся окне. 

2. Сделайте активным окно схемы. Выберите в меню команду Simulate>Tune Tool (Мо-

делировать>Инструмент настройки) или щёлкните по значку Tune Tool  на панели 
инструментов и переместите курсор на поле схемы. Курсор будет отображаться в виде 
крестообразной отвёртки. Поместите перекрестие курсора на переменную L1=14 и 
щёлкните левой кнопкой мышки. Цвет переменной должен измениться на синий. Затем 
поместите перекрестие курсора на переменную L2=14 и щёлкните левой кнопкой 

мышки. Аналогично назначьте для на-
стройки переменные WS1=1, WS2=1, 
S1=0.1, S2=0.1 и LL=3. Переместите кур-
сор на свободное место в окне схемы и 
щёлкните левой кнопкой мышки, чтобы 
отменить режим выбора переменных для 
настройки. 

3. Сделайте активным окно графика. Выбе-
рите в меню команду Simulate> Tune или 

щёлкните по значку Tune  на панели 
инструментов. Откроется окно Variable 

Tuner (Механизм настройки переменной, рис. 1.65). Установив курсор на верхнюю 
часть окна и, нажав кнопку мышки, можно переместить окно в любое удобное место. 

Рис. 1.65 
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4. Из графика рис. 1.64 видно, что характеристику необходимо сдвинуть вверх по часто-
те. Для этого необходимо уменьшить длину резонаторов L1 и L2. Пределы регулиров-
ки переменных отображаются в полях Min-> и Max->, текущее значение переменных – 
в поле Nom->. Установленные по умолчанию пределы регулировки могут быть на-
столько большими, что точную настройку выполнить трудно. Например, для L1 и L2 
эти пределы могут быть от 7 до 28 (см. рис. 1.65). Чтобы настройка была плавной, 

уменьшите эти пределы. Т.к. 
L1 и L2 нужно регулировать 
только в меньшую сторону, 
введите для этих переменных в 
поле Min-> значение 7, а в по-
ле Max-> - значение 14. Дви-
гайте движки у этих перемен-
ных в сторону уменьшения 
(т.е. вниз), пока не получите 
максимум ослабления на час-
тоте 4 ГГц. Затем, двигая 
движки у переменных S1 и S2, 
добейтесь максимального ос-
лабления на частоте 4 ГГц. 
Двигая движки у переменных 
WS1 и WS2, убедитесь, что 
при изменении ширины про-

водников связанных линий характеристика прак-
тически не изменяется и эти переменные можно 
оставить без изменения. Двигая движок у пере-
менной LL, убедитесь, что при уменьшении это-
го расстояния характеристика незначительно 
улучшается. Окончательная характеристика по-
сле настройки показана на рис. 1.66. Закройте 
окно настройки. 

Рис. 1.66 

5. Сделайте активным окно схемы. Значения пе-
ременных после настройки показаны на рис. 1.67. 

Рис. 1.67 

1.2.5. Статистический анализ. 
Поскольку проектируемый фильтр является узкополосным, его желательно спроекти-

ровать несколько выше по частоте т.к. сдвинуть характеристику в сторону нижних частот 
проще, например, приклеивая узкие пластины из поликора на резонаторы или удлиняя резо-
наторы кусочками фольги из индия. Чтобы определить, насколько выше по частоте нужно 
спроектировать фильтр, оценим разброс характеристики от технологических допусков. Для 
этого необходимо назначить переменные для проведения статистического анализа и опреде-
лить допуска. Очевидно, что наибольшее влияние на частоту заграждения фильтра будет 

влиять допуск на длину резонаторов L1 и 
L2. Заметное влияние могут так же ока-
зывать разброс диэлектрической прони-
цаемости и толщины подложки. Эти пе-
ременные и назначим для статистическо-
го анализа. 

1. Сделайте активным окно схемы. 
Щёлкните правой кнопкой мышки 
по переменной L1 и выберите Prop-
erties. Откроется диалоговое окно 
Edit Equation (рис. 1.68). В этом 
окне отметьте Use statistics (Ис-Рис. 1.68 
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пользовать статистику) и Normal (Нормальное распределение). В поле S.D. (Seated De-
viate – Установка отклонения) введите допуск на длину резонатора 0.02. Поле In per-
cent (В процентах) должно быть не отмеченным, чтобы допуск считался заданным в 
единицах длины, т.е. в мм, а не в процентах. Нажмите OK. 

2. Аналогично для статистиче-
ского анализа назначьте пере-
менную L2. 

3. Введите допуск на параметры 
подложки. Дважды щёлкните 
левой кнопкой мышки по эле-
менту MSUB. Откроется диало-
говое окно Element Options. На 
вкладке Parameters этого окна 
в столбце Value напротив па-
раметра H введите толщину 
подложки 0.98. Дело в том, что 
по ТУ допуск на толщину под-
ложки только минусовой -0.04, 
а в Microwave Office можно оп-

ределить только симметричный допуск. 
Чтобы остаться в поле возможных разме-
ров толщины, её можно задать 0.98 с сим-
метричным допуском 0.02. Откройте 
вкладку Statistics диалогового окна (рис. 
1.69). На этой вкладке отметьте столбец 
Use напротив параметров Er и H. Напро-
тив переменной Er отметьте столбец ln%, 
чтобы задать допуск в процентах, и в 
столбце Tol (Tolerance – допуск) введите 
2. Напротив переменной H в столбце Tol 
введите 0.02. Нажмите OK. 

Рис. 1.69 

Рис. 1.70
4. Сделайте активным окно графика и установите цель 
статистического анализа. Для этого щёлкните правой 
кнопкой мышки по группе Yield Goals в левом окне 
проекта и выберите Add Yield Goal. Откроется диало-
говое окно New Yield Goal (рис. 1.70). Отметьте 
Meas<Goal. Снимите “галочки” в полях Start Min и 
Start Max, и введите соответственно нижнюю частоту 
заграждения 3.9 и верхнюю 4.1 ГГц. В поле Goal start 
введите -50. Нажмите OK. 

Рис. 1.71 5. Щёлкните правой кнопкой мышки по графи-
ку и выберите Properties. В открывшемся ок-
не свойств графика на вкладке Yield Data от-
метьте Show traces (Показывать трассы) и All 
traces (Все трассы). Нажмите Apply и затем 
OK. 

6. Выполните статистический анализ, выбрав в 
меню команду Simulate>Yield Analysis. От-
кроется диалоговое окно Yield Analysis (рис. 
1.71). В выпадающем списке Analysis Meth-
ods выберите Yield Analysis, в поле Maxi-
mum Iteration введите 500. Нажмите Start. 
Во время выполнения статистического анали-
за в нижней части этого диалогового окна Рис. 1.72
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отображается общее количество выполненных выборок (Iter. =) и количество выборок, 
удовлетворяющих установленной цели, в процентах (Yield =). Из полученного графика 
(рис. 1.72) видно, что резонансная частота может смещаться примерно на 0.1 ГГц. 
Чтобы удалить из графика результаты статистического анализа, щёлкните по кнопке 

Clear в окне рис. 1.71. Или, если это окно уже закрыто, щёлкните по графику правой кноп-
кой мышки и выберите Properties. В открывшемся окне свойств графика на вкладке Yield 
Data снимите “галочку” в Show traces, нажмите Apply и OK. 

1.2.6. Создание электромагнитной структуры. 
1. Выберите в меню команду Options> Layout Options. В открывшемся окне на вклад-

ке Layout в поле Grid spacing (Шаг сетки) введите 0.1, в поле Database unit size 
(Размер базы данных единицы измерения, определяет точность размера клеток сет-
ки) введите 0.001. Откройте вкладку Dimension Line (Измерительная линия) в поля 
Font height (Высота шрифта) и Arrow size (Размер стрелки) введите 1. Нажмите 
OK. 

2. Сделайте активным окно схемы. Щёлкните по значку New Schematic Layout View 
на панели инструментов, откроется окно топологии схемы. Выберите в меню ко-

манду Edit>Select All и затем 
команду Edit>Snap Together. 

3. Щёлкните по значку Dimen-
sion Line на панели инстру-
ментов, установите курсор на 
левый край топологии фильт-
ра, нажмите левую кнопку 
мышки и, не отпуская кнопки, 
переместите курсор на правый 
край топологии, отпустите 
кнопку, двигая мышкой, уста-
новите размер длины фильтра 

и щёлкните мышкой. Аналогично установите размер ширины фильтра. Полученная 
топология показана на рис. 1.73. 

Рис. 1.73 

4. Выделите все элементы топологии и щёлкните по значку Copy на панели инстру-
ментов. 

5. Щёлкните по значку New Em Structure на панели инструментов и создайте элек-
тромагнитную структуру 
с именем FZ4. 
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6. Щёлкните по значку Sub-
strate Information на па-
нели инструментов. На 
вкладке Enclosure от-
крывшегося диалогового 
окна в поле X-
Dimension(mm) введите 
28.6 (длина электромаг-
нитной структуры должна 
быть точно равна длине 
топологии фильтра), в по-
ле X-Divisions введите 
286, в поле Y-
Dimension(mm) введите 

20, в поле Y-Divisions введите 200. Откройте вкладку Dielectric Layers. Для первого 
слоя введите толщину 10 мм. Для второго слоя введите толщину 1 мм, диэлектриче-
скую проницаемость 10.28, тангенс потерь 0.0001 и масштаб просмотра 4 (рис. 
1.74). Нажмите OK. 

Рис. 1.74 



7. Щёлкните по значку View All на панели инструментов, чтобы открыть всё окно то-
пологии. Щёлкните по значку Paste и поместите скопированную топологию по цен-

тру электромагнитной структу-
ры. 

8. Щёлкните по значку View Area 
на панели инструментов и вы-
делите часть топологии с пер-
вым резонатором так, чтобы ви-
деть сетку (рис. 1.75). Из рисун-
ка видно, что изгиб резонатора 
и несвязанный (вертикальный) 
проводник несколько не совпа-
дают с сеткой. Это может ска-
заться на точности анализа, хотя 
и не значительно. При желании 
топологию можно отредактиро-
вать следующим образом. 

Рис. 1.75

9. Щёлкните по значку Polygon Conductor на панели инструментов. Установите кур-
сор на верхний угол изгиба и щёлкните мышкой, переместите курсор к правому 

нижнему углу изгиба и снова щёлкните мышкой. Этот 
угол будет точно привязан к сетке. Перемещайте курсор 
к остальным углам изгиба, щёлкая мышкой, пока не по-
лучите замкнутый многоугольник изгиба (рис. 1.76). Он 
несколько не совпадает с прежним изгибом. Щёлкните 
по видимой части прежнего изгиба и нажмите клавишу 
Delete, чтобы удалить его. Щёлкните по вертикальному 
проводнику этого резонатора и удалите его. Щёлкните 
по горизонтальному проводнику резонатора, скопируйте 

его, щёлкните правой кнопкой мышки, чтобы развернуть проводник на 90 градусов 
и соедините с нижней стороной изгиба. Удалите изгибы и вертикальные проводники 
у двух последних резонаторов. Скопируйте изгиб первого резонатора и соедините 
его с горизонтальными проводниками второго и затем третьего резонаторов. При 

соединении изгиба с проводником второ-
го резонатора, разверните изгиб, щёлкая 
правой кнопкой мышки. Скопируйте вер-
тикальный проводник первого резонатора 
и соедините его с изгибом второго резо-
натора. Снова скопируйте вертикальный 
проводник первого резонатора и соеди-
ните его с изгибом третьего резонатора. 

Рис. 1.76

10. Щёлкните мышкой по входному провод-
нику топологии фильтра, затем щёлкните 

по значку Edge Port на панели инструментов и установите порт, отодвинув его ре-
ференсную плоскость вправо на dx: 1. Аналогично установите порт на выходной 
проводник фильтра. Полученная топология показана на рис. 1.77. 

Рис. 1.77

11. Выделите всю топологию, Щёлкните правой кнопкой мышки по любому элементу 
топологии и выберите Mesh/Material Properties. В открывшемся окне выберите ма-
териал 1/2oz Cu и нажмите OK. 

1.2.7. Анализ и уточнение топологии. 
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1. Сделайте активным окно графика и щёлкните по значку Analyze на панели инстру-
ментов. Полученный график показан на рис. 1.78. Характеристика электромагнит-
ной структуры лежит выше по частоте, что и требуется. Напомним, что частота за-
граждения по результатам статистического анализа должна быть около 4.1 ГГц. Од-



нако ослабление на частоте заграждения мало. Усилим связь резонаторов с основ-
ным проводником. 

2. Установите курсор на имя электромагнитной структуры FZ4 в левом окне проекта, 
нажмите левую кнопку мышки, переместите курсор на группу EM Structures и от-

пустите кнопку. Щёлкните правой кнопкой мышки по имени полученной копии 
электромагнитной структуры, выберите Rename EM Structure и переименуйте её в 
FZ4A. 

Рис. 1.78 Рис. 1.79 

3. Щёлкните по горизонтальному проводнику первого резонатора структуры FZ4A, 
нажмите клавишу Shift и, не отпуская её, щёлкните по изгибу этого резонатора и за-
тем по вертикальному проводнику. Все элементы первого резонатора будут выделе-
ны. 

4. Установите курсор на любой элемент выделенного резонатора, нажмите левую 
кнопку мышки и переместите резонатор вверх на dx: 0 dy: -0.1. Аналогично умень-
шите зазор на 0.1 мм у остальных резонаторов. 

5. Сделайте активным окно графика и щёлкните по значку Analyze на панели инстру-
ментов. Полученный график показан на рис. 1.79. Характеристика уже ближе к тре-
буемой. 

6. Щёлкните правой кнопкой мышки по имени структуры FZ4 в левом окне проекта и 
выберите Delete EM Structure, чтобы удалить эту структуру. 

7. Скопируйте структуру FZ4A, как описано в п. 2 и переименуйте её в FZ4. Дважды 
щёлкните по горизонтальному проводнику первого резонатора, установите курсор 
на ромбик посередине левой стороны этого проводника и сдвиньте эту сторону 
вправо на 0.1. Аналогично укоротите на 0.1 остальные два резонатора. 

8. Сделайте активным окно графика и щёлкните по значку Analyze на панели инстру-
ментов. Полученный график показан на рис. 1.80. Характеристику последней струк-

Рис. 1.81 
Рис. 1.80 
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туры FZ4 можно считать удовлетворительной. Размеры резонаторов в окончатель-
ной топологии показаны на рис. 1.81. 

1.3. Фильтр с полосой заграждения 4.5 – 5.5 ГГц 
Спроектировать фильтр, обеспечивающий ослабление не менее 50 дБ в полосе загра-

ждения от 4.5 до 5.5 ГГц. Полоса пропускания должна быть обеспечена от 0 до 3.5 ГГц и от 
6.5 до 10 ГГц. 

В этом примере сравним использование обычной схемы и схемы с Х-моделями.  

1.3.1. Создание электрической схемы. 
1. Создайте новый проект и сохраните его под именем FZ5. 
2. Т.к. в проекте будет две схемы с одинаковой подложкой, поместим элемент подложки 
в Global Definition, откуда он будет доступен для всех схем проекта. Дважды щёлкните 
по Global Definition, откройте в левом окне вкладку Elem, щёлкните мышкой по груп-
пе Substrates и перетащите элемент MSUB в окно Global Definition. 

3. Дважды щёлкните по элементу MSUB и в открывшемся 
окне введите Er=10.4, H=0.5, T=0.005, Rho=0.7118 (про-
водимость меди относительно золота), Tand=0.0001, Er-
Nom=10.4 (рис.1.82), нажмите OK. 
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4. Щёлкните по значку New Schematic и создайте схему с 
именем FilZ. 

5. Раскройте группу Microstrip, щёлкните мышкой по под-
группе Lines и перетащите элемент MLIN в окно схемы. 

6. Щёлкните мышкой по подгруппе Junctions, перетащите 
элемент MTEE$ в окно схемы и подключите его к право-
му плечу элемента MLIN. 

7. Щёлкните мышкой по подгруппе Lines, перетащите эле-
мент MLEF в окно схемы, три раза щёлкните правой кнопкой мышки и подключите его 
к плечу 3 элемента MTEE$. 

Рис. 1.82 

8. Выделите все элементы созданной схемы и щёлкните по значку Copy на панели инст-
рументов. 

9. Щёлкните по значку Paste на панели инструментов и подключите скопированные 
элементы к плечу 2 элемента MTEE$. 

10. Повторите п.9 ещё два раза. 
11. Перетащите элемент MLIN в окно схемы и подключите его к плечу 2 последнего эле-
мента MTEE$. 

12. Щёлкая по значку Port на панели инструментов, подключите порты к входу и выходу 
схемы. 

1.3.2. Добавление переменных, редактирование и анализ схемы. 
1. С помощью инструмента Tools>TXLine Определим, что длина полуволнового отрезка 
при диэлектрической постоянной 10.4 и толщине подложки 0.5 на частоте 5 ГГц равна 
примерно 5.7 мм. 

2. Щёлкая по значку Equation на панели инструментов, добавьте переменные LL1=5.7, 
LL2=5.7, LS1=5.7, LS2=5.7, WL1=0.45, WL2=0.45, WS1=0.45 и WS2=0.45. 

3. Дважды щёлкните по первому элементу MLIN и в открывшемся окне введите W=0.45, 
L=3. Эти же параметры введите для последнего элемента MLIN. 

4. Дважды щёлкните по второму элементу MLIN и в открывшемся окне введите 
W=WL1, L=LL1. Эти же параметры введите для предпоследнего элемента MLIN. 

5. Дважды щёлкните по третьему элементу MLIN и в открывшемся окне введите 
W=WL2, L=LL2. 

6. Дважды щёлкните по первому элементу MLEF и в открывшемся окне введите 
W=WS1, L=LS1. Эти же параметры введите для последнего элемента MLEF. 



7. Дважды щёлкните по второму элементу MLEF и в открывшемся окне введите 
W=WS2, L=LS2. Эти же параметры введите для третьего элемента MLEF. Отредакти-
рованная схема должна иметь вид, показанный на рис. 1.83. 
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8. Откройте вкладку Proj в левом окне проекта. Дважды щёлкните мышкой по Project 
Options в левом окне проекта и введите частоты от 0 до 10 ГГц с шагом 0.2. 

Рис. 1.83 

9. Щёлкните по значку New Graph на панели инструментов и создайте график LdB. 
Щёлкните правой кнопкой мышки по имени созданного графика в левом окне проекта 
и выберите Add Measurement. В открывшемся окне в области Meas. Type отметьте 
Port Parameters, в области Measurement отметьте S, в поле To Port Index введите 2, в 
поле From Port Index введите 1, отметьте dB, нажмите Apply и OK. 

10. Снова щёлкните по значку New Graph на панели инструментов и создайте график 
VSWR. Щёлкните правой кнопкой мышки по имени этого графика в левом окне проек-
та и выберите Add Measurement. В открывшемся окне в области Meas. Type отметьте 
Linear, в области Measurement отметьте VSWR, в поле Port Index введите 1, снимите 
отметку в dB, нажмите Apply и OK. 

11. Откройте окно графика LdB и щёлкните по значку Analyze на панели инструментов. 
Щёлкните правой кнопкой мышки по полученному графику и выберите Properties. На 
вкладке Axes для оси x снимите “галочку” в Auto divs и в поле Step введите 0.5. Для 
оси Left 1 снимите “галочки” в Auto limits и в Auto divs, в поле Min введите -70, в поле 
Max введите 0 и в поле Step введите 5. На вкладке Fonts нажмите кнопку Axis number. 
Во втором открывшемся окне в области Шрифт отметьте Arial, в области Начертание 
отметьте обычный, в области Размер отметьте 18 и нажмите OK. Будет возврат к пер-
вому окну, в котором нажмите Apply и OK. 

Рис.1.84 

12. Откройте окно графика VSWR и щёлкните по значку Analyze на панели инструмен-
тов. Щёлкните правой кнопкой мышки по полученному графику и выберите Properties. 
На вкладке Axes для оси x снимите “галочку” в Auto divs и в поле Step введите 0.5. Для 

Рис.1.85 



оси Left 1 снимите “галочки” в Auto limits и в Auto divs, в поле Min введите 0, в поле 
Max введите 10 и в поле Step введите 0.5. На вкладке Fonts введите те же параметры, 
что и в предыдущем пункте. 
Рассчитанный график вносимого ослабления показан на рис. 1.84, а коэффициента 

стоячей волны – на рис. 1.85. 

1.3.3. Оптимизация схемы. 
1. Откройте окно схемы. Щёлкните правой кнопкой мышки по переменной LL1 и выбе-

рите Properties. В открывшемся 
окне редактирования переменной 
отметьте Optimize и Constrain, в 
поле Upper bound введите 7, в 
поле Lower bound введите 3, на-
жмите OK. Аналогично с такими 
же параметрами назначьте для оп-
тимизации переменные LL2, LS1 
и LS2. 

2. Щёлкните правой кнопкой мыш-
ки по переменной WL1, отметьте 
Optimize и Constrain, в поле Up-
per bound введите 0.5, в поле 
Lower bound введите 0.2, нажми-
те OK. Аналогично с такими же 
параметрами назначьте для опти-

мизации переменную WL2. 

Рис.1.86 

3. Щёлкните правой кнопкой мышки по переменной WS1, отметьте Optimize и Con-
strain, в поле Upper bound введите 2, в поле Lower bound введите 0.2, нажмите OK. 
Аналогично с такими же параметрами назначьте для оптимизации переменную WS2. 

4. Откройте окно графика LdB. Щёлкните правой кнопкой мышки по группе Optimizer 
Goals в левом окне проекта и выберите Add Opt Coal. Сначала добавим цель оптими-
зации по ослаблению в нижней полосе пропускания. В открывшемся окне (рис. 1.86) в 
области Measurement отметьте имя схемы и оптимизируемую величину 
FilZ:DB(|S(2,1)|), Отметьте Meas>Goal, снимите “галочку” в Max и введите 3.5 в поле 
Stop, введите -0.7 поле Goal и нажмите OK. 

5. Добавьте цель оптимизации по ослаблению в верхней полосе пропускания. Отметьте 
FilZ:DB(|S(2,1)|), отметьте Meas>Goal, снимите “галочку” в Min и введите 6.5 в поле 

Start, введите -0.7 в поле Goal. 
6. Добавьте цель оптимизации по ос-
лаблению в полосе заграждении. 
Отметьте FilZ:DB(|S(2,1)|), отметь-
те Meas<Goal, снимите “галочки” в 
Min и Max, введите 4.5 в поле Start 
и 5.5 в поле Stop, введите -50 поле 
Goal. 

7. Добавьте цель оптимизации по 
КСВн в нижней полосе пропуска-
ния. Отметьте FilZ:VSWR(1), от-
метьте Meas<Goal, снимите “галоч-
ку” в Max, введите 3.5 в поле Stop, 
введите 1.5 поле Goal. 

8. Добавьте цель оптимизации по 
КСВн в верхней полосе пропуска-
ния. Отметьте FilZ:VSWR(1), от-

Рис.1.87 
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метьте Meas<Goal, снимите “галочку” в Min, введите 6.5 в поле Start, введите 1.5 поле 
Goal. 

9. Выберите в меню Simulate>Optimize. В открывшемся окне (рис. 1.87) выберите метод 
оптимизации Pointer-Robust Optimization, введите число итераций 2000 и нажмите 
Start. 
Полученный после оптимизации график ослабления показан на рис. 1.88, а КСВн – на 

рис. 1.89. Из этих графиков видно, что оптимизация хорошо справилась с характеристикой 
КСВн, но требование по полосе заграждения не выполняется. Попробуем исправить эту ха-
рактеристику ручной настройкой, причём так, чтобы значения переменных были кратны пя-
ти сотым (предполагаемый размер ячеек сетки в электромагнитной структуре). 

Рис.1.89 Рис.1.88 

Откройте окно схемы. Щёлкните по значку Tune Tool на панели инструментов и, устанавли-

вая курсор на переменные и щёлкая мышкой, назначьте все переменные для настройки. 
Рис.1.90

Откройте окно графика LdB. Щёлкните по значку Tune на панели инструментов. Характери-
стику необходимо сдвинуть вверх по частоте. Для этого двигайте движки переменных LS1 и 
LS2, определяющих длину шлейфов, в сторону уменьшения, чтобы сдвинуть график вверх 
по частоте. При необходимости подрегулируйте значения других переменных. Возможный 
вариант характеристики после настройки показан на рис. 1.90. 

Переменные получили значения: LL1=6.1, LL2=6.0, LS1=6.1, LS2=5.9, WL1=0.3, 
WL2=0.25, WS1=0.15 и WS2=0.4. 
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1.3.4. Создание электромагнитной структуры. 
1. Выберите в меню Options>Layout Options. В открывшемся окне в поле Grid spacing 
введите 0.01, в поле Database unit size введите 0.001, нажмите OK. 

2. Откройте окно схемы и щёлкните по значку New Schematic Layout View на панели 
инструментов. 

3. В открывшемся окне топологии схемы выделите все элементы топологии и щёлкните 
по значку Snap Together на панели инструментов. 

4. С помощью инструмента Measure на панели инструментов определим размер создан-
ной топологии 25.3х6.55 мм. 

5. Щёлкните по значку New EM Structure на панели инструментов и создайте структуру 
с именем FZ. 

6. Щёлкните по значку Substrate Information на панели инструментов. В открывшемся 
окне на вкладке Enclosure в поле X-Dimension(mm) введите 25.3, в поле X-Divisions 
введите 506. В поле Y-Dimension(mm) введите 8, в поле Y-Divisions введите 160. На 
вкладке Dielectric Layers для слоя 1 введите толщину слоя 6; для слоя 2 введите тол-
щину слоя 0.5, диэлектрическую проницаемость 10.4, тангенс потерь 0.0001, нажмите 
OK. 

7. Откройте окно топологии схемы. Это окно не отображается в левом окне проекта и 
если его не видно (закрыто другими окнами), упорядочите расположение окон, напри-

мер, выбрав в меню Win-
dow>Cascade. Выделите всю топо-
логию схемы и щёлкните по значку 
Copy на панели инструментов. От-
кройте окно электромагнитной 
структуры, щёлкните мышкой по 
значку Paste на панели инструментов 
и вставьте скопированную тополо-
гию в электромагнитную структуру 
так, чтобы края входного и выходно-
го проводников точно совпадали с 
границами корпуса. Щёлкните пра-
вой кнопкой мышки по любому эле-
менту топологии (вся топология 

должна быть выделена) и выберите Mesh/Material Properties. В открывшемся окне вы-
берите материал 1/2oz Cu и нажмите OK. 

Рис.1.91 

8. Щёлкните мышкой по входному проводнику, чтобы выделить его, затем щёлкните 
мышкой по значку Edge Port на панели инструментов, установите порт на входе 
фильтра и сдвиньте референсную плоскость вправо на 1 мм. Аналогично установите 
порт на выходе фильтра. 

9. Откройте окно графика LdB и щёлкните по значку Analyze на панели инструментов.  
Рассчитанный график показан на рис. 1.91. Характеристика не удовлетворяет требо-

ваниям в полосе заграждения и требуется редактирование электромагнитной структуры. 
Создадим схему с использованием Х-моделей. 

Х-модели являются моделями, полученными на основе электромагнитного моделиро-
вания. Эти модели объединяют возможности электромагнитного (высокая точность) и ли-
нейного (высокое быстродействие, возможность проведения настройки, оптимизации и ста-
тистического анализа) моделирования. Имена всех Х-моделей оканчиваются на Х (например, 
MTEEX, MSTEPX, MBEND90X), и их легко отличить от других моделей. 

Любая Х-модель должна иметь таблицу данных, сгенерированную для модели на под-
ложке с определённой диэлектрической проницаемостью. Для некоторых типичных подло-
жек (например, для диэлектрической проницаемости, равной 9.8) такие таблицы сгенериро-
ваны компанией AWR и включены в Microwave Office. Эти модели находятся в корневом ка-
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талоге программы в папке EM_Models (файлы с расширением EMX). Если для применяемого 
материала такой таблицы нет, она должна бать заполнена до выполнения анализа. 

Замечание. Вместо заполнения Х-модели можно использовать имеющуюся запол-
ненную модель с ближайшим значением диэлектрической проницаемости, введя это 
значение в параметр подложки ErNom. Например, имеющийся файл Micro-
strip_10p2_MTEEX_A.EMX означает, что это Х-модель микрополоскового Т-
сочленения для материала с диэлектрической проницаемостью, равной 10.2. Если в 
параметры подложки рис. 1.82 этого примера ввести ErNom=10.2, то заполнения мо-
дели не потребуется. На точности анализа это обычно сказывается незначительно. 

1.3.5. Создание схемы с Х-моделями. 
1. Откройте окно схемы FilZ. Щёлкните мышкой по значку Tune Tool на панели инст-
рументов и, устанавливая курсор на переменные и щёлкая мышкой, отмените настрой-

ку для всех переменных. Установите курсор на имя схемы в левом окне проекта, на-
жмите левую кнопку мышки и, не отпуская кнопки, переместите курсор на группу Cir-
cuit Schematics. Щёлкните по имени скопированной схемы правой кнопкой мышки и 
переименуйте копию схемы в FilZ_X. 

Рис.1.92 

2. Откройте вкладку Elem в левом окне проекта и раскройте группу Microstrip. Щёлк-
ните левой кнопкой мышки по подгруппе Junctions в левом окне проекта. Щёлкните 
мышкой по первому элементу MTEE$, чтобы выделить его, и нажмите клавишу Delete, 
чтобы удалить этот элемент. Перетащите элемент MTEEX$ в окно схемы и установите 
его вместо первого удалённого элемента MTEE$. Аналогично замените все остальные 
элементы MTEE$ на элементы MTEEX$. 

3. Щёлкните мышкой по подгруппе Lines в левом окне проекта и замените все элементы 
MLEF на элементы MLEFX. 

4. Дважды щёлкая мышкой по переменным, присвойте им первоначальные значения, как 
будто схема создаётся впервые: LL1=5.7, LL2=5.7, LS1=5.7, LS2=5.7, WL1=0.45, 
WL2=0.45, WS1=0.45 и WS2=0.45. Схема должна выглядеть, как на рис. 1.92. 

5. Дважды щёлкните по первому элементу MLEFX и введите W=WS1, L=LS1. Эти же 
значения параметров введите для последнего элемента MLEFX.Для второго и третьего 
элементов MLEFX введите W=WS2, L=LS2. 

Рис.1.93

1.3.6. Заполнение Х-моделей, анализ и оптимизация схемы. 
1. Откройте вкладку Proj в левом окне проекта и сделайте активным окно графика LdB. 
Щёлкните левой кнопкой мышки по значку Analyze на панели инструментов. Если в 
Microwave Office имеется заполненная Х-модель, начнётся анализ схемы. В противном 
случае открывается окно, в котором сообщается, что модель не заполнена и нужно её 
заполнить (рис. 1.93). В этом случае закройте это окно сообщения и выполните сле-
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дующие действия для заполнения Х-модели. Имейте ввиду, что заполнение Х-модели 
занимает длительное время (может до нескольких часов). Но однажды заполненная Х-
модель затем может использоваться во всех проектах, в которых используется материал 

подложки с такой же диэлек-
трической проницаемостью. 

2. Откройте окно схемы 
FilZ_X. Дважды щёлкните по 
первому элементу MTEEX$. 
В открывшемся окне свойств 
элемента щёлкните по кнопке 
Show Secondary (показать 
дополнительные). В окне бу-
дут отображены дополни-
тельные параметры элемента, 
которые по умолчанию скры-
ты, а кнопка изменит своё имя 
на Hide Secondary (скрыть 
дополнительные). В поле 
AutoFill измените значение 0 

на 1 и нажмите OK. 
Рис.1.94

3. Дважды щёлкните по первому элементу MLEFX и аналогично в поле AutoFill изме-
ните значение 0 на 1, нажмите OK. 

4. Откройте окно графика и щёлкните левой 
кнопкой мышки по значку Analyze на пане-
ли инструментов. Откроется окно для выбо-
ра решающего устройства. Просто закройте 
это окно, согласившись с предлагаемым по 
умолчанию. Начнётся процесс заполнения 
Х-модели и в левом окне проекта в группе 
EM Structures появится электромагнитная 
структура с именем EM_Work_Space. Про-
цесс заполнения отображается точно так же, 
как и обычный процесс электромагнитного 
анализа. Если процесс автозаполнения оста-
новить, щёлкнув мышкой по кнопке Cancel в 
окне отображения процесса, открыть окно 
электромагнитной структуры 
EM_Work_Space, щёлкнув правой кнопкой 
мышки по этому имени, и продолжить ана-
лиз, щёлкнув по значку Analyze на панели 
инструментов, то можно наблюдать, как из-
меняется электромагнитная структура модели 
при её заполнении (рис. 1.94). При этом про-
цесс автозаполнения будет продолжен с того 
момента, где был остановлен. Можно вообще 
выгрузить проект и выключить компьютер. 
При следующей загрузке проекта и запуска 

анализа этот процесс будет продолжен с момента его остановки. 

Рис.1.95

Рис. 1.96 

5. После окончания процесса заполнения сразу же будет рассчитан график схемы (рис. 
1.95, пунктирная линия). 
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6. Выполним оптимизацию этой схемы. Щёлкните правой кнопкой мышки по имени од-
ной из целей оптимизации в левом окне проекта и выберите Properties. В открывшемся 
окне в области Measurement отметьте имя схемы FilZ_X:DB(|S(2,1)|), нажмите OK. То 
же самое сделайте для всех целей оптимизации. 



7. Выберите в меню команду Simulate>Optimize. В открывшемся окне выберите метод 
оптимизации Pointer-Robust Optimization, введите количество итераций 2000 и на-
жмите Start. Оптимизация и для этой схемы не привела к улучшению характеристики 
(рис. 1.96), поэтому подстроим схему вручную. 

8. Откройте окно схемы FilZ_X, щёлкните по значку Tune Tool на панели инструментов 
и назначьте все переменные для настройки. 

9. Откройте окно графика LdB. щёлкните по значку Tune на панели инструментов и, 
двигая движки переменных на блоке настройки, добейтесь удовлетворительной харак-
теристики, стараясь, чтобы значения переменных были кратны пяти сотым (рис. 1.97). 

Рис. 1.97

1.3.7. Создание и анализ электромагнитной структуры. 
10. Откройте окно схемы FilZ_X и щёлкните по значку New Schematic Layout View на 
панели инструментов. 

11. В открывшемся окне топологии схемы выделите все элементы топологии и щёлкните 
по значку Snap Together на панели инструментов. 

12. С помощью инструмента Measure на панели инструментов определим размер создан-
ной топологии 24.2х6.45 мм. 

13. Установите курсор на имя электромагнитной структуры FZ, нажмите левую кнопку 
мышки и переместите курсор на группу EM Structures в левом окне проекта. Переиме-
нуйте скопированную структуру в FZ_X. Выделите всю топологию и нажмите клавишу 
Delete, чтобы удалить её. Щёлкните по значку Substrate Information на панели инст-
рументов. В открывшемся окне на вкладке Enclosure в поле X-Dimension(mm) введите 
24.2, в поле X-Division введите 484, нажмите OK. 

14. Откройте окно топологии схемы. Выделите всю топологию схемы и скопируйте её в 
буфер обмена, щёлкнув по значку Copy на панели инструментов. Откройте окно элек-
тромагнитной структуры, щёлкните мышкой по значку Paste на панели инструментов и 
вставьте скопированную топологию в электромагнитную структуру так, чтобы края 
входного и выходного проводников точно совпадали с границами корпуса (рис. 1.98). 
Щёлкните правой кнопкой мышки по любому элементу топологии (вся топология 
должна быть выделена) и выберите Mesh/Material Properties. В открывшемся окне вы-
берите материал 1/2oz Cu и нажмите OK. 

15. Щёлкните мышкой по входному проводнику, чтобы выделить его, затем щёлкните 
мышкой по значку Edge Port на панели инструментов и установите порт на входе 
фильтра. Аналогично установите порт на выходе фильтра. Должна получиться структу-
ра, показанная на рис. 1.98. 
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16. Откройте окно графика LdB 
и щёлкните по значку Ana-
lyze на панели инструментов. 

17. Чтобы не затемнять рассчи-
танный график характери-
стиками предыдущих схемы 
и электромагнитной структу-
ры, не удаляя их из проекта 

(на всякий случай), можно сделать 
следующее. Щёлкните правой кноп-
кой мышки по графику и выберите 
Properties. В открывшемся окне 
свойств графика на вкладке Traces в 
области Style в столбце Color отметь-
те имя схемы FilZ:DB(|S(2,1)|) (имя 
схемы или электромагнитной струк-
туры в отмеченной строке отобража-
ется в поле Measurement). В строке 
редактирования в нижней части об-
ласти Style щёлкните по кнопке в 
правом конце поля столбца Symbol и 
в выпадающем списке выберите none. 
То же самое сделайте в столбце Line 
(рис. 1.99). Таким же образом сними-
те отображение символов и линии для 

характеристики электромагнитной структуры FZ. Нажмите Apply и OK. 

Рис. 1.98 

Рис. 1.99 

18. Откройте график VSWR и измените его свойства, как описано в предыдущем пункте. 
Рассчитанный график LdB показан на рис. 1.100, а график КСВн – на рис. 1.101. Ха-

рактеристика схемы довольно хорошо совпадает с характеристикой электромагнитной 
структуры и редактирования топологии не требуется. 

В составе Microwave Office имеется пример …\Examples\Circuit Design 
Types\Filters\18Ghz_LPF, в котором показано моделирование фильтра на шлейфах, в схеме 
которого используются Х-модели и учитывается связь между шлейфами. Т.е. вместо элемен-
тов отдельных отрезков линий используется элемент связанных линий. Показано хорошее 
совпадение характеристик схемы, электромагнитной структуры и экспериментальной харак-
теристики. 

Очевидно, чем точнее схема отражает особенности электромагнитной структуры, тем 
точнее выполняется линейное моделирование и сокращается время на проектирование. Од-
нако добиться этого не всегда просто и ожидаемого эффекта от использования Х-моделей 
может не получиться. 

Рис. 1.101 Рис. 1.100
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2. Фильтры нижних частот 

2.1. Фильтр с полосой пропускания до 3 ГГц 
Спроектировать фильтр нижних частот с полосой пропускания до 3 ГГц и обеспечи-

вающий ослабление сигнала не менее 30 дБ на частоте 4.5 ГГц. Для реализации фильтра вы-
берем структуру из чередующихся высокоомных отрезков линии (индуктивности) и низко-
омных отрезков (ёмкости). 

2.1.1. Создание схемы фильтра. 
Вначале создадим схему, которая кажется очевидной. 

1. Создайте новый проект и сохраните его под именем FN3. 
2. Щёлкните по значку New Schematic и создайте схему с именем FN. 
3. Откройте в левом окне вкладку Elem и раскройте группу Microstrip. 
4. Щёлкните по подгруппе Lines. Найдите элемент MLIN и перетащите его в окно схе-
мы. 

5. Щёлкните по подгруппе Junctions. Найдите элемент 
MSTEP$, перетащите его в окно схемы и подключите 
к правому выводу элемента MLIN. Щёлкните по эле-
менту MLIN, чтобы выделить его. Щёлкните по знач-
ку Copy и затем по значку Paste на панели инстру-
ментов. Подключите скопированный элемент к пра-

вому выводу элемента MSTEP$ (рис. 2.1). 
Рис. 2.1

6. Щёлкните по элементу MSTEP$, нажмите клавишу Shift и щёлкните по второму эле-
менту MLIN. Оба эти элемента должны быть выделены (рис.2.1). Щёлкните по значку 
Copy и затем по значку Paste на панели инструментов. Подключите скопированные 
элементы к правому выводу схемы. 

7. Щёлкните по значку Paste на панели инструментов и подключите скопированные 
элементы к правому выводу схемы. 

8. Повторите шаг 7. 
9. Щёлкните по значку Paste на панели инструментов, переместите курсор в окно схемы, 
три раза щёлкните правой кнопкой мышки, чтобы развернуть скопированные элементы 
на 270 градусов, и подключите их к последнему выводу схемы. 

10. Щёлкните по значку Paste на панели инструментов, переместите курсор в окно схемы, 
два раза щёлкните правой кнопкой мышки, чтобы развернуть скопированные элементы 
на 180 градусов, и подключите их к последнему выводу схемы. 

11. Два раза повторите шаг 10. 
12. Щёлкните по значку Port на панели инструментов и подключите порт ко входу схемы. 
Аналогично подключите порт к выходу схемы. 

13. Щёлкните по группе Substrates в левом окне проекта, выберите элемент MSUB и пе-
ретащите его на свободное место в окне схемы. Полученная схема показана на рис. 2.2. 

Рис. 2.2 
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2.1.2. Добавление переменных, редактирование элементов, определение 
частот, добавление графика и анализ схемы. 

Поскольку никаких предварительных расчётов не проводилось, присвоим перемен-
ным заведомо малые значения. В таком случае не нужно гадать, в какую сторону изменять 
эти значения при настройке. 

1. Щёлкните по значку Equation на панели инструментов. Переместите курсор в окно 
схемы, поместите поле для ввода переменной в свободном месте на поле схемы и 
щёлкните мышкой. Введите LI1=2. Аналогично введите переменную LI2=2. Эти пере-
менные будут определять длину индуктивностей. 

2. Аналогично введите переменные LC1=2, LC2=2, WC1=1 и WC2=1, которые будут 
определять длину и ширину емкостей. 

3. Дважды щёлкните по первому элементу MLIN (ID=TL1) в схеме и введите W=0.5 и 
L=3. Такие же значения введите и для последнего элемента MLIN. Хотя значение дли-
ны не принципиально для этих элементов и можно ввести любую длину или оставить 
по умолчанию. Нажмите OK. 

4. Дважды щёлкните по второму элементу MLIN (ID=TL3) и введите W=0.1 и L= LI1 
(ширину для индуктивных полосок выберем постоянной и равной 0,1 мм). Эти же зна-
чения введите для предпоследнего элемента ID=TL14. 

5. Для третьего (ID=TL4) и седьмого (ID=TL12) элементов введите W=WC1 и L=LC1. 
6. Для четвёртого (ID=TL6) и шестого (ID=TL10) элементов введите W=0.1 и L=LI2. 
7. Для пятого элемента (ID=TL8) введите W=WC2 и L=LC2. 
8. Дважды щёлкните по элементу MSUB и введите значения параметров Er=10.27, 

H=0.5, T=0.005, Tand=0.0001 и ErNom=10.27. Нажмите OK. Отредактированная схема 
показана на рис. 2.3. 

Рис. 2.3 
9. Щёлкните по значку Tune Tool на панели инструментов. Поочерёдно устанавливая 
курсор на переменные так, чтобы курсор отображался в виде перекрестия, и, щёлкая 
мышкой, назначьте все переменные для настройки. Затем щёлкните мышкой на сво-
бодном месте на поле схемы, чтобы отменить режим назначения переменных для на-
стройки. 

10. Откройте вкладку Proj в левом окне проекта и дважды щёлкните по Project Options. 
В открывшемся окне на вкладке Frequencies в поле Start(GHz) введите 2, в поле 
Stop(GHz) введите 6 и в поле Step(GHz) введите 0.2. (Переключаться между полями 
можно, нажимая клавишу Tab). Нажмите Apply и затем OK. 

11. Щёлкните по значку New Graph на панели инструментов и создайте график с именем 
LdB. 

12. Щёлкните правой кнопкой мышки по имени графика LdB в левом окне проекта и вы-
берите Add Measurement. В открывшемся окне в поле To Port Index введите 2, в поле 
From Port Index введите 1 и установите “галочку” в поле dB. Нажмите Apply и затем 
OK. 
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13. Щёлкните по значку Analyze на па-
нели инструментов, чтобы выполнить 
анализ. 

14. Щёлкните по графику правой кноп-
кой мышки. В открывшемся окне на 
вкладке Axes отметьте x. Снимите 
“галочку” в Auto divs, в поле Step 
введите 0.2 и щёлкните Apply. От-
метьте Left 1. Снимите “галочку” в 
Auto limits и в поле Min введите -50. 
Снимите “галочку” в Auto divs, в поле 
Step введите 5 и щёлкните Apply. На-
жмите OK. Полученный график пока-
зан на рис. 2.4. 

Рис. 2.4 

2.1.3. Настройка схемы. 
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те окно схемы активным. 

е курсор на второй эле-

1. Щёлкните по значку Tune на панели инструментов. В открывшемся блоке настройки 
сдвиньте движок у переменной WC1 в сторону увеличения (вверх). При значении этой 
переменной больше 2-х анализ прекращается и появляется окно с сообщением об 

ошибке (рис. 2.5). Это объясняется тем, 
что все элементы имеют определённые 
пределы применимости, о которых для 
большинства элементов можно узнать, 
если дважды щёлкнуть по элементу и в 
открывшемся окне нажать кнопку Ele-
ment Help. В нашем случае нарушается 
ограничение для элементов MSTEP$, 
для которых скачок ширины полосок 
не должен превышать 20. В такой си-
туации остаётся удалить эту неодно-
родность из схемы или использовать X-
модель соответствующего элемента. В 
данном случае можно пойти на неко-
торую потерю точности анализа и 
удалить неоднородности из схемы. 

2. Сделай

Рис. 2.5 

Щёлкните по первому элементу 
MSTEP$ и нажмите клавишу Delete, 
чтобы удалить этот элемент из схемы. 
Аналогично удалите все элементы 
MSTEP$. 

3. Установит
мент MLIN, нажмите левую кнопку 
мышки и соедините этот элемент с 

первым элементом MLIN. Аналогично соедините все остальные элементы схемы. Вос-
становите прежнее значение переменной WC1=1. Полученная схема показана на рис. 
2.6. 

Рис. 2.6 

4. Сделайте активным окно графика. Щёлкните по зрачку Analyze на панели инструмен-
тов. Полученная характеристика почти не отличается от предыдущей характеристики. 

5. Чтобы удобнее было наблюдать характеристику при настройке, установим маркеры на 
частоты 3 ГГц и 4.5 ГГц. Выберите в меню команду Graph>Marker>Add Marker, пе-
реместите курсор на график, нажмите левую кнопку мышки и, двигая мышкой, пере-
местите маркер на частоту 3 ГГц, отпустите кнопку. Аналогично установите маркер на 
частоту 4.5 ГГц. 
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6. Щёлкните по зрачку Tune на панели инструментов. Двигая движки переменных на 
блоке настройки, добейтесь нужной характеристики (рис. 2.7). При необходимости 
можно изменить пределы регулировки переменных, изменяя значения в полях Max-> и 
Min-> на блоке настройки. 

Рис. 2.7 Рис.2.8 

7. Сделайте активным окно схемы. После настройки переменные получили следующие 
значения: LI1=3.34, LI2=4.09, LC1=1.8, LC2=2.1, WC1=5.9 и WC2=7.52 (рис. 2.8). 

2.1.4. Создание и анализ электромагнитной структуры. 
1. Щёлкните по значку New Em Structure на панели инструментов и создайте электро-
магнитную структуру с именем FN3. 

2. Щёлкните по значку Substrate In-
formation на панели инструментов. 
На вкладке Enclosure в поле X-
Dimension (mm) введите 14.8, в поле 
X-Divisions введите 148, , в поле Y-
Dimension (mm) введите 11,5 и  в 
поле Y-Divisions введите 115. На 
вкладке Dielectric Layers отметьте 
верхний слой (Layer 1) и в строке 
редактирования (нижняя строка) в 
поле Thickness mm введите 6. От-
метьте второй слой. В поле Thickness 
mm введите 0.5, в поле er введите 
10.27, в поле Loss Tangent введите 

0.0001 и в поле View Scale введите 4 (рис. 2.9). Нажмите OK. 

Рис. 2.9 

3. Щёлкните по значку View All на панели инструментов, чтобы видеть всю электромаг-
нитную структуру. Чтобы начертить входной проводник, щёлкните по значку Rectangle 
Conductor на панели инструментов. Поместите курсор на левый край электромагнит-
ной структуры и нажмите клавишу Tab. В поле x введите 0, в поле y введите 4, нажми-
те OK и затем клавишу Tab. В поле dx введите 3, в поле dy введите 0.5. Нажмите OK. 

4. Чтобы начертить первый индуктивный проводник, щёлкните по значку Polygon Con-
ductor на панели инструментов. Установите курсор на правую сторону начерченного 
входного проводника на 2 клеточки сетки выше нижней стороны входного проводника 
и щёлкните левой кнопкой мышки. Затем последовательно перемещайте курсор сле-
дующим образом, щёлкая мышкой после каждого перемещения: на 0.3 вправо, на 2.7 
вниз, на 0.4 вправо, на 0.1 вверх, на 0.3 влево, на 2.7 вверх, на 0.4 влево (здесь курсор 
должен оказаться на правой стороне входного проводника) и в этом месте щёлкните 
мышкой два раза. 



5. Чтобы начертить первый емкостной проводник, щёлкните по значку Rectangle Con-
ductor на панели инструментов. Поместите курсор в любое свободное место на элек-

тромагнитной структуре и нажмите клавишу Tab. Вве-
дите в поля x и y любые значения координат в пределах 
электромагнитной структуры, например, 5 и 5. Нажмите 
OK и затем снова нажмите клавишу Tab. В поле dx вве-
дите 1.8, поле dy введите 5.9, Нажмите OK. Установите 
курсор на полученный прямоугольник, нажмите левую 
кнопку мышки и переместите прямоугольник так, чтобы 
соединить индуктивный проводник с серединой емкост-
ного прямоугольника. Должна получиться топология, 
показанная на рис. 2.10. 

6. Чтобы начертить второй индуктивный проводник, 
щёлкните по значку Polygon Conductor на панели инструментов. Установите курсор на 
середину правой стороны емкостного проводника и щёлкните левой кнопкой мышки. 
Затем последовательно перемещайте курсор следующим образом, щёлкая мышкой по-
сле каждого перемещения: на 0.3 вправо, на 3.5 вверх, на 0.4 вправо, на 0.1 вниз, на 0.3 
влево, на 3.5 вниз, на 0.4 влево (здесь курсор должен оказаться на правой стороне емко-
стного проводника) и в этом месте щёлкните мышкой два раза. 

Рис. 2.10 

7. Чтобы начертить второй емкостной проводник, щёлкните по значку Rectangle Con-
ductor на панели инструментов. Поместите курсор в любое свободное место на элек-
тромагнитной структуре и нажмите клавишу Tab. Введите в поля x и y любые значения 
координат в пределах электромагнитной структуры, например, 7 и 5. Нажмите OK и 
затем снова нажмите клавишу Tab. В поле dx введите 2,1, в поле dy введите 7,5, На-
жмите OK. Установите курсор на полученный прямоугольник, нажмите левую кнопку 
мышки и переместите прямоугольник так, чтобы соединить емкостной проводник с ин-
дуктивным. 

8. Выделите второй индуктивный проводник, щёлкнув по нему мышкой. Щёлкните по 
значку Copy и затем по значку Paste на панели инструментов. Поместите скопирован-
ный проводник на свободном месте на электромагнитной структуре. Щёлкните левой 
кнопкой мышки, чтобы закрепить его, и затем щёлкните по нему правой кнопкой мыш-
ки и выберите Flip. Установите курсор на скопированный проводник, нажмите левую 
кнопку мышки и, двигая мышкой, создайте его зеркальное отображение. Установив 
курсор на полученный проводник и, нажав кнопку мышки, соедините его с емкостным 
проводником фильтра. 

9. Выделите первый емкостной проводник, скопируйте его и соедините с последним ин-
дуктивным проводником. 

10. Скопируйте первый индуктивный проводник, создайте его зеркальное отображение и 
соедините с последним емкостным проводником. 

11. Скопируйте входной проводник и соедините его с последним индуктивным проводни-
ком. Дважды щёлкните по созданному выходному проводнику, установите курсор на 
ромбик посередине правой стороны этого проводника, так чтобы он отображался в ви-
де двойной стрелки, нажмите левую кнопку мышки и совместите эту сторону с правым 
краем корпуса. 

12. Выделите входной проводник, щёлкнув по нему мышкой. Щёлкните по значку Edge 
Port на панели инструментов, установите курсор на левый край входного проводника 
так, чтобы на этом краю появился небольшой прямоугольник, и щёлкните мышкой. 
Щёлкните по этому прямоугольнику, установите курсор на правую сторону прямо-
угольника так, чтобы курсор отображался в виде двойной стрелки. Нажмите левую 
кнопку мышки и переместите курсор вправо на величину dx: 1. Аналогично установите 
порт на выходной проводник. 

13. Выделите все элементы топологии, выбрав в меню Edit>Select All. Или установите 
курсор левее и выше электромагнитной структуры, нажмите левую кнопку мышки и 
переместите курсор правее и ниже электромагнитной структуры. Установите курсор на 
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любой элемент топологии, нажмите левую кнопку мышки и расположите топологию 
симметрично относительно стенок корпуса. 

14. Щёлкните правой кнопкой мышки по любому элементу топологии (все элементы 
должны быть выделены) и выберите Mesh/Material Properties. В открывшемся окне в 
поле Selected Material введите 1/2oz Cu, щелкнув по кнопке в правом конце этого по-
ля. Щёлкнув по кнопке Edit Material в этом окне можно изменить отображаемый цвет 
материала. Нажмите OK. Полученная электромагнитная структура показана на рис. 
2.11. 

15. Сделайте активным окно графика и щёлкните по значку Analyze на панели инстру-
ментов. Полученный график показан на рис. 2.12. 

Рис. 2.11 Рис. 2.12

2.1.5. Редактирование электромагнитной структуры. 
Как видно из графиков, характеристику электромагнитной структуры для получения 

требуемых параметров необходимо сдвинуть в сторону верхних частот. Для этого уменьшим 
ширину емкостных проводников. 

1. Установите курсор на имя электромагнитной структуры EM3 в левом окне проекта, 
нажмите левую кнопку мышки и переместите курсор на группу EM Structures. На ра-
бочем поле проекта откроется окно с копией электромагнитной структуры, а в левом 
окне проекта в группе EM Structures появится имя скопированной структуры Copy of 
EM3. Щёлкните правой кнопкой мышки по этому имени и выберите Rename EM 
Structure. Переименуйте структуру в EM3A. 
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установите курсор на ромбик посередине

-

туры EM3 в 

2. Дважды щёлкните по первому емкостному проводнику в скопированной структуре, 
 верхней стороны так, чтобы он отображался в 

виде двойной стрелки, нажмите кнопку 
мышки и сдвиньте эту сторону вниз на dy: 
0.2. Затем установите курсор на ромбик по-
середине нижней стороны и сдвиньте эту 
сторону вверх на величину dy: -0.2. На та-
кую же величину уменьшите размеры вто-
рого и третьего емкостных проводников. 

3. Щёлкните по значку Analyze на панели 
инструментов. Полученный график пока
зан на рис. 2.13. Как видно из этого графи-
ка, необходимо и дальше уменьшать ши-
рину емкостных проводников. 

4. Щёлкните правой кнопкой мышки по 
имени электромагнитной струкРис. 2.13

левом окне проекта и выберите Delete EM Structure, чтобы удалить эту структуру. 



5. Скопируйте оставшуюся электромагнитную структуру EM3A, как описано в п. 3 и пе-
реименуйте её в EM3. 

6. Укоротите все емкостные проводники на 1 мм (по 0.5 мм с верхней стороны и нижней, 
как описано в п. 3). Откройте окно графика и щёлкните по значку Analyze на панели 
инструментов. Полученный график показан на рис. 2.14. Полученная характеристика 
уже удовлетворяет поставленным требованиям. Окончательная топология фильтра по-
казана на рис. 2.15. 

2.2. Фильтр на емкостных секторах. 
Требуется спроектировать фильтр с полосой пропускания до 5 ГГц с ослаблением не 

менее 30 дБ в диапазоне 8-14 ГГц на подложке из материала ФЛАН10 толщиной 0,5 мм. 

Рис. 2.15Рис.2.14 

2.2.1. Создание схемы. 
1. Создайте новый проект и сохраните его с именем FN5. 
2. Создайте схему с именем Fil. 
3. В левом окне проекта откройте вкладку Elem, раскройте группу Microstrip и щёлкни-
те по подгруппе Lines. 

4. Найдите в нижней части левого окна элемент MLIN, перетащите его в окно схемы и 
щёлкните левой кнопкой мышки. 

5. Повторите п.4 и соедините второй элемент MLIN с первым. 
6. В левом окне проекта в группе Microstrip щёлкните по подгруппе Other. Найдите в 
нижней части левого окна элемент MSRSTUB2, перетащите его в окно схемы и соеди-
ните со вторым элементом MLIN. 

7. Щёлкните по одному из элементов MLIN, затем последовательно щёлкните по знач-
кам Copy и Paste на панели инструментов и соедините скопированный элемент с эле-
ментом MSRSTUB2. 

8. Щёлкните по элементу MSRSTUB2, затем последовательно щёлкните по значкам 
Copy и Paste на панели инструментов, переместите курсор на поле схемы, щёлкните 
два раза правой кнопкой мышки, чтобы развернуть скопированный элемент на 180 гра-
дусов, и соедините его с последним элементом MLIN. 

9. Скопируйте любой элемент MLIN, как описано выше, щёлкните три раза правой 
кнопкой мышки, чтобы развернуть скопированный элемент на 270 градусов, и соеди-
ните его со вторым элементом MSRSTUB2. 

10. Щёлкните по второму элементу MSRSTUB2, скопируйте его и соедините с последним 
элементом MLIN. 

11. Нажмите клавишу Shift и, не отпуская клавиши, щёлкните по первому и затем по вто-
рому элементам MLIN, чтобы выделить оба эти элемента. Скопируйте эти элементы, 
щёлкните два раза правой кнопкой мышки, чтобы развернуть их на 180 градусов, и со-
едините с последним элементом MSRSTUB2. 
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12. Щёлкните по значку Port на 
панели инструментов и под-
ключите его ко входу фильтра. 
Аналогично подключите порт к 
выходу фильтра. 

13. Щёлкните по группе Sub-
strates в левом окне проекта, 
найдите в нижней части левого 
окна элемент подложки MSUB, 
перетащите его в окно схемы и 
поместите на свободном месте 
в окне схемы. 
Полученная схема показана на 

рис. 2.16. Рис. 2.16

2.2.2. Добавление переменных редактирование элементов схемы. 
Ширину индуктивных проводников будем считать постоянной и равной 0,1 мм. Углы 

секторов и ширину их основания также будем считать постоянными и равными соответст-
венно 60 градусов и 0,5 мм. Хотя, при необходимости, и эти параметры могут быть заданы 
для настройки. 

1. Щёлкните по значку Equation на панели инструментов, поместите курсор на свобод-
ное место в схеме и щёлкните мышкой. В открывшемся поле ввода введите длину ин-
дуктивного проводника LI1=1 и щёлкните мышкой на свободном месте в окне схемы. 
Аналогично введите переменные LI2=1, R1=1 и R2=1 (радиусы секторов). 

2. Дважды щёлкните по первому элементу MLIN и в открывшемся окне свойств элемен-
та введите W=0.5 mm и L=3 mm. Нажмите OK. Такие же параметры введите для по-
следнего элемента MLIN. 

3. Дважды щёлкните по второму элементу MLIN и введите W=0.1 mm и L=LI1 mm. 
Нажмите OK. Такие же параметры введите для предпоследнего элемента MLIN. 

4. Дважды щёлкните по третьему элементу MLIN и введите W=0.1 mm и L=LI2 mm. 
Нажмите OK. Такие же параметры введите для четвёртого элемента MLIN. 

5. Дважды щёлкните по первому элементу MSRSTUB2 и введите Ro=R1 mm, Wg=0.5 
mm, W=0.1 mm и Theta=60 
Deg. Нажмите OK. Такие же 
параметры введите для 
третьего элемента 
MSRSTUB2. 
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6. Дважды щёлкните по вто-
рому элементу MSRSTUB2 
и введите Ro=R2 mm, 
Wg=0.5 mm, W=0.1 mm и 
Theta=60 Deg. Нажмите 
OK. 

7. Дважды щёлкните по эле-
менту MSUB и введите 
Er=10, H=0.5 mm, T=0.02 
mm, Tand=0.002 и 
ErNom=10. 

Отредактированная схема показана на рис. 2.17. 

Рис. 2.17 



2.2.3. Анализ схемы. 
1. Откройте вкладку Proj в левом окне проекта. Дважды щёлкните по Project Options и 
на вкладке Frequencies в поле Start(GHz) введите 1, в поле Stop(GHz) введите 15 и в 
поле Step(GHz) введите 0.5, нажмите Apply и OK. 

2. Щёлкните по значку New Graph, введите имя графика LdB и нажмите OK. 
3. Щёлкните правой кнопкой мышки по имени графика LdB в левом окне проекта и вы-

берите Add Measurement. Введите 2 в 
поле To Port Index и 1 в поле From 
Port Index, отметьте dB, нажмите Ap-
ply и OK. 
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4. Щёлкните по значку Analyze на пане-
ли инструментов. 

5. После окончания анализа измените 
свойства графика так, чтобы они оста-
вались постоянными при настройке, а 
не менялись автоматически при изме-
нении характеристики. Для этого 
щёлкните по графику правой кнопкой 
мышки и выберите Properties. На 

вкладке Axes отметьте ось x, снимите “галочку” в Auto divs. и в поле Step введите 1. 
Нажмите Apply. Отметьте ось Left 1. Снимите “галочку” в Auto limits и в поле Min 
введите -60. Снимите “галочку” в Auto divs. и в поле Step введите 0.5. Нажмите Apply 
и OK. 
Полученный график показан на рис. 2.18. 

Рис. 2.18

2.2.4. Настройка схемы. 
1. Сделайте активным окно схемы. Щёлкните по значку Tune Tool на панели инстру-
ментов, установите курсор на переменную LI1 и щёлкните левой кнопкой мышки, что-
бы назначить переменную для настройки. Затем, перемещая курсор на остальные пере-
менные и щёлкая мышкой, назначьте для настройки все переменные, после чего щёлк-

ните на свободном месте схе-
мы, чтобы отменить режим на-
значения переменных. 

2. Сделайте активным окно гра-
фика и щёлкните по значку 
Tune на панели инструментов. 
Двигая движки блока настрой-
ки, добейтесь требуемой харак-
теристики (рис. 2.19). 

3. Закройте блок настройки и 
сделайте активным окно схемы. 
В этом примере переменные 
получили следующие значения: 
LI1=2.3, LI2=3.15, R1=2.5 и 
R2=3.05 (после округления до 
пяти сотых). 

Рис. 2.19 

2.2.5. Создание и анализ электромагнитной структуры. 
1. Выберите в меню команду Options>Layout Options. На вкладке Layout открывшегося 
окна (рис. 2.20) в поле Grid spacing введите 0.05, а в поле Database unit size введите 
0.001. Нажмите OK. 

2. Сделайте активным окно схемы. Щёлкните по значку New Schematic Layout View на 
панели инструментов. Выберите в меню команду Edit>Select All и затем Edit>Snap 



Together, чтобы правильно 
отобразить все соединения 
элементов топологии. Щёлк-
ните по значку Measure (Из-
мерять) на панели инструмен-
тов. Установите курсор на 
нижний левый угол входного 
проводника, нажмите левую 
кнопку мышки и, не отпуская 
кнопки, переместите курсор к 
нижнему правому углу выход-
ного проводника, чтобы изме-
рить длину топологии, которая 
определяет длину корпуса 
электромагнитной структуры. 

Аналогично измерьте ши-
рину топологии. Получен-
ная топология показана на 
рис. 2.21. 

Рис. 2.20 

3. Выделите все элементы 
топологии и щёлкните по 
значку Copy на панели ин-
струментов. Щёлкните по 
значку New EM Structure 

на панели инструментов и соз-
дайте электромагнитную 
структуру с именем FN5. 

Рис. 2.21 
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мышкой по входному 

4. Щёлкните по значку Sub-
strate Information. На вкладке 
Enclosure открывшегося окна 
в поле X-Dimension(mm) вве-
дите 18.4, в поле X-Divisions 
введите 180, в поле Y-
Dimension(mm) введите 9 и в 
поле Y-Divisions введите 90. 
Размер клеток сетки по осям X 
и Y будет 0.1 мм. На вкладке 
Dielectric Layers для слоя 1 

введите толщину 6, для слоя 2 введите 
толщину 0.5, диэлектрическую про-
ницаемость 10, тангенс потерь 0.002 и 
масштаб отображения 4 (рис.2.22). 
Нажмите OK. Щёлкните по значку 
Paste на панели инструментов и по-
местите скопированную топологию по 
центру электромагнитной структуры. 

5. Щёлкните 

Рис. 2.22 

проводнику схемы, затем щёлкните по 
значку Edge Port на панели инстру-
ментов. Установите порт на входе 
фильтра и сдвиньте референсную 

плоскость вправо на 1 мм. Аналогично установите порт на выходе фильтра. Получен-
ная электромагнитная структура показана на рис. 2.23. 

Рис. 2.23 



6. Сделайте активным окно графика и выполните анализ, щёлкнув по значку Analyze на 
панели инструментов. Полученный 
график показан на рис. 2.24. Из ха-
рактеристики видно, что её нужно 
сдвинуть вверх по частоте примерно 
на 1 ГГц. Это можно сделать, 
уменьшив радиусы секторов. Одна-
ко в редакторе электромагнитной 
структуры это сделать довольно 
сложно. Поэтому вначале отредак-
тируем элементы схемы. 
Чтобы можно было сравнивать ха-

рактеристики новых вариантов с прежни-
ми, сделаем копии электромагнитной 
структуры и схемы. Рис. 2.24 

1. Установите курсор на имя электромагнитной структуры FN5 в левом окне проекта. 
Нажмите левую кнопку мышки, переместите курсор на группу EM Structures и от-
пустите кнопку. Щёлкните правой кнопкой мышки по имени скопированной струк-
туры в левом окне проекта и выберите Rename EM Structure и переименуйте её в 
FN5A. 

2. Сделайте активным окно схемы. Щёлкните по значку Tune Tool на панели инстру-
ментов и, щёлкая по переменным, отмените их выбор для настройки. Установите 
курсор на имя схемы Fil в левом окне проекта, нажмите левую кнопку мышки, пе-
реместите курсор на группу Circuit Schematics и отпустите кнопку. Щёлкните пра-
вой кнопкой мышки по имени скопированной схемы в левом окне проекта и выбе-
рите Rename Schematic и переименуйте её в FilA. 

3. Щёлкните по значку Tune 
Tool на панели инстру-
ментов и, щёлкая по пере-
менным, назначьте их для 
настройки. 

4. Сделайте активным окно 
графика и щёлкните по 
значку Analyze на панели 
инструментов. Щёлкните 
по значку Tune на панели 
инструментов и, двигая 
движки у переменных R1 
и R2, сдвиньте характери-
стику вверх по частоте 
примерно на 1 ГГц (рис. 
2.25). Радиусы секторов 

получили значения R1=2.3 и R2=2.8. 

Рис. 2.25 

5. Закройте окно блока настройки и сделайте активным окно схемы FilA. Щёлкните по 
значку New Schematic Layout View на панели инструментов. Если в открывшемся 
окне топологии видны красные пунктирные линии, выберите в меню команду 
Edit>Select All и затем Edit>Snap Together. Выделите все элементы топологии и 
щёлкните по значку Copy на панели инструментов. 

6. Сделайте активным окно электромагнитной структуры FN5A. Выделите всю топо-
логию в этом окне и нажмите клавишу Delete. Щёлкните по значку Paste на панели 
инструментов и поместите скопированную топологию по центру электромагнитной 
структуры. Установите порты на входе и выходе фильтра. Обратите внимание, что 
референсные плоскости портов теперь устанавливаются автоматически. 
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7. Сделайте активным окно графика и щёлкните по значку Analyze на панели инстру-
ментов. Полученная характеристи-
ка теперь удовлетворяет постав-
ленным требованиям (рис. 2.26). 
Однако есть некоторые сомнения в 
точности выполненного анализа, 
т.к. стороны секторов наклонены 
по отношению к сетке. Чтобы оце-
нить достоверность полученной ха-
рактеристики, повторим анализ, 
сделав более мелкую сетку. 

8. Удалим ненужные теперь схемы и 
электромагнитную структуру FN5. 
Щёлкните правой кнопкой мышки 
по имени схемы Fil и выберите De-

lete Schematic. Аналогично удалите схему FilA и электромагнитную структуру FN5. 
Рис. 2.26 

9. Чтобы можно было сравнить характеристики электромагнитной структуры при раз-
ных размерах клеток сетки, 
скопируйте электромагнитную 
структуру FN5A и переиме-
нуйте её в FN5. Щёлкните по 
значку Substrate Information. 
На вкладке Enclosure в поле 
X-Divisions введите 368 и в 
поле Y- Divisions введите 180. 
Размер клеток сетки по осям X 
и Y будет 0.05 мм. Нажмите 
OK. 

10. Сделайте активным окно гра-
фика и щёлкните по значку 
Analyze на панели инструмен-
тов. Время анализа по сравне-
нию с предыдущим случаем 

существенно увеличилось. Из полученного графика (рис.2.27) видно, что различие 
между характеристиками при разных размерах клеток сетки незначительное и мож-
но надеяться на достаточную точность выполненного анализа. 

Рис. 2.27 
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3. Полосно-пропускающие фильтры 

3.1. Фильтр на шлейфах с полосой пропускания 8 – 12 ГГц 
Спроектировать фильтр на четвертьволновых замкнутых шлейфах с полосой пропус-

кания от 8 до 12 ГГц, обеспечивающий подавление сигнала на частоте 6 ГГц не менее 35 дБ. 

3.1.1. Создание схемы фильтра. 
Для реализации фильтра выберем структуру с шестью резонаторами на замкнутых 

четвертьволновых шлейфах. Причём каждый резонатор будет состоять из двух шлейфов, 
расположенных по обе стороны от микрополосковой линии, чтобы шлейфы не были узкими. 
Расстояние между резонаторами также должно быть примерно равным четверти длины вол-
ны. Используя команду меню Tools>TXLine (см. пример 1.1), можно определить, что для 
поликора толщиной 0.5 мм на частоте 10 ГГц четверть длины волны равно примерно 2.8 мм. 

1. Выберите в меню File>New Project, создайте новый проект и сохраните его, выбрав 
в меню Save Project As, под именем F8-12. 

2. Щёлкните по значку New Schematic на панели инструментов и создайте схему с 
именем Fil. 

3. Откройте вкладку Elem в левом окне проекта, раскройте группу Microstrip и щёлк-
ните по подгруппе Lines. 

4. В нижней части левого окна проекта найдите элемент MLIN и перетащите его в ок-
но схемы. 

5. Щёлкните по подгруппе Junctions, перетащите в окно схемы элемент MCROSS$ и 
соедините его с правым выводом элемента MLIN. 
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6. Щёлкните по элементу MLIN, чтобы выделить его. 
Щёлкните по значку Copy и затем по значку Paste 
на панели инструментов, щёлкните правой кноп-
кой мышки, чтобы развернуть скопированный эле-
мент, и соедините его с плечом 2 элемента 
MCROSS$. 

7. Щёлкните по значку Paste, три раза щёлкните пра-
вой кнопкой мышки, чтобы развернуть скопиро-
ванный элемент, и соедините его с плечом 4 эле-
мента MCROSS$. 

8. Щёлкните по значку Ground на панели инстру-
ментов и соедините землю с нижним выводом 
нижнего элемента MLIN. 

9. Снова щёлкните по значку Ground на панели ин-
струментов, два раза щёлкните правой кнопкой 
мышки и соедините землю с верхним выводом 
верхнего элемента MLIN.Полученная схема перво-

го резонатора показана на рис. 3.1. 

Рис. 3.1 

10. Выделите все элементы созданной схемы и щёлкните по значку Copy на панели ин-
струментов. 

11. Щёлкните по значку Paste на панели инструментов и соедините скопированные 
элементы с плечом 3 последнего элемента MCROSS$. 

12. Повторите п. 11 четыре раза. 
13. Выделите любой горизонтальный элемент MLIN, щёлкнув по нему мышкой, скопи-

руйте его и соедините с плечом 3 последнего элемента MCROSS$. 
14. Щёлкните по значку Port на панели инструментов и соедините порт со входом 

фильтра. Аналогично подключите порт к выходу фильтра, щёлкнув два раза мыш-
кой, чтобы развернуть его. 



15. Щёлкните по подгруппе Substrates в левом окне проекта и перетащите в окно схе-
мы элемент MSUB. Полученная схема показана на рис. 3.2. 

Рис. 3.2 

3.1.2. Добавление переменных и редактирование элементов схемы. 
1. Щёлкая по значку Equation на панели инструментов, добавьте переменные 

LL1=2.8, LL2=2.8, LL3=2.8, LS1=2.8, LS2=2.8, LS3=2.8, WS1=0.5, WS2=0.5 и 
WS3=0.5. 

2. Дважды щёлкните по входному элементу MLIN и введите W=0.5 и L=3, нажмите 
OK. Аналогично отредактируйте выходной элемент MLIN. 

3. Аналогично для элементов MLIN между первым и вторым, а также между послед-
ним и предпоследним резонаторами введите W=0.5 и L=LL1. Для элементов MLIN 
между вторым и третьим резонаторами, а также между четвёртым и пятым резона-
торами введите W=0.5 и L=LL2. Для элемента MLIN между третьим и четвёртым 
резонаторами введите W=0.5 и L=LL3. 

4. Для обоих шлейфов первого и последнего резонаторов введите W=WS1 и L=LS1, 
для второго и четвёртого резонаторов – W=WS2 и L=LS2, для третьего и четвёртого 
резонаторов – W=WS3 и L=LS3. 

5. Дважды щёлкните по элементу MSUB и введите Er=10.54, H=0.5, T=0.005, 
Tand=0.0001 и ErNom=10.54. нажмите OK. 

Первая половина схемы показана на рис. 3.3, остальная часть схемы симметрична 
этой половине. 

Рис. 3.3 
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3.1.3. Определение частот проекта, анализ и настройка схемы. 
1. Откройте вкладку Proj в левом окне проекта и дважды щёлкните по Project 

Options. В открывшемся окне опций проекта на вкладке Frequencies отметьте Re-
place, в поле Start(GHz) введите 4, в поле Stop(GHz) введите 16 и в поле 
Step(GHz), введите 0.5. Нажмите Apply и OK. 

2. Щёлкните по значку New Graph и создайте график с именем LdB. Щёлкните пра-
вой кнопкой по имени созданного графика в левом окне проекта и выберите Add 
Measurement. Отметьте Port Parameters и S. В поле To Port Index введите 2, 
щёлкнув по кнопке в правом конце этого поля, аналогично в поле From Port Index 

введите 1, отметьте dB и нажмите 
OK. 

3. На панели инструментов щёлкните 
по значку Analyze. Щёлкните пра-
вой кнопкой мышки по графику и 
выберите Properties. В открывшем-
ся окне свойств графика на вкладке 
Axes отметьте x, снимите “галочку” 
в Auto divs и в поле Step введите 
0.5. Отметьте Left 1, снимите “га-
лочку” в Auto limits, в поле Min 
введите -60, в поле Max введите 0. 
Снимите “галочку” в Auto divs и в 
поле Step введите 5. На вкладке 
Fonts нажмите кнопку Axis num-
bers и в области Размер выберете 
14. Нажмите OK, затем Apply и 
OK. Чтобы точнее отобразить ха-
рактеристику в переходной области, 
добавьте частоты 7.25, 8.75 и 12.25. 
Полученная характеристика шире 
требуемой (рис. 3.4). 

Рис. 3.4 

4. Назначьте переменные для оптими-
зации. Для этого откройте окно 
схемы. Щёлкните по переменной 
LL1 левой кнопкой мышки и затем 

правой кнопкой и выберите Properties.. В открывшемся окне (рис. 3.5) отметьте Op-
timize и Constrain. В поле Upper bound введите 4, в поле Lower bound введите 1.5. 
Нажмите OK. 

Рис. 3.5 

5. Аналогично введите такие же параметры для переменных LL2, LL3, LS1, LS2 и 
LS3. Для переменных WS1, WS2 и WS3 в поле Upper bound ведите 1, в поле Lower 
bound – 0.3. 

6. Сделайте активным окно графика. 
7. Установите цели оптимизации. Сначала установим цель в нижней полосе загражде-

ния. Щёлкните правой кнопкой по Optimizer Goals и выберите Add Opt Goal. В от-
крывшемся окне отметьте Meas< Goal. Снимите “галочку” в Stop и в поле Max вве-
дите 6 GHz, в поле Goal введите -35, нажмите OK. Теперь установим цель в полосе 
пропускания. Снова щёлкните правой кнопкой по Optimizer Goals и выберите Add 
Opt Goal. Отметьте Meas> Goal. Снимите “галочки” в Start и Stop. В поле Min вве-
дите 8, в поле Max введите 12, в поле Goal введите -0.5. Нажмите OK. К крутизне 
верхнего ската характеристики требования не предъявляются. Цели оптимизации 
отобразятся на графике. 

8. Выберите в меню Simulate>Optimize. В открывшемся окне выберите метод опти-
мизации Random(Local), в поле Maximum Iterations введите 500 и нажмите Start.  
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Характеристика после оптимиза-
ции показана на рис. 3.6. Сделайте актив-
ным окно схемы. Переменные после оп-
тимизации получили значения, показан-
ные на рис. 3.7. 

 

Рис. 3.7 
 

Рис. 3.6  

3.1.4. Создание и анализ электромагнитной структуры. 
Выберем размер клеток сетки в электромагнитной структуре по оси X равным 0.1, а 

по оси Y – 0.05 мм. Соответственно округлим значения переменных: LL1=2, LL2=2.5, 
LL3=2.5, WS1=WS2=WS3=0.5. Что касается длины шлейфов, то она зависит от способа 
обеспечения заземления. Мы сделаем заземление с помощью узкой металлической полоски 
по краям платы и металлизацией боковых торцов платы. Очевидно, что в такой конструкции 
длина шлейфов от входной микрополоски до заземляющей будет несколько меньше рассчи-
танных. Примем в первом приближении длину всех шлейфов одинаковой и равной 2.5 мм. 
Исходя из этих размеров с учётом входных проводников, выберем размеры корпуса 20х5,9 
мм с запасом для возможных изменений размеров топологии. 

1. Щёлкните по значку New EM Structure на панели инструментов и создайте элек-
тромагнитную структуру с именем F8_12. 

2. Щёлкните по значку Substrate Information на панели инструментов. В открывшем-
ся окне на вкладке Enclosure в поле X-Dimension(mm) введите 20, в поле X-

Divisions введите 200, в поле Y-
Dimension(mm) введите 5.9, в 
поле Y- Divisions введите 118. На 
вкладке Dielectric Layers для 
слоя 1 введите толщину 6, для 
слоя 2 введите толщину 0.5, ди-
электрическую проницаемость 
10.54, тангенс потерь 0.0001 и 
масштаб просмотра 4 (рис. 3.8). 
Нажмите OK. 

3. Щёлкните по значку Rectangle 
Conductor, установите курсор на 
левый край электромагнитной 

структуры и нажмите клавишу Tab. В открывшемся 
окне рис. 3.9 в поле x введите 0, в поле y введите 2.7. 
Нажмите OK. Снова нажмите клавишу Tab и в от-
крывшемся окне рис. 3.10 в поле dx введите 20, в поле 
dy введите 0.5. Нажмите OK. 

Рис. 3.8 

Рис. 3.9 4. Снова щёлкните по значку Rectangle Conductor на 
панели инструментов, поместите курсор на электро-
магнитную структуру и нажмите клавишу Tab. В поле 
x введите 3, , в поле y введите 2.7. Нажмите OK. В по-
ле dx введите 0.6, в поле dy введите -2.5. Нажмите 
OK. Рис. 3.10 
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5. Скопируйте полученный шлейф и подключите его к 
линии с противоположной стороны уже имеющегося 
шлейфа. Топология должна иметь вид, показанный 
на рис. 3.11. 
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6. Щёлкните мышкой по одному из шлейфов, нажмите 
клавишу Shift и щёлкните по второму шлейфу. Оба 
шлейфа должны быть выделены. Щёлкните по знач-
ку Copy на панели инструментов. 

7. Щёлкая по значку Paste на панели инструментов, 
установите недостающие пять шлейфов, на расстоя-

ниях между шлейфами LL1=2, LL2=2.5, LL3=2.5, определённых ранее. 

Рис. 3.11 

8. Создадим заземление для верхних шлейфов. Щёлкните по значку Polygon Conduc-
tor на панели инструментов, поместите курсор на верхний левый угол первого 
шлейфа и щёлкните мышкой. Переместите курсор вправо на верхний правый угол 
последнего шлейфа и щёлкните мышкой. Переместите курсор вверх до верхнего 

края корпуса и щёлкните мыш-
кой. Переместите курсор влево до 
левого края первого шлейфа и 
дважды щёлкните мышкой. 

9. Скопируйте созданный зазем-
ляющий проводник и заземлите 
нижние шлейфы. Полученная то-
пология должна иметь вид, пока-
занный на рис. 3.12. 

Рис. 3.12 

10. Выделите входной проводник фильтра, затем щёлкните по значку Edge Port на па-
нели инструментов, установите порт на входе фильтра и сдвиньте референсную 
плоскость порта на 1 мм вправо. Аналогично установите порт на выходе фильтра и 

сдвиньте его референсную 
плоскость порта на 1 мм влево. 

11. Выделите все элементы топо-
логии, выбрав в меню 
Edit>Select All. Щёлкните пра-
вой кнопкой мышки по како-
му-нибудь проводнику тополо-
гии и выберите Mesh/Material 
Properties. В открывшемся ок-
не выберите материал 1/2oz Cu 
и нажмите OK. 

12. Выполните анализ, щёлкнув по 
значку Analyze на панели ин-
струментов. Рассчитанный гра-
фик показан на рис. 3.13. 

Рис. 3.13  

3.1.5. Редактирование топологии. 
Из графика видно, что полосу пропускания нужно уменьшить и убрать выброс в низ-

кочастотной части полосы пропускания. Попробуем увеличить ширину двух средних шлей-
фов. 

1. Установите курсор на имя электромагнитной структуры F8_12 в левом окне проекта, 
нажмите левую кнопку мышки и переместите курсор на группу EM Structures, отпус-
тите кнопку. Переименуйте скопированную структуру в F8_12A. 

2. Щёлкните по значку View Area на панели инструментов и увеличьте структуру так, 
чтобы отобразить первые три резонатора. Дважды щёлкните по третьему верхнему 
шлейфу, установите курсор на синий ромбик посередине левой стороны шлейфа, на-



жмите левую кнопку мышки и переместите эту сторону на dx:-0.2 влево (рис. 3.14). 
Сделайте то же самое с третьим 
нижним шлейфом. 

3. Чтобы сохранить прежнее рас-
стояние между вторым и треть-
им шлейфами, нужно на такую 
же величину сдвинуть эти 
шлейфы влево. Установите кур-
сор левее и выше первого верх-
него шлейфа, нажмите левую 
кнопку мышки и, не отпуская 
кнопки, переместите курсор пра-
вее и ниже второго нижнего 
шлейфа, чтобы выделить все эти 
шлейфы. Установите курсор на 
любой шлейф, нажмите левую 
кнопку мышки и сдвиньте шлей-

фы влево на. dx:-0.2. 

Рис. 3.14 

4. Дважды щёлкните по верхнему заземляющему проводнику и сдвиньте его левую сто-
рону на dx:-0.2. То же самое сде-
лайте с нижним заземляющим 
проводником. 
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5. Аналогично увеличьте ширину 
шлейфов четвёртого резонатора, 
сдвинув их правую сторону впра-
во на 0.2, сдвиньте вправо шлей-
фы последних двух резонаторов 
на ту же величину и соответст-
венно удлините оба заземляющих 
проводника. 

6. Выполните анализ, щёлкнув по 
значку Analyze на панели инст-
рументов. Рассчитанный график 
показан на рис. 3.15. Ширина по-

лосы пропускания уменьшилась, но всё ещё остаётся шире требуемой и в низкочастот-
ной части полосы пропускания остаётся выброс. 

Рис. 3.15 

7. Удалите предыдущую структуру F8_12, щёлкнув правой кнопкой мышки по её имени 
в левом окне проекта и выбрав Delete EM Structure. 

8. Скопируйте структуру F8_12A, как описано в п.1 и переименуйте её в F8_12. 
9. Дважды щёлкните мышкой по первому верхнему шлейфу. Установите курсор на ром-
бик посередине верхней стороны шлейфа и сдвиньте эту сторону вниз на 0.25. Дважды 
щёлкните мышкой по первому нижнему шлейфу. Затем установите курсор на ромбик 
посередине нижней стороны шлейфа и сдвиньте эту сторону вверх на 0.25. Аналогично 
укоротите на 0.25 все шлейфы. Дважды щёлкните мышкой по верхнему заземляющему 
проводнику, установите курсор на ромбик посередине нижней стороны и сдвиньте эту 
сторону вниз на 0.25. Аналогично сдвиньте вверх на 0.25 верхнюю сторону нижнего за-
земляющего проводника. Выполните анализ, щёлкнув по значку Analyze на панели ин-
струментов. Рассчитанный график показан на рис. 3.16. Характеристика несколько 
сдвинулась вверх по частоте, и выброс в низкочастотной части полосы пропускания 
уменьшился. 



10. Удалите предыдущую структуру F8_12A. Скопируйте оставшуюся структуру F8_12 и 
переименуйте её в F8_12A. Чтобы ещё сузить полосу пропускания расширьте третьи и 
четвёртые шлейфы на 0.1, как описано в пп.1-5 и выполните анализ. Рассчитанный гра-
фик показан на рис. 3.17. Удалите предыдущую структуру F8_12. 

11. В нашем случае характеристика довольно близка к требуемой и наблюдать за измене-
нием характеристики в полосе пропускания на созданном графике довольно тяжело. В 
этом случае лучше прейти к графику стоячей волны, на котором изменения характери-
стики отображаются заметнее. Создадим такой график. 

Рис. 3.17 Рис. 3.16 

12. Щёлкните мышкой по значку New Graph и создайте график с именем KstU. Щёлкни-
те правой кнопкой мышки по имени 
этого графика в левом окне проекта 
и выберите Add Measurement. В 
области Meas. Type отметьте Lin-
ear, в области Measurement от-
метьте VSWR, в поле Port Index 
введите 1, снимите “галочку” в dB, 
если она стоит и нажмите Apply и 
затем OK. Щёлкните по значку 
Analyze на панели инструментов. 
Щёлкните по полученному графику 
правой кнопкой мышки и выберите 
Properties. На вкладке Axes от-
крывшегося окна для оси x снимите 
“галочку” в Auto limits, в поле Min 
введите 7, в поле Max введите 14. 
Снимите “галочку” в Auto divs и в 

поле Step введите 0.5. Для оси Left 1 снимите “галочку” в Auto limits, в поле Min вве-
дите 0, в поле Max введите 5. Снимите “галочку” в Auto divs и в поле Step введите 0.5. 
Нажмите Apply и затем OK. График показан на рис. 3.18. Видно, что нужно улучшить 
согласование в полосе пропускания. Попробуем сделать это, увеличив расстояния меж-
ду шлейфами и уменьшив ширину первого шлейфа. 

Рис. 3.18 

13. Скопируйте электромагнитную структуру и переименуйте её в F8_12. Дважды щёлк-
ните по первому верхнему шлейфу и сдвиньте его левую сторону вправо на 0.2. То же 
самое сделайте с первым нижним шлейфом. Аналогично уменьшите ширину последних 
шлейфов, сдвинув их правую сторону влево на 0.2. Выделите шлейфы трёх первых ре-
зонаторов и сдвиньте их на 0.1 влево. Выделите шлейфы двух первых резонаторов и 
сдвиньте их на 0.2 влево. Выделите шлейфы первого резонатора и сдвиньте их на 1.1 
влево. Выделите шлейфы двух последних резонаторов и сдвиньте их на 0.2 вправо. Вы-
делите шлейфы последнего резонатора и сдвиньте их на 1.1 вправо. При этом располо-
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жение последних шлейфов выходит за референсную плоскость порта на выходе фильт-
ра. Поэтому удлиним длину корпуса. 

14. Щёлкните по значку Substrate Information на панели инструментов и на вкладке En-
closure введите длину корпуса 23 и количество клеток по оси X – 230. Выделите все 
элементы топологии и сдвиньте топологию вправо на 1.2, чтобы она расположилась 
симметрично относительно корпуса (при этом порты отображаются красным цветом, 
указывающем на ошибку). Дважды щёлкните по входному проводнику фильтра, уста-
новите курсор на ромбик посередине левой стороны и сдвиньте эту сторону так, чтобы 
она совпала с левым краем корпуса (при этом порт не будет отображаться красным 

цветом). Аналогично совместите правую 
сторону входного проводника с правой сто-
роной корпуса. Дважды щёлкните по верх-
нему заземляющему проводнику и продлите 
его правую и левую стороны до крайних 
шлейфов. Тоже самое сделайте с нижним за-
земляющим проводником. Топология долж-
на иметь вид, показанный на рис. 3.19. Рас-
стояния между резонаторами (от края 

фильтра к центру) равны 3.1, 2.7 и 2.6, а ширины шлейфов 0.4, 0.6 и 0.9. 

Рис. 3.19 

15. Сделайте активным окно графика KstU и щёлкните по значку Analyze на панели ин-
струментов. Полученный график показан на рис. 3.20. Сделайте активным окно графи-
ка LdB, этот график показан на рис. 3.21. 

16. Полученная характеристика уже удовлетворяет поставленным требованиям, но её 
можно ещё улучшить. 

17. Удалите теперь не нужную схему из проекта. Для этого щёлкните правой кнопкой 

мышки по имени схемы Fil в левом окне проекта и выберите Delete Schematic. Также 
удалите электромагнитную структуру F8_12A и цели оптимизации. Установите курсор 
на имя оставшейся структуры F8_12 в левом окне проекта, нажмите левую кнопку 
мышки и переместите курсор на группу EM Structures. Переименуйте скопированную 
структуру в F8_12A. 

Рис. 3.21 Рис. 3.20 

18. Щёлкните по значку View Area на панели инструментов и выделите левую часть 
фильтра (два резонатора), чтобы увеличить эту часть. Щёлкните по верхнему зазем-

ляющему проводнику и затем щёлкните по значку Notch 
Conductor (Выемка проводника). Установите курсор на 
нижний левый угол заземляющего проводника, нажмите 
левую кнопку мышки и, не отпуская кнопки, перемести-
те курсор на 0.1 вверх и на 1.9 вправо (рис. 3.22), отпус-
тите кнопку мышки. Аналогично сделайте такие же вы-
емки на левом и правом краях обоих заземляющих про-

водников. Дважды щёлкните по первому верхнему шлейфу и сдвиньте его верхнюю 

Рис. 3.22 
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сторону до соединения с верхним 
заземляющим проводником. Ана-
логично соедините все крайние 
шлейфы с заземляющими провод-
никами. Должна получиться струк-
тура, показанная на рис. 3.23. 
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лосой пропускания 4 – 4.4 ГГц 

3.2.1. 
 первое приближение для структуры фильтра воспользуемся мастером 

а в поле Grid spacing введите 0.05, а в поле Database введите 0.001, нажми-

19. Сделайте активным окно графика 

KstU и щёлкните по значку Analyze на 
панели инструментов. Полученный
график показан на рис. 3.24. 
Синтезированная топология показана 

на рис. 3.25, а расчётная и эксперименталь-
ная характеристики вносимого ослабления 
ильтра показаны на рис. 3.26. 

Рис. 3.23 

ф

Рис. 3.24 

Рис. 3.26 Рис. 3.25 

3.2. Фильтр с боковыми электромагнитными связями с по-

Синтез фильтра. 
Чтобы получить

синтеза фильтров. 
1. Создайте новый проект и сохраните его под именем Fil4. 
2. Выберите в меню команду Options>Layout Options. На вкладке Layout открывше-

гося окн
те OK. 

3. На вкладке Proj раскройте группу Wizards и дважды щёлкните по Filter Synthesis 
Wizard. В открывшемся окне нажмите кнопку Далее. В следующем окне отметьте 
Bandpass и нажмите кнопку Далее. Отметьте аппроксимацию Chebyshev и нажмите 
кнопку Далее. В следующем окне Bandpass Parameter Specifications (рис. 3.27) 
введите порядок фильтра N=5, нижнюю частоту полосы пропускания FL=4, верх-
нюю частоту полосы пропускания FH=4.4, пульсации в полосе пропускания 
PV=0.5, сопротивление источника RS=50 и сопротивление нагрузки RL=50, нажми-
те Далее. Отметьте тип структуры фильтра Parallel Coupled Half-Wave Resonators 
(Параллельно связанные полуволновые резонаторы) и нажмите Далее. В следую-
щем окне Bandpass Filter Constraints (Рис. 3.28) отметьте Odd Mode Center Reso-
nator (Нечётная мода центрального резонатора), введите импеданс нечётной моды 
50, минимальный зазор между резонаторами 0.01 и минимальную ширину резонато-
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окно графика без характеристики, т.е. анализ не выполнялся, хотя схема мастером 

ров 0.2, нажмите Далее. Выберите планарную физическую структуру Microstrip и 

нажмите Далее. В следующем окне Microstrip Substrate Parameter Specifications 
(рис. 3.29) в поля Predefined Microstrip Substrate Selection (Выбор предопределён-
ной подложки микрополоски) и в Microstrip Substrate Name (Имя подложки мик-
рополоски) введите User Defined (Определяется пользователем). Введите 

диэлектрическую проницаемость Er=10.3, 
тангенс потерь Tand=0.001, толщину 
подложки H=0.5, толщину проводника 0.005. 
В поле Metal Selection введите Copper 
(Медь, щёлкнув по кнопке в правом конце 
этого поля). Нажмите Далее. В следующем 
окне Schematic Specification (рис. 3.30) в по-
ле Schematic Name введите Filter, в поле De-

sign Name (Имя проекта) оставьте имя Design по умолчанию (это имя будет ото-
бражаться в группе Filter Synthesis Wizard), в поле Graph Name введите LdB. От-
метьте Include Optimization Goals (Включить цели оптимизации), Round Size To 
Grid (Округлить до размера сетки), Create Graph (Создать график). В области 
Graph Type отметьте Rectangular и в области Measurements отметьте Forward 
Transfer (S21). Нажмите Далее. В следующем окне нажмите Готово. В нашем слу-
чае выводится окно с сообщением об ошибке (рис. 3.31). Видимо, это связано с тем, 
что при заданных требованиях нарушаются пределы применимости имеющихся мо-
делей линий или неоднородностей. В таком случае остаётся нажать OK и начать 
процесс синтеза фильтра сначала, изменив некоторые требования. Повторите син-
тез, изменив только требования к топологии проводников в окне Bandpass Filter 
Constrains, оставив их по умолчанию (рис. 3.32). На рабочем поле может открыться 

Рис. 3.27 Рис. 3.28 

Рис. 3.30 Рис. 3.29

Рис. 3.31 



синтеза создана. При попытке выпол-
нить анализ, он не выполняется и вы-
водится сообщение о том, что не за-
полнена база данных X-модели (рис. 
3.33). 

 65

 
Рис. 3.33 

 
 Рис. 3.32  

3.2.2. Настройка схемы. 
1. Сделайте активным окно схемы, дважды щёлкнув по имени схемы в левом окне 

проекта. Фрагмент схемы показан на рис. 3.34. Из схемы и сообщения об ошибке 
(рис. 3.33) видна причина неудачи проведения 
анализа. Мастер синтеза использует в схеме X-
модели скачка ширины полоски, очевидно для 
повышения точности анализа. Однако эта модель 
не заполнена. Поскольку схему мы используем в 
качестве первого приближения для создания в 
дальнейшем электромагнитной структуры, мы не 
будем заполнять X-модель, а заменим этот эле-
мент другим. 

Рис. 3.34 

2. Щёлкните мышкой по первому элементу MSTEPX$, нажмите клавишу Shift и 
щёлкните по всем остальным элементам MSTEPX$, чтобы выделить их. Нажмите 
клавишу Delete, чтобы удалить эти элементы. 

3. Откройте вкладку Elem в левом окне проекта. Раскройте группу Microscript и 
щёлкните по подгруппе Junctions. В нижней части левого окна найдите элемент 
MSTEP$, перетащите его в окно схемы и установите на место первого удалённого 
элемента MSTEPX$. Аналогично установите элементы MSTEP$ на место всех ос-
тальных удалённых элементов MSTEPX$. Полученная схема показана на рис. 3.35. 
Обратите внимание, что все размеры кратны размерам клеток сетки, которые мы ус-
тановили в опциях топологии (Layout Options). 

Рис. 3.35

4. Мастер синтеза автоматически определяет частоты только для созданной схемы. 
Чтобы просмотреть их, откройте вкладку Proj в левом окне проекта, щёлкните пра-
вой кнопкой мышки по имени схемы Filter в левом окне проекта и выберите Op-
tions. Обратите внимание, что “галочка” в Use project defaults (Использовать уста-
новки проекта) снята, т.е. установленные частоты будут использоваться только в 



этой схеме. Мы установим частоты, которые будут использоваться для всего проек-
та. Установите “галочку” в Use project defaults и нажмите OK. Дважды щёлкните 
по Project Options в левом окне проекта. В открывшемся окне опций на вкладке 
Frequencies в поле Start(GHz) введите 3.4, в поле Stop(GHz) введите 5.4, в поле 
Step(GHz) введите 0.1. Нажмите Apply. Чтобы точнее отобразить характеристику в 
переходной области, введите дополнительные частоты. Отметьте Add и Single 
point. В поле Point(GHz) введите 3.95 и нажмите Apply. Аналогично введите 4.05, 

4.35 и 4.45, нажимая Apply. После 
окончания ввода нажмите OK. 

5. Откройте окно графика LdB. 
Щёлкните по значку Analyze на 
панели инструментов. Щёлкните 
по полученному графику правой 
кнопкой мышки и выберите Prop-
erties. На вкладке Axes для оси x 
снимите “галочку” в Auto divs и в 
поле Step введите 0.1. Для оси Left 
1 снимите “галочку” в Auto limits, 
в поле Min введите -80, снимите 
“галочку” в Auto divs и в поле Step 
введите 5. Нажмите Apply и OK. 
Полученный график показан на рис. 
3.36. Обратите внимание, что мас-
тер синтеза фильтров подготовил 
всё для проведения настройки и оп-
тимизации. 

Рис. 3.36 

6. В группе целей оптимизации 
(Optimizer Goals) в левом окне 
проекта удалите цель Filter 
DB(|S(1,1)|), щёлкнув по ней правой 
кнопкой мышки, т.к. такой график 
мы не используем. Выполните оп-
тимизацию. Для этого выберите в 
меню Simulate>Optimize. В от-
крывшемся окне выберите метод 
оптимизации Rendom(Lokal) и вве-

дите максимум итераций 500, нажмите Start. График после оптимиза-
ции имеет вид, показанный на рис. 3.37. 

Рис. 3.37 

7. Сделайте активным окно схемы. Обратите внимание, что размеры 
элементов схемы после оптимизации уже не кратны размерам клеток 
сетки топологи (рис. 3.38). Это связано с тем, что при оптимизации на 
характер изменения значений переменных никаких ограничений не 
накладывается. Сохранить привязку к сетке можно, используя дис-
кретную оптимизацию. Для этого необходимо в схему добавить до-

полнительные векторные переменные. 
Рис. 3.38

8. Щёлкните по значку Equation на панели инструментов, переместите курсор на сво-
бодное место в окне схемы, щёлкните левой кнопкой мышки и в открывшемся 
окошке ввода введите LL=stepped(6,7,0.05). Эта запись означает, что переменная 
LL может изменять значения от 6 до 7 с шагом 0.05. Аналогично введите перемен-
ные WW= stepped(0.25,0.5,0.05) и SS= stepped(0.15,0.8,0.05). Дважды щёлкните по 
переменной L0 и измените её значение на L0=LL[13]. Эта запись означает, что пе-
ременная L0 получает значение тринадцатой переменной из вектора LL. Щёлкните 
левой кнопкой мышки на свободном месте окна схемы, чтобы отменить режим ре-
дактирования переменной. Справа от переменной появится её числовое значение, 
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соответствующее тринадцатому элементу 
вектора LL. Введённые переменные показа-
ны на рис. 3.39. 

9. На входе и выходе схемы добавим регуляр-
ные отрезки линии, чтобы затем получить ре-
альную топологию схемы. Нажмите клавишу 
Ctrl, установите курсор на входной порт и, 
перемещая мышку, сместите порт куда-
нибудь на свободное место в окне схемы. От-
кройте вкладку Elem в левом окне проекта. 
Из подгруппы Junction в группе Microstrip 

перетащите элемент MSTEP$ в окно схемы и подключите его к входному резонато-
ру фильтра. Из подгруппы Lines перетащите элемент MLIN в окно схемы и под-
ключите его к входу фильтра. Щёлкните по этому элементу правой кнопкой мышки 
и введите параметры W=0.5 и L=3. Установите курсор на перемещённый элемент 
порта, нажмите левую кнопку мышки и подключите порт ко входу схемы. Анало-
гично добавьте такой же отрезок линии к выходу схемы. Полученная схема показа-
на на рис. 3.40. 

Рис. 3.39

Рис. 3.40

10. Откройте вкладку Proj в левом ок-
не проекта и сделайте активным 
окно графика. Выберите в меню 
команду Simulate>Optimize, выбе-
рите метод оптимизации Ran-
dom(Local), установите максимум 
итераций 500 и нажмите Start. 
Имейте ввиду, дискретную оптими-
зацию поддерживают только указа-
тели оптимизации (Pointer) и слу-
чайные методы (Random). Полу-
ченная характеристика показана на 
рис. 3.41. Рис. 3.41

3.2.3. Статистический анализ. 
Сделайте активным окно схемы. Обратите внима-

ние, что теперь значения переменных кратны размерам 
клеток сетки топологии (рис. 3.42). 
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Прежде чем создавать электромагнитную структуру, 
оценим возможный разброс характеристики в зависимости 
от технологических допусков. 
 
 

Рис. 3.42 



1. Щёлкните правой кнопкой мыш-
ки по переменной L0=LL[13] и 
выберите Properties. В открыв-
шемся окне установите “галочку” 
в Use statistic и снимите все ос-
тальные “галочки”, в поле S.D. 
введите допуск 0.02, нажмите OK 
(рис.3.43). Аналогично назначьте 
для статистического анализа все 
переменные L1, L2, S0, S1, S2, 
W0 и W1. Дважды щёлкните по 

элементу подложки MSUB. В от-
крывшемся окне на вкладке Pa-
rameters в столбце Value напро-
тив параметра H введите толщину 
подложки 0.48. Откройте вкладку 
Statistics. На этой вкладке от-
метьте столбец Use напротив па-
раметров Er и H. Напротив пере-
менной Er отметьте столбец ln%, 
чтобы задать допуск в процентах, 
и в столбце Tol (Tolerance – до-
пуск) введите 2. Напротив пере-
менной H в столбце Tol введите 

0.02 (рис. 3.44). Нажмите OK. 

Рис. 3.43 

Рис. 3.44

2. Сделайте активным окно графика и ус-
тановите цели статистического анали-
за. Для этого щёлкните правой кноп-
кой мышки по группе Yield Goals в 
левом окне проекта. Откроется диало-
говое окно New Yield Goal (рис.3.45). 
Отметьте Meas<Goal. Снимите “га-
лочку” в поле Start Max, и введите 
нижнюю частоту заграждения 3.8 ГГц. 
В поле Goal start введите -30. Нажми-
те OK. Снова щёлкните правой кноп-
кой мышки по группе Yield Goals. От-

метьте Meas<Goal. Снимите “галочку в поле Start Min и введите верхнюю частоту 
заграждения 4.7 ГГц. В поле Goal start введите -30. Нажмите OK. Снова щёлкните 
правой кнопкой мышки по группе Yield Goals. Отметьте Meas>Goal. Снимите “га-

лочки” в полях Start Min и Start Max, и введите 
соответственно нижнюю частоту заграждения 4 
ГГц и верхнюю 4.4 ГГц. В поле Goal start введите 
-1. Нажмите OK. 

Рис. 3.45 

3. Щёлкните правой кнопкой мышки по графику. В 
открывшемся окне свойств графика на вкладке 
Yield Data отметьте Show traces (Показывать 
трассы) и All traces (Все трассы). Нажмите Apply 
и затем OK. 

Рис. 3.46 
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4. Выполните статистический 
анализ, выбрав в меню ко-
манду Simulate>Yield Analy-
sis. Откроется диалоговое ок-
но Yield Analysis (рис. 3.46). 
В выпадающем списке Analy-
sis Methods выберите Yield 
Analysis, в поле Maximum It-
eration введите 100. Нажмите 
Start. Полученный график 
показан на рис. 3.47. Из этого 
графика видно, что характе-
ристика может смещаться 
вниз по частоте на 100 МГц, 
т.е. фильтр нужно спроекти-

ровать выше по частоте не меньше, чем на такую же величину. Чтобы убрать не-
нужные теперь трассы характеристик, щёлкните по кнопке Clear в окне рис. 3.46 и 
закройте это окно. 

Рис. 3.47 

3.2.4. Создание электромагнитной структуры. 
1. Сделайте активным окно схемы.  
2. Щёлкните по значку New Schematic Layout View. Выберите в меню команду 

Edit>Select All и затем команду Edit>Snap Together. Выберите в меню команду 
Options>Layout Options и в открывшемся окне на вкладке Dimension Lines в поля 
Font height и Arrow size введите 1, нажмите OK. Щёлкните по значку Dimension 
Line, установите курсор на левый край топологии, нажмите левую кнопку мышки, 

переместите курсор на 
правый край топологии, 
отпустите кнопку, по-
местите размерную ли-
нию в положение, удоб-
ное для наблюдения и 

щёлкните левой кнопкой мышки. Аналогично измерьте ширину топологии. Полу-
ченная топология показана на рис. 3.48. Из рисунка видно, что длина электромаг-

нитной структуры должна быть 45,6 
мм. Ширину структуры выберем 8 
мм. 

Рис. 3.48 

3. Щёлкните по значку New EM 
Structure на панели инструментов и 
создайте структуру с именем Fil4. 
Щёлкните по знаку Substrate in-
formation на панели инструментов. 
На вкладке Enclosure открывшегося 
окна в поле X-Dimension(mm) вве-
дите 45.6, в поле X-Divisions введи-
те 456, в поле Y-Dimension(mm) 
введите 8 и в поле Y-Divisions вве-
дите 160. На вкладке Dielectric Lay-
ers для слоя 1 введите толщину 6, 

для слоя 2 введите толщину 0.5, диэлектрическую проницаемость 10.3, тангенс по-
терь 0.0001 и масштаб просмотра 4 (рис. 3.49). Нажмите OK. 

Рис.3.49 
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4. Сделайте активным окно топологии схемы. Это окно не отображается в левом окне 
топологии, поэтому сделать его активным можно, щёлкнув по видимой части этого 
окна мышкой. Если окно не видно, упорядочьте расположение окон, например, вы-



брав в меню Window>Cascade. Выделите все элементы топологии схемы, установив 
курсор мышки левее и выше топологии, нажав левую кнопку мушки и переместив 
курсор правее и ниже топологии. Или выбрав в меню Edit>Select All. Щёлкните по 
значку Copy на панели инструментов. Сделайте активным окно электромагнитной 

структуры, дважды щёлкнув мышкой по 
имени структуры Fil4 в левом окне про-
екта. Щёлкните по значку Paste на па-
нели инструментов и поместите скопи-
рованную топологию симметрично от-
носительно корпуса так, чтобы левый и 
правый края топологии точно совпадали 
с левым и правым краями корпуса. 
Щёлкните мышкой по входному про-
воднику, чтобы выделить его, затем 
щёлкните по значку Edge Port на пане-
ли инструментов и установите порт на 
входе фильтра. Щёлкните по квадратику 
установленного порта, установите кур-
сор на правую сторону этого квадрати-
ка, нажмите левую кнопку мышки и 
сдвиньте референсную плоскость порта 
на 1 мм вправо. Аналогично установите 
порт на выходе фильтра. Выделите все 
элементы топологии, щёлкните правой 
кнопкой мышки по любому элементу и 

выберите Mesh/Material Properties. В открывшемся окне в поле Select Material вве-
дите 1/2oz Cu (рис. 3.50) и нажмите OK. Полученная электромагнитная структура по-
казана на рис.3.51. 

Рис. 3.50 

Рис. 3.51 
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рсор на имя 

е дважды щёлкните по верхнему проводнику первых 

на dx:-0.1 (рис. 3.53). Дважды щёлкните по нижнему проводнику этих связанных  

5. Сделайте активным окно графика. 
Щёлкните правой кнопкой мышки 
по имени кривой графика Fil-
ter:DB(|S(2,1)|) в левом окне про-
екта и выберите Properties. В поле 
Data Source Name открывшегося 
окна введите All Sources и нажми-
те OK. Щёлкните по значку Ana-
lyze на панели инструментов. По-
лученный график показан на рис. 
3.52. Характеристика получилась 
несколько уже требуемой. Чтобы 
её расширить, нужно уменьшить 

зазоры в связанных отрез-
ках линии, а чтобы сдви-
нуть вверх по частоте, нуж-
но укоротить резонаторы. 

6. Установите ку

Рис. 3.52

электромагнитной структу-
ры Fil4 в левом окне проекта, нажмите левую кнопку мышки и переместите кур-
сор на группу EM Structures. Переименуйте скопированную структуру в Fil4A. 

7. На скопированной структур

Рис. 3.53 

связанных отрезков линии, установите курсор на ромбик посередине правой сто-
роны этого отрезка, нажмите левую кнопку мышки и сдвиньте эту сторону влево 
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д

отрезков и сдвиньте его левую сторону вправо на dx:0.1 (рис. 3.54). Аналогично уко-
ротите проводники во всех связанных отрезках линии. Установите курсор левее и 
выше третьего проводника топологии, нажмите левую кнопку мышки и переместите 

курсор правее и ниже последнего 
проводника топологии, чтобы вы-
делить все проводники, кроме двух 
первых (рис. 3.55). Установите кур-
сор на любой выделенный провод-
ник и сдвиньте прово ники вверх 
на dy:-0.05 (рис. 3.56), чтобы 

уменьшить величину второго зазора на 0.05 мм. Аналогично уменьшите на 0.05 мм 
величину всех зазоров, кроме первого и последнего. Выделите все элементы тополо-

гии и сдвиньте всю топологию 
вниз на 0.1, чтобы сохранить её 
размещение симметрично относи-
тельно корпуса. Дважды щёлкните 
по Project Options в левом окне 
проекта и добавьте частоту 4.55 
ГГц, чтобы точнее отобразить 
правую переходную область ха-
рактеристики. Откройте окно гра-
фика. Щёлкните по значку Ana-
lyze на панели инструментов. По-
лученный график показан на рис. 
3.57. 

Рис. 3.54 

Рис. 3.55 

Рис. 3.56 1. Щёлкните по значку New 
Graph и создайте график 
коэффициента стоячей волн 
с именем KstU. Щёлкните 
правой кнопкой по имени 
этого графика в левом окне 
проекта и выберите Add 
Measurement. В открыв-
шемся окне отметьте Lin-
ear и VSWR, введите ин-
декс порта 1, снимите “га-
лочку” в dB и нажмите Ap-
ply и OK. Щёлкните по 
значку Analyze на панели 
инструментов. Щёлкните 
правой кнопкой по графику 
и выберите Properties. На 
вкладке Axes для оси x 
снимите “галочку” в Auto 
limits, в поле Min введите 
3.9, в поле Max введите 
4.7, снимите “галочку” в 
Auto divs и в поле Step 
введите 0.05. Для оси Left 
1 снимите “галочку” в Auto 
limits, в поле Min введите 
0, в поле  Max  введите  10,  

Рис. 3.57 

Рис. 3.58 



снимите “галочку” в Auto divs и в поле Step введите 0.5, нажмите Apply и OK. Гра-
фик показан на рис. 3.58. Из проведённого анализа видно, что характеристика сме-
щена вверх по частоте на 100 Мгц, как и требовалось, и имеет запас по ширине по-
лосы пропускания, однако желательно уменьшить KstU на частоте 4.4 ГГц. 

9. Удалите предыдущую структуру Fil4, щёлкнув по её имени в левом окне проекта и 
выбрав Delete EM Structure. Сделайте копию структуры Fil4A и переименуйте её в 
Fil4. Дважды щёлкните мышкой по верхнему проводнику первых связанных отрез-

ков, установите курсор на 
ромбик посередине верх-
ней стороны, нажмите ле-
вую кнопку мышки и пе-
реместите эту сторону на 
dy:0.1 вниз (рис. 3.59). 

Аналогично сместите нижнюю сторону нижнего проводника последних связанных 
отрезков линий вверх на dy:-0.1. Сделайте активным окно с графиком KstU и щёлк-
ните по значку Analyze на панели инструментов. Полученная характеристика удов-
летворяет предъявляемым требованиям. Удалите из проекта предыдущую структуру 
Fil4A и схему Filter. Смоделированная топология фильтра показана на рис. 3.60, а 
характеристики вносимого ослабления и коэффициента стоячей волны на рис. 3.61 и 
3.62 соответственно. 

Рис. 3.59 

Рис. 3.60 

Рис. 3.61 Рис. 3.62 

3.3. Фильтр с полуволновыми электромагнитными связями 
с полосой пропускания 9,5 – 10,5 ГГц. 

Требуется смоделировать фильтр с полуволновыми электромагнитными связями меж-
ду резонаторами и с кондуктивными связями 
между крайними резонаторами и подводя-
щими линиями (рис. 3.63). Полоса пропуска-
ния 9,5 – 10,5 ГГц и на частотах заграждения 
8,5 и 11,5 ГГц ослабления должно быть не 
менее 40 дБ. 

Рис. 3.63  
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3.3.1. Создание схемы. 
В первом приближении может быть создана следующая схема. 

1. Создайте новый проект и сохраните его под именем F95-105. 
2. Щёлкните по значку New Schematic на панели инструментов и создайте схему с име-
нем Fil. 

3. В левом окне проекта откройте вкладку Elem и выбе-
рите подгруппу Lines в группе Microstrip. 

4. Перетащите в поле схемы элемент MLIN, затем пере-
тащите второй такой же элемент и соедините его с пер-
вым. Рис. 3.64 

5. Раскройте подгруппу Junctions, перетащите в поле 
схемы элемент MTEE, щёлкни-
те три раза правой кнопкой 
мышки, чтобы развернуть его, и 
соедините плечо 3 этого эле-
мента с правым концом второго 
элемента MLIN (рис. 3.64). 

6. Раскройте подгруппу Coupled 
Lines. Перетащите в поле схемы 
элемент связанных линий 
M9CLIN, щёлкните правой 
кнопкой мышки, чтобы развер-

нуть его, и соедините плечо 1 этого элемента с плечом 1 элемента MTEE (рис. 3.65). 

Рис. 3.65

7. Щёлкните по элементу MTEE, чтобы выделить его. Щёлкните по значкам Copy и 
Paste на панели инструментов, переместите курсор в окно схемы, щёлкните два раза 

правой кнопкой 
мышки, чтобы 
развернуть ско-
пированный эле-
мент, и соедините 
его плечо 2 с пле-
чом 9 последнего 
отрезка в элемен-
те связанных ли-
ний. 

8. Перетащите в 
окно схемы эле-
мент M7CLIN и 
соедините его с 

элементом M9CLIN между двумя элементами MTEE (рис. 3.66). 

Рис. 3.66 

9. Перетащите в окно схемы элемент M9CLIN, щёлкните правой кнопкой мышки, чтобы 
развернуть его, и соедините с нижней частью схемы. 

10. Нажмите клавишу Shift, щёлкните мышкой по первому элементу MLIN и затем по 
второму, чтобы выделить их. Скопируйте выделенные элементы и соедините их с пле-
чом 3 последнего элемента MTEE. 

11. Раскройте подгруппу Other, перетащите элемент MOPEN в схему, щёлкните правой 
кнопкой мышки и соедините этот элемент с плечом 10 верхнего элемента M9CLIN. 
Щёлкните по значку Copy и затем, щёлкая по значку Paste, подключите элемент 
MOPEN ко всем остальным плечам верхнего элемента M9CLIN. Аналогично подклю-
чите элементы MOPEN ко всем плечам нижнего элемента M9CLIN. 
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12. Щёлкните по значку Port на панели инструментов и подключите порт ко входу схемы. 
Снова щёлкните по значку Port, два раза щёлкните правой кнопкой мышки и подклю-
чите порт к выходу схемы. 



13. Щёлкните по группе Substrates в левом окне проекта и перетащите элемент MSUB в 
окно схемы. Должна получиться схема, показанная на рис. 3.67. 

Рис. 3.67 

3.3.2. Добавление переменных и редактирование элементов схемы. 
1. Добавьте переменные для связанных отрезков линий. Для этого щёлкните по значку 

Equation на панели инструментов и введите переменную W1=0.45. Аналогично до-
бавьте переменные W2=0.45, W3=0.45, W4=0.45 и W5=0.45. Затем добавьте S1=1, 
S2=1, S3=1 и S4=1. Введите переменную для полной длины полуволновых резонаторов 
L=5.6 (примерно половина длины волны на подложке с Er=10.45 толщиной 0.5 мм на 
частоте 10 ГГц). Введите расстояния от верхнего разомкнутого конца крайних резона-
торов до точки подключения кондуктивной связи. Это расстояние в первом приближе-
нии будем считать равным примерно одной трети от длины резонатора: L1=1.8. Введи-
те переменную для расстояния от нижнего разомкнутого конца крайних резонаторов до 
точки подключения кондуктивной связи. Оно будет равно L2=L-L1-WT. Добавьте пе-
ременные для согласующих отрезков на входе и выходе фильтров WT=0.45 и LT=0.5. 

2. Дважды щёлкните по первому элементу MLIN и введите параметры W=0.45 и L=3. 
Эти же значения параметров введите для последнего элемента MLIN. Дважды щёлкни-
те по второму элементу MLIN и введите параметры W=WT и L=LT, эти же значения 
параметров введите для предпоследнего элемента MLIN. 

3. Дважды щёлкните по верхнему элементу M9CLIN и введите параметры W1=W1, 
W2=W2, W3=W3, W4=W4, W5=W5, W6=W4, W7=W3, W8=W2, W9=W1, S1=S1, 
S2=S2, S3=S3, S4=S4, S5=S4, S6=S3, S7=S2, S8=S1 и L=L1. Эти же значения парамет-
ров введите для нижнего элемента M9CLIN, только значение длины введите L=L2. 

4. Дважды щёлкните по элементу M7CLIN и введите параметры W1=W2, W2=W3, 
W3=W4, W4=W5, W5=W4, W6=W3, W7=W2,  S1=S2,  S2=S3,  S3=S4,  S4=S4,  S5=S3,  
S6=S2 и L=WT. 

5. Для элементов MOPEN введите соответствующие параметры W=W1, W=W2, W=W3, 
W=W4, W=W5, W=W4, W=W3, W=W2 и W=W1. 

6. Дважды щёлкните по первому элементу MTEE и введите W1=W1, W2=W1, W3=WT. 
Такие же параметры введите для последнего элемента MTEE. 
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ная схема показана на рис. 3.68. 

ne Tool на панели инстру-
ой, назначьте для настрой-

 по частоте 0.2. 

7. Дважды щёлкните по элементу MSUB и введите параметры Er=10.54,  H=0.5, 
T=0.005,  Tand=0.0001 и ErNom=10.54. Окончатель

Рис. 3.68 

3.3.3. Добавление частот, анализ и настройка схемы. 
1. В левом окне проекта откройте вкладку Proj. Дважды щёлкните по Project Options в 
этом окне и введите частоты от 8 до 12 с шагом 0.25. Нажмите Apply и OK. 

2. Сделайте активным окно схемы. Щёлкните по значку Tu
ментов, устанавливая курсор на переменные и щёлкая мышк
ки все переменные, кроме L2=L-L1-LT, щёлкните мышкой на свободном месте поля 
схемы. 

3. Щёлкните по значку New Graph на панели инструментов и создайте график с именем 
LdB. Щёлкните правой кнопкой мыш-
ки по имени созданного графика в ле-
вом окне проекта и добавьте измеряе-
мую величину S21 в dB, нажмите Ap-
ply и OK. 

4. Щёлкните по значку Analyze на пане-
ли инструментов. Щёлкните правой 
кнопкой по графику и выберите Prop-
erties. В открывшемся окне Rectangu-
lar Plot Properties на вкладке Axes для 
оси x снимите “галочку” в Auto divs и в 
поле Step введите шаг
Для оси Left 1 снимите “галочку” в 
Auto limits, введите в поле Min введи-
те -50 и в поле Max введите 0, снимите 
“галочку” в Auto divs и в поле Step 

введите 5. На вкладке Fonts щёлкните по кнопке Axis numbers, в открывшемся окне 
Шрифт выберите шрифт Arial, начертание обычный и размер 14, нажмите OK. В окне 
Rectangular Plot Properties нажмите Apply и OK. Полученный график показан на рис. 
3.69. 

Рис. 3.69 
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тройки пе-

 

. 
. В открывшемся окне на вкладке 

Layout в поле Grid spacing (Интервал сетки) введите 0.05 mm и в поле Database unit 
size введите 0.001 mm. На вкладке Dimension Lines в поля Font height и Arrow size 
введите 0.5 mm, в поле Precision (Точность, т.е. число знаков после запятой) введите 2. 

ть размер клеток в сетке 

нду Edit>Select All. 

 команду 

ирины топологии. Исходя их полу-

5. Щёлкните по значку Tune на 
панели инструментов и, двигая 
движки переменных на блоке 
настройки, добейтесь требуе-
мой характеристики (рис. 
3.70). 
В результате нас

ременные получили следующие зна-
чения: L=5.25, L1=1.6, W1=0.7, 
W2=0.5, W3=W4=W5=0.45, S1=0.55, 
S2=1.1, S3=S4=1.2, WT=0.45 и 
LT=0.5. 
 

 
 
 Рис. 3.70 

3.3.4. Создание электромагнитной структуры
1. Выберите в меню команду Options>Layout Options

Нажмите OK. На панели инструмен-
тов в окошке Set Grid Snap Multiple 
(Установи
кратным) введите 1х, щёлкнув по 
кнопке в правом краю этого окошка, 
чтобы размер клеток в сетке остался 
равным 0.05 мм. 

2. Сделайте активным окно схемы. Выберите в меню команду New Schematic Layout 
View, чтобы отобразить топологию схемы. Возможный вариант отображения схемы 
показан на рис. 3.71. 

3. Выделите все элементы топологии, установив курсор мышки левее и выше топологии, 
нажав кнопку мышки и переместив курсор правее и ниже топологии, или выбрав в ме-

ню кома

Рис. 3.71 

Выберите в меню команду 
Edit>Snap Together или 
щёлкните по значку Snap To-
gether на панели инструмен-
тов. Исправленная топология 
показана на рис. 3.72. 

4. Выберите в меню
Dimension Line. Установите 
курсор мышки на верхний ле-

вый угол входного проводника, нажмите кнопку мышки и, не отпуская кнопки, пере-
местите курсор на верхний правый угол выходного проводника и отпустите кнопку, ус-
тановите размер длины топологии удобным для наблюдения и щёлкните левой кнопкой 
мышки (рис. 3.72). Аналогично установите размер ш

Рис. 3.72 

ченных размеров, выберем размер платы 19.75х7. 
5. Выберите в меню команду New EM Structure и создайте структуру с именем 

F95_105. 
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5, в поле X-Divisions введите 395, в 

s для слоя 1 введите толщину 6. Для слоя 2 введите толщину 0.5, диэлектри-

крайние стороны входного и выход-

ыделить его. Щёлкните по значку Edge 

гию, 

 Frequencies 

ектромагнитной структуры F95_105 в левом окне проек-
та, нажмите левую кнопку мышки и переместите курсор на группу EM Structures. 

6. Выберите в меню команду Substrate Information. В открывшемся окне на вкладке 
Enclosure в поле X-Dimension(mm) введите 19.7
поле Y-Dimension(mm) введите 7 и в поле Y- Divisions введите 140. На вкладке Dielec-
tric Layer

ческую проницаемость 
10.54, тангенс потерь 0.0001 
и масштаб просмотра 4 (рис. 
3.73). Нажмите OK. 

7. Сделайте активным окно 
топологии схемы, выделите 
все элементы топологии и 
щёлкните по значку Copy на 
панели инструментов. 

8. Сделайте активным окно 
электромагнитной структу-
ры и щёлкните по значку 
Paste на панели инструмен-
тов. Поместите топологию в 
электромагнитную структу-

ру симметрично относительно корпуса так, чтобы
Рис. 3.73 

 
ного проводников точно совпадали с левым и правым краями корпуса (рис.3.74). 

9. Щёлкните по входному проводнику, чтобы в
Port на панели инструментов и установите порт на входе фильтра. Щёлкните по квад-

ратику установленного порта, 
установите курсор на правую 
сторону этого квадратика, на-
жмите кнопку мышки и сдвинь-
те референсную плоскость 
вправо на 1 мм. Аналогично ус-
тановите порт на выходе фильт-
ра. Выделите всю тополо
щёлкните правой кнопкой по 
любому элементу топологии и 
выберите Mesh/Material Prop-
erties. В открывшемся окне вы-
берите материал 1/2oz Cu, на-
жмите OK. Полученная тополо-
гия показана на рис.3.74. 

10. Щёлкните по значку Analyze 
на панели инструментов. Полу-
ченная характеристика показана 
на рис. 3.75. Характеристика 
сдвинута вниз по частоте, т.е. 
нужно укоротить резонаторы. 
Кроме того добавим частотных 
точек, чтобы точнее отобразить 

характеристику в переходной области. 
11. Дважды щёлкните по Project Options в левом окне проекта. На вкладке

Рис. 3.74 

Рис. 3.75 

отметьте Add и Single point. В поле Point(GHz) введите 9.35 и нажмите Apply. Анало-
гично добавьте частоты 10.65 и 10.85. Щёлкните по значку Analyze на панели инстру-
ментов. 

12. Установите курсор на имя эл
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ику 

 1, снимите “галочку” в dB, нажмите 

как описано 

Щёлкните правой кнопкой мышки 
по имени скопированной структу-
ры Copy of F95_105, выберите 
Rename EM Structure и переиме-
нуйте её в F95_105A. 

13. Дважды щёлкните по верхней 
части первого резонатора, устано-
вите курсор на ромбик посередине
верхней стороны и сместите её 
вниз на 0.05. Аналогично укоро-
тите все остальные резонаторы. 
Сделайте активным окно графика 
LdB и щёлкните по значку Ana-
lyze на панели инструментов. Ха-
рактеристика показана на рис. 
3.76. 

14. Для дальнейшей отработки топо-
логии лучше перейти к граф

Рис. 3.76

стоячей волны. Щёлкните по 
значку New Graph и создайте 
график с именем KstU. Щёлкните 
правой кнопкой мышки по этому 
имени в левом окне проекта и вы-
берите Add Measurement. В об-
ласти Meas. Type выберите Lin-
ear, в области Measurement вы-
берите VSWR, в поле Data Source 
Name введите All Source, в поле Рис. 3.77 

Рис. 3.78

Port Index установите
Apply и OK. Щёлкните по значку Analyze на панели инстру-
ментов. Щёлкните правой кнопкой по графику и выберите 
Properties. Для оси x снимите “галочки” в Auto limits и Auto 
divs. В поле Min введите 9, в поле Max введите 11, в поле Step 
введите 0.2. Для оси Left 1 снимите “галочки” в Auto limits и 

Auto divs. В поле Min введите 0, в 
поле Max введите 10, в поле Step 
введите 0.5. График KstU показан 
на рис. 3.77. 

15. Уточним точку подключения 
кондуктивной связи. Щёлкните 
правой кнопкой мышки по имени 
структуры F95_105 в левом окне 
проекта и удалите эту структуру. 
Создайте копию оставшейся 
структуры F95_105A, 
выше, и переименуйте скопиро-
ванную структуру в F95_105. На-
жмите клавишу Shift и щёлкните 

по двум входным отрезкам линий, чтобы выделить их (рис. 3.78). Установите курсор на 
любой выделенный проводник и сдвиньте выделенные проводники на 0.2 вверх. В Pro-
ject Options добавьте частоту 9.6 ГГц, как описано выше. Сделайте активным окно 
графика KstU и щёлкните по значку Analyze на панели инструментов. Полученный 
график показан на рис. 3.79. Характеристика имеет сдвиг вверх по частоте и полоса 
пропускания несколько шире требуемой при выполнении требований на частотах за-

Рис. 3.79 
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кания 4.3 – 4.8 
ГГц.

слаб-

рис. 3.

Б

е электрической схемы. 
 именем Fil43-48. 

анели инструментов и соз-

кните по подгруппе Junctions, перетащите элемент 

й кнопкой мышки, чтобы развернуть, и подклю-

ой кнопкой мышки и подключи-
те этот элемент к нижнему элементу MLIN (рис. 3.83). 

граждения, что обеспечивает необходи-
мый запас для настройки. На этом моде-

лирование можно считать законченным. 
Характеристика ослабления (расчётная и 
экспериментальная) и смоделированная 

топология показаны на рис. 3.80 и 3.81. 

3.4. Шпилечный фильтр с полосой пропус
 
Спроектировать шпилечный фильтр с полосой пропускания от 4.3 до 4.8 ГГц, о

ление в 

Рис. 3.81 

Рис. 3.80 

диапазоне от 5.2 до 7.4 должно быть не менее 40 дБ. Структура фильтра показана на 
82. В мастере синтеза фильтров Microwave Office 

подобных структур нет. Поэтому, чтобы получить первое 
приближение параметров топологии нужно воспользо-
ваться программой NuHertz Filter, интегрированной в Mi-
crowave Office, или обратиться к соответствующей лите-
ратуре, или действовать следующим образом. удем счи-
тать, что фильтр состоит из полуволновых резонаторов с 

укороченными связями, которые свёрнуты в шпильку. Воспользовавшись встроенным инст-
рументом TXLine (команда меню Tool>TXLine) определим, что длина полуволнового от-
резка на частоте 4.55 ГГц при подложке толщиной 0.5 мм и диэлектрической проницаемости 
10.3 равна примерно 12.5 мм. Выберем расстояние между проводниками внутри шпильки 1.5 
мм (ширина шпильки). Тогда длина шпильки должна быть примерно 5.5 мм. Электромагнит-
ной связью внутри шпильки будем пренебрегать. Теперь можно создавать электрическую 
схему фильтра. 

3.4.1. Создани

Рис. 3.82 

1. Создайте новый проект и сохраните его под
2. Щёлкните по значку New Schematic на п
дайте схему с именем Fil. 

3. Откройте вкладку Elem в левом окне проекта и раскройте группу 
Microstrip. 

4. Щёлкните по подгруппе Lines и перетащите элемент MLIN в окно 
схемы. Щёл
тройника MTEE$ в окно схемы, три раза щёлкните правой кнопкой 
мышки, чтобы развернуть этот элемент, и подключите его плечом 3 
к элементу MLIN. 

5. Выделите элемент MLIN, щёлкнув по нему мышкой, скопируйте 
его, щёлкните право
чите к плечу 1 элемента MTEE$. Аналогично подключите элемент 
MLIN к плечу 2 элемента MTEE$. 

6. Щёлкните по подгруппе Other, перетащите элемент MOPEN$ в 
окно схемы, три раза щёлкните прав

Рис. 3.83 
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D=TL3). 

 

по подгруппе Coupled Lines, 

ID=TL8). Скопируйте элемент 

 правой кнопкой мышки и подключите их к плечу 2 

 
 с 

15. Щёлкните по значку Paste на панели инструментов и подключите скопированные 
элементы к плечу 4 последнего элемента MCLIN. 

7. Щёлкните по подгруппе _Obsolite (Ус-
таревшие), перетащите элемент 
MBENDR, щёлкните правой кнопкой 
мышки и подключите этот элемент с 
верхним элементом MLIN (I

8. Скопируйте первый элемент MLIN 
(ID=TL1) и подключите его к элементу 
MBENDR. 

9. Из левого окна проекта снова перетащи-
те элемент MBENDR и подключите этот
элемент к последнему элементу MLIN 
(ID=TL7). 

10. Щёлкните 
перетащите элемент MCLIN в окно схе-
мы, щёлкните правой кнопкой мышки и 
подключите его к последнему элементу 
MBENDR (
MOPEN$ и подключите его к плечам 1 и 
4 элемента MCLIN (рис. 3.84). 

11. Нажмите клавишу Shift и, щёлкая мышкой по элементам, выделите элементы 
MBENDR (ID=TL6), MLIN (ID=TL7) и MBENDR (ID=TL8) (рис. 3.84). Скопируйте 
эти элементы, щёлкните два раза

Рис. 3.84 

элемента MCLIN. 

12. Скопируйте элемент MCLIN и подключите его к последнему элементу MBENDR. 
13. Скопируйте элемент MOPEN$ и подключите его к плечам 2 и 3 последнего элемента 

MCLIN (рис. 3.85).

Рис. 3.85

14. Нажмите клавишу Shift и, щёлкая мышкой по элементам, выделите элементы
ID=TL6 по ID=TL17 (рис. 3.85) и скопируйте их, щёлкнув по значку Copy на панели 
инструментов. 
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TL6), MLIN (ID=TL7) и MBENDR (ID=TL8), как в п.11. Скопируйте 

элементам, выделите два элемента 
) и элемент MOPEN$ (ID=TL5), подключенные к элементу 

жду двумя по-

ubstrates в левом окне проекта и перетащите элемент под-

тов, добавьте следующие перемен-

щих связанные 

 

ента MLIN (ID=TL45), подклю-

L2. Такие же параметры введите для элемента MLIN (ID=TL46), подклю-

введите W=WS и L=LS1. Такие же параметры 
введите для элемента MLIN (ID=TL44), соединяющего выходные проводники с по-
следним элементом связанных линий MCLIN (ID=TL35). 

жду двумя по-

ubstrates в левом окне проекта и перетащите элемент под-

тов, добавьте следующие перемен-

щих связанные 

 

ента MLIN (ID=TL45), подклю-

L2. Такие же параметры введите для элемента MLIN (ID=TL46), подклю-

введите W=WS и L=LS1. Такие же параметры 
введите для элемента MLIN (ID=TL44), соединяющего выходные проводники с по-
следним элементом связанных линий MCLIN (ID=TL35). 

16. Повторите п.15 ещё раз. 
17. Нажмите клавишу Shift и, щёлкая мышкой по элементам, выделите элементы 

MBENDR (ID=
эти элементы и подключите их к плечу 2 последнего элемента MCLIN. 

18. Нажмите клавишу Shift и, щёлкая мышкой по 
MLIN (ID=TL3 и ID=TL4
MTEE$ (ID=TL2), и скопируйте их. Подключите скопированные элементы к послед-
нему элементу MBENDR (ID=TL8). 

19. Скопируйте элемент MTEE$ (ID=TL2), и включите его в разрыв ме
элементу MBENDR (ID=TL8). 

19. Скопируйте элемент MTEE$ (ID=TL2), и включите его в разрыв ме
следними элементами MLIN (ID=TL45 и ID=TL46), два раза щёлкнув правой кнопкой 
мышки, чтобы развернуть. 

20. Скопируйте первый элемент MLIN (ID=TL1) и подключите его к плечу 3 последнего 
элемента MTEE$ (ID=TL48). 

следними элементами MLIN (ID=TL45 и ID=TL46), два раза щёлкнув правой кнопкой 
мышки, чтобы развернуть. 

20. Скопируйте первый элемент MLIN (ID=TL1) и подключите его к плечу 3 последнего 
элемента MTEE$ (ID=TL48). 

21. Щёлкните по значку Port на панели инструментов и установите порт на входе фильт-
ра. Аналогично установите порт на выходе схемы. 

22. Щёлкните по подгруппе S

21. Щёлкните по значку Port на панели инструментов и установите порт на входе фильт-
ра. Аналогично установите порт на выходе схемы. 

22. Щёлкните по подгруппе S
ложки MSUB в окно проекта. Полученная схема показана на рис. 3.86. ложки MSUB в окно проекта. Полученная схема показана на рис. 3.86. 

Рис. 3.86 

3.4.2. Добавление переменных, редактирование элементов и анализ схемы. 
1. Щёлкая по значку Equation на панели инструмен

3.4.2. Добавление переменных, редактирование элементов и анализ схемы. 
1. Щёлкая по значку Equation на панели инструмен
ные: W1=0.45 (ширина проводников крайних шпилек, к которым подключается кон-
дуктивная связь с портами), WS=0.45 (ширина проводников, соединяю
ные: W1=0.45 (ширина проводников крайних шпилек, к которым подключается кон-
дуктивная связь с портами), WS=0.45 (ширина проводников, соединяю
отрезки), WR1=0.45, WR2=0.45, WR3=0.45 (ширина проводников в связанных отрез-
ках), LR=5.5 (длина связанных отрезков), LS1=1.5, LS2=1.5, LS3=1.5, LS4=1.5 (длина
отрезки), WR1=0.45, WR2=0.45, WR3=0.45 (ширина проводников в связанных отрез-
ках), LR=5.5 (длина связанных отрезков), LS1=1.5, LS2=1.5, LS3=1.5, LS4=1.5 (длина
отрезков между связанными линиями), L1=1.8 (длина верхнего отрезка до кондуктив-
ной связи), L2=LR-L1-0.45 (длина нижнего отрезка от кондуктивной связи), S1=0.5, 
S2=0.5, S3=0.5 (величина зазора в связанных линиях). 

2. Дважды щёлкните по первому элементу MLIN (ID=TL1) и введите параметры 
W=0.45 и L=3. Такие же параметры введите для последнего элемента MLIN 
(ID=TL49). 

3. Для элемента MLIN (ID=TL3), подключенного к плечу 1 входного тройника, введите 
W=W1 и L=L1. Такие же параметры введите для элем

отрезков между связанными линиями), L1=1.8 (длина верхнего отрезка до кондуктив-
ной связи), L2=LR-L1-0.45 (длина нижнего отрезка от кондуктивной связи), S1=0.5, 
S2=0.5, S3=0.5 (величина зазора в связанных линиях). 

2. Дважды щёлкните по первому элементу MLIN (ID=TL1) и введите параметры 
W=0.45 и L=3. Такие же параметры введите для последнего элемента MLIN 
(ID=TL49). 

3. Для элемента MLIN (ID=TL3), подключенного к плечу 1 входного тройника, введите 
W=W1 и L=L1. Такие же параметры введите для элем
ченного к плечу 1 выходного тройника. 

4. Для элемента MLIN (ID=TL4), подключенного к плечу 2 входного тройника, введите 
W=W1 и L=

ченного к плечу 1 выходного тройника. 
4. Для элемента MLIN (ID=TL4), подключенного к плечу 2 входного тройника, введите 

W=W1 и L=
ченного к плечу 1 выходного тройника. 

5. Для элемента MLIN (ID=TL7), соединяющего входные проводники с первым элемен-
том связанных линий MCLIN (ID=TL9), 

ченного к плечу 1 выходного тройника. 
5. Для элемента MLIN (ID=TL7), соединяющего входные проводники с первым элемен-
том связанных линий MCLIN (ID=TL9), 
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37), соединяющего предпоследний элемент 

четвёртый элемент MCLIN 

S1 и L=LR. Такие же 

 W=WR3, S=S3 и L=LR. Такие же 

рая половина симмет-
рична первой. 

eplace, в поле 

 значку New Graph на панели ин-
. 

ласти 
e 
в 

ex 

6. Для элемента MLIN (ID=TL11), соединяющего первый элемент MCLIN (ID=TL9) со 
вторым элементом MCLIN (ID=TL15), ведите W=WS и L=LS2. Такие же параметры 
введите для элемента MLIN (ID=TL
MCLIN (ID=TL34) с последним элементом MCLIN (ID=TL35). 

7. Для элемента MLIN (ID=TL24), соединяющего второй элемент MCLIN (ID=TL15) с 
третьим элементом MCLIN (ID=TL22), ведите W=WS и L=LS3. Такие же параметры 
введите для элемента MLIN (ID=TL36), соединяющего 
(ID=TL23) с пятым элементом MCLIN (ID=TL34). 

8. Для элемента MLIN (ID=TL25), соединяющего третий элемент MCLIN (ID=TL22) с 
четвёртым элементом MCLIN (ID=TL23), ведите W=WS и L=LS4. 

9. Для первого элемента MCLIN (ID=TL9) введите W=WR1, S=
параметры введите для последнего элемента MCLIN (ID=TL35). 

10. Для второго элемента MCLIN (ID=TL15) введите W=WR2, S=S2 и L=LR. Такие же 
параметры введите для предпоследнего элемента MCLIN (ID=TL34). 

11. Для третьего элемента MCLIN (ID=TL22) введите
параметры введите для четвёртого элемента MCLIN (ID=TL23). 

12. Для всех элементов MBENDR введите W=WS. 
13. Для элемента MSUB введите Er=10.3, H=0.5, T=0.005, Tand=0.0001 и ErNom=10.3. 
Первая половина окончательной схемы показана на рис. 3.87, вто

Рис. 3.87

14. Откройте вкладку Proj в левом окне проекта и дважды щёлкните по Project Options. 
В открывшемся окне опций проекта на вкладке Frequencies отметьте R

Start(GHz) введите 3.9, в поле Stop(GHz) введите 
5.2, в поле Step(GHz) введите 0.1. Добавьте час-
тоты 4.25 и 4.85. Нажмите Apply и OK. 

15. Щёлкните по
струментов и создайте график с именем LdB
Щёлкните правой кнопкой по имени графика LdB 
в левом поле проекта и выберите Add Measure-
ment. В области Meas. Type разверните группу 
Linear и отметьте Port Parameters. В об
Measurement отметьте S. В поле Data Sourc
Name введите All Sources, щёлкнув по кнопке 
правом конце этого поля. В поле To Port Ind
введите 2, В поле From Port Index введите 1, от-

Рис. 3.88 
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e на панели инструментов. Щёлкните правой кнопкой 

ы. Щёлкните по значку Tune Tool на панели инстру-
урсор на переменные и, щёлкая мышкой, назначьте для на-
менные:WR1, WR2, WR3, LR, LS1, LS2, LS3, LS4, S1, S2 и 

S

м окно схемы. Исключите из настройки пере-

Когда характеристика будет близка к требуемой, можно перейти к графику коэф-

, 

метьте dB, нажмите Apply и OK. 
16. Щёлкните по значку Analyz
мышки по графику и выберите Properties. Для оси x снимите “галочку” Auto divs и в 
поле Step введите 0.1. Для оси Left 1 снимите “галочки” Auto limits и Auto divs. В поле 
Min введите -80, в поле Step введите 2. Нажмите Apply и OK. График показан на рис. 
3.88. После выполнения анализа может появиться окно, предупреждающее, что элемент 
MBENDR устаревший и рекомендуется использовать элемент MBENDA. Закройте это 
окно и не обращайте внимания. 

3.4.3. Настройка схемы. 
В нашем случае назначить для настройки сразу все переменные не получится, т.к. в 

блок настойки можно включить до 12 переменных. Из графика видно, что резонансная час-
тота выше требуемой и полоса пропускания шире. Поэтому включим в блок настройки дли-
ну и ширину резонаторов, и величину зазоров. 

1. Сделайте активным окно схем
ментов. Устанавливая к
стройки следующие пере

3. 
2. Сделайте активным окно графика и щёлкните по значку Tune на панели инструмен-
тов. Двигая движки переменных на блоке настройки, добейтесь характеристики, близ-
кой к требуемой. Затем сделайте активны
менные WR1, WR2, WR3 и добавьте переменные WS, W1 и L1, как описано в п.1. 
Сделайте активным окно графика и снова, двигая движки на блоке настойки, добейтесь 
улучшения характеристики. Возможно, эту процедуру придётся повторить несколько 
раз. 
фициента стоячей волны. Для этого щёлкните по значку New Graph на панели инстру-
ментов и создайте график с именем KstU. Затем щёлкните правой кнопкой мышки по 
имени этого графика в левом окне проекта и выберите Add Measurement. В открыв-
шемся окне в области Meas. Type отметьте Linear, в области Measurement отметьте 
VSWR, в поле Port Index введите 1 и снимите “галочку” в dB. Нажмите Apply и OK. 

3. Щёлкните по значку Analyze на панели инструментов. Затем щёлкните правой кноп-
кой мышки по графику и выберите Properties. Для оси x снимите “галочки” Auto limits 
и Auto divs, в поле Min введите 4.2, в поле Max введите 5 и в поле Step введите 0.05. 
Для оси Left 1 снимите “галочки” Auto limits и Auto divs. В поле Min введите 0, в поле 
Max введите 10 и в поле Step введите 0.5. Нажмите Apply и OK. 
Графики ослабления и КСВн после настройки показаны на рис. 3.89 и 3.90 соответст-

венно. Эти графики получены при следующих значения переменных: WS=0.5, W1=0.45
WR1=0.5, WR2=0.6, WR3=0.6, LR=5.2, LS1=0.8, LS2=1.55, LS3=1.55, LS4=1.6, S1=0.2, 
S2=0.45, S3=0.5 и L1=1.9. 

Рис. 3.89 Рис. 3.90 
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g введите 0.05 и в окно Database unit size введите 0.001, нажмите 
OK. Сделайте активным окно схемы и 
щёлкните по значку New Schematic 
Layout View. В открывшемся окне 
топологии схемы выделите все эле-
менты топологии и щёлкните по знач-
ку Snap Together на панели инстру-
ментов. Топология схемы, созданная 
Microwave Office показана на рис. 
 структуру непосредственно в редакто-
топологию и сократив количество топо-

топологии схемы, определим, что для раз-
 25х8 мм. 

1. Щёлкните по значку New EM Struc-
ture на панели инструментов и создай-
те электромагнитную структуру с име-
нем Fil43_48. 

2. Щёлкните по значку Substrate In-
formation. На вкладке Enclosure от-
крывшегося окна в поле X-
Dimension(mm) введите 25, в поле X-
Divisions введите 500, в поле Y-
Dimension(mm) введите 8 и в поле Y-
Divisions введите 160. На вкладке Di-
electric Layers для слоя 1 введите тол-
щину 6. для слоя 2 введите толщину 

0.5, диэлектрическую проницаемость 10.3, тангенс потерь 
0.0001 и масштаб отображения 4 (рис. 3.92), нажмите OK. 

3. Щёлкните по значку Rectangle Conductor на панели ин-
струментов. Нажмите клавишу Tab, в поле x введите 0, в 

поле y введите 3.3 (рис. 3.93), нажмите OK и затем клавишу 
Tab, в поле dx введите 3, в поле dy введите 0.45 (рис. 3.94), 

 значку Polygon Conductor, поместите кур-
 месте в нижней части окна электромаг-

ы и щёлкните мышкой. Затем перемещайте 
мышкой после каждого перемещения, на 5.2 

вправо, на 5.2 вниз, на 0.5 влево, на 4.7 вверх, на 
вниз и дважды щёлкните мышкой. Установи-
ченный резонатор, нажмите левую кнопку 

 резонатор с входным проводником. 
у Measure на панели инструментов, измерь-
верхней части резонатора до входного про-

 резонатор так, чтобы это расстояние было 
равно 1.9. Должна получиться структура, показанная на рис. 
3.95. 

5. Щёлкните по резонатору мышкой, чтобы выделить его, щёлкните по значку Copy и 
затем по ste на панели инструментов. Поместит анный резонатор на 
свободном месте в поле электромагнитной структуры и два раза щёлкните правой 

3.4.4. Создание и анализ электромагнитной структуры. 
Выберите в меню команду Options>Layout Options. На вкладке Layout открывшего-

ся окна в поле Grid spacin

Рис. 3.91 

3.91. В этом примере мы создадим электромагнитную
ре электромагнитной структуры, несколько изменив 
логических элементов. 

Измерив длину и ширину топологии в окне 
мещения топологии фильтра нужен корпус размером

Рис. 3.92 

Рис. 3.93 

нажмите OK. 
4. Щёлкните по
сор на свободном

нитной структур
курсор, щёлкая 
вверх, на 1.75 
0.8 влево, на 4.7 
те курсор на полу
мышки и соедините
Щёлкнув по значк
те расстояние от 
водника и сдвиньте

Рис. 3.94 

Рис. 3.95 

 значку Pa е скопиров



кнопкой мышки, чтобы развернуть его. Дважды щёлкните левой кнопкой мышки по 

 85

ередине левой стороны 

курсор на ром
натора, нажми
эту стону впра
водника шпиль
курсор на ромб
го проводника 
на 0.75, затем

 

ув два раза правой кнопкой 

7. Снова щёлкните по значку Paste и поместите
расстоянии 0.5 мм. Дважды щёлкните по
на ромбик посередине крайней правой стороны ника шпильки, нажмите 
левую кнопку мышки и сдвиньте эту сторон
левую сторону правого проводника шпильки
ками шпильки должно быть 1.6 мм. 

8. Дальше резонаторы должны располагаться
ра. Поэтому можно действовать следующи
ру, скопируйте его и поместите справа от

9. Щёлкните по второму резонатору, скопиру
натора на расстоянии 0.45 мм. 

10. Щёлкните му резонатору, скопируйте
местите справа от шестого

11. Щёлкните по входному
натору на таком же
ной  будет
л кой мышки
сдвиньте эту стону 
ная на рис. 3.97. 

12. Щёлкните мышкой
п струментов вите порт на входе фильтра, щёлкните по квадратику 

скопированному резонатору. Установите курсор на ромбик пос
этого резонатора, нажмите левую кнопку мышки и 
сдвиньте эту стону влево на 0.1, чтобы ширина лево-
го проводника шпильки была равна 0.6. Установите 

бик посередине правой стороны резо-
те левую кнопку мышки и сдвиньте 
во на 0.15, чтобы ширина правого про-
ки также была равна 0.6. Установите 
ик посередине правой стороны право-
шпильки, и сдвиньте эту стону вправо 
 аналогично сдвиньте вправо на 0.75 

левую сторону правого проводника шпильки. Расстояние между проводниками шпиль-
ки должно получиться равным 1.55. Установите курсор мышки на отредактированный 
резонатор, нажмите левую кнопку мышки и поместите этот резонатор рядом с первым

Рис. 3.96

на расстоянии 0.2 мм (рис. 3.96). 
6. Выделите второй резонатор, скопируйте его и, щёлкн
мышки, поместите его рядом со вторым резонатором на расстоянии 0.45 мм. 

 четвёртый резонатор рядом с третьим на 
 этому резонатору, установите курсор мышки 

 правого провод
у вправо на 0.05 мм. Аналогично сдвиньте 
 на 0.05 мм. Расстояние между проводни-

 симметрично относительно центра фильт-
м образом. Щёлкните по третьему резонато-

 четвёртого резонатора на расстоянии 0.5 мм. 
йте его и поместите справа от пятого резо-

 его, сделайте зеркальную копю и по-
 резонатора на расстоянии 0.2 мм.  

 проводнику, скопируйте его и подключите к последнему резо-

 по перво

 расстоянии от верха резонатора, как и входной проводник. Выход-
 выходить за пределы корпуса, поэтому дважды щёлкните по нему 

, установите курсор на ромбик посередине правой стороны и 
влево до границы корпуса. Должна получиться топология, показан-

 проводник
евой кноп

 по входному проводнику, затем щёлкните по значку Edge Port на 
 и устано

Рис. 3.97

анели ин
порта, установите курсор на правую сторону порта, нажмите левую кнопку мышки и 
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13. Выделите все элементы т
топологии, нажмите левую
ниже топологии так, чтобы

на панели инструментов. Щёлкни-

ите Prop-

 

структуры Fil43_48 в 

правой кнопкой мышки 
по имени скопирован-
ной структуры Copy of 
Fil43_48 и переименуй-
те её в Fil43_48A. 

2. Дважды щёлкните по 
первому резонатору. Ус-
тановите курсор на ром-
бик посередине нижней 

стороны левого проводника шпильки, нажмите левую кнопку мышки и сдвиньте эту 
сторону на 0.6 вниз (рис. 3.99). Аналогично сдвиньте на 0.6 нижнюю сторону правого 
проводника первого резонатора. 

3. Установите курсор на второй резо жмите левую кнопку мышки и сдвиньте 

сдвиньте референсную площадь на 1 мм вправо. Аналогично установите порт на выхо-
де фильтра и сдвиньте референсную площадь на 1 мм влево. 

опологии. Для этого установите курсор мышки левее и выше 
 кнопку мышки и переместите курсор по диагонали правее и 
 в образовавшийся прямоугольник попали все элементы то-

пологии, отпустите кнопку. Или 
выберите в меню команду 
Edit>Select Al. Щёлкните правой 
кнопкой мышки по любому эле-
менту топологии и выберите 
Mesh/Material Properties. В поле 
Selected Material введите 1/2oz 
Cu, нажмите OK. 

14. Сделайте активным окно графика 
LdB и щёлкните по значку Analyze 

те по полученному графику правой 
кнопкой мышки и выбер
erties. Для оси x снимите “галоч-
ку” в Auto limits, в поле Min вве-

дите 3.9, в поле Max введите 5.2, снимите “галочку” в Auto divs и в поле Step введите 
0.1. Для оси Left 1 снимите “галочку” в Auto limits, в поле Min введите -60, в поле Max 
введите 0, снимите “галочку” в Auto divs и в поле Step введите 5. Нажмите Apply и 
OK. График ослабления показан на рис

Рис. 3.98 

. 3.98. 

3.4.6. Редактирование топологии. 
Полученная характеристика сдвинута вверх по частоте. Поэтому необходимо 

удлинить резонаторы. 
1. Установите курсор на
имя электромагнитной 

левом окне проекта, на-
жмите левую кнопку 
мышки и переместите 
курсор на группу EM 
Structures. Щёлкните 

Рис. 3.100Рис. 3.99 

натор, на
этот резонатор вниз на 0.6 мм. Дважды щёлкните по второму резонатору левой кнопкой 
мышки и удлините его проводники на 0.6 вверх (рис. 3.100). 

4. Аналогично удлините все резонаторы фильтра. 
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шки и сдвиньте всю топо-

6.

7.

ьшим на 0.1 мм 

 мышки
окне проекта и удалите эту структуру, выбрав
структуры Fil43_48A, как описано в п.1 и переимену

8. Установи  и выше первого ре
переместит авее и ниже третьего 

на 0.1 сначала три последних ре-
зонатора и затем два последних влево. Дважды щёлкните по входному проводнику, ус-

не правой стороны этого проводника и сдвиньте её 
ре-

-
ной пр
следним

9. Сделайте
щёлкните
инструмент
на рис. 3.102. 

10. Удалите
Fil43_48A
характеристику
частоте. 
пробуем 
шпилек, 

структуры Fil43_48 и переименуйте её в Fil43_48A. Два ртому 
резонатору и сдвиньте обе стороны левого проводника
вправо и затем сдвиньте обе стороны правого проводника

ие между этими проводн о равно 1.2 
натора и сдвиньте из на 0.2 мм вправо, чтобы сохранить

му резонатору и сдвиньте 
мм так, чтобы расстояние между про-
 по входному проводнику и сдвиньте 

его правую сторону до соединения с первым резонатором. Аналогично отредактируйте 

5. Выделите все элементы топологии, установите курсор на любой элемент, нажмите ле-
вую кнопку мы
логию вверх на 0.3 мм, чтобы сохранить 
её симметричное положение относитель-
но корпуса. 
 Сделайте активным окно графика LdB и 
щёлкните по значку Analyze на панели 
инструментов. Характеристика показана 
на рис. 3.101. 
 Ширина полосы пропускания получи-
лась меньше требуемой, поэтому нужно 
увеличить связи между резонаторами, т.е. 
уменьшить зазоры. Умен
зазоры между вторым и третьим резона-
торами, а также между третьим и четвёр-

 по имени структуры Fil43_48 в левом 
 Delete EM Structure. Создайте копию 

йте её в Fil43_48. 
зонатора, нажмите левую кнопку мышки и 
резонатора, чтобы выделить эти резонато-

ры. Или нажмите клавишу Shift и щёлкните мышкой по этим резонаторам. Установите 
курсор на один из этих резонаторов, нажмите левую кнопку мышки и переместите и 
переместите три резонатора на 0.1 вправо. Аналогично выделите два первых резонато-
ра и сдвиньте их на 0.1 вправо. Аналогично сдвиньте 

Рис. 3.101
тым. Сначала щёлкните правой кнопкой

те курсор левее
е курсор пр

тановите курсор на ромбик посереди
вправо на 0.2 до соединения с первым 
зонатором. Аналогично удлините выход

оводник до его соединения с по-
 резонатором. 

 активным окно графика LdB и 
 по значку Analyze на панели 
ов. Характеристика показана 

 предыдущую структуру 
. Из графика видно, что теперь 

 нужно сдвинуть вверх по 
Укоротим резонаторы, но по-
это сделать, укоротив не длину 
а их ширину. Создайте копию 
жды щёлкните по четвё

Рис. 3.102 

 этого резонатора на 0.2 мм 
 на 0.2 мм влево так, чтобы 

мм. Выделите три первых резо-
 величину зазора. Дважды 

щёлкните по третьему резонатору и сдвиньте обе стороны левого проводника вправо на 
0.35 мм так, чтобы расстояние между проводниками было равно 1.2 мм. Выделите два 
первых резонатора и сдвиньте их на 0.35 мм вправо. Дважды щёлкните по второму ре-

расстоян иками был

зонатору и сдвиньте обе стороны левого проводника вправо на 0.35 мм так, чтобы рас-
стояние между проводниками было равно 1.2 мм. Выделите первый резонатор и 
сдвиньте его на 0.35 мм вправо. Дважды щёлкните по перво
обе стороны его левого проводника влево на 0.4 
водниками было равно 1.2 мм. Дважды щёлкните



правую часть топологии так, чтобы она бы
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рину горизонтальных проводников в 
ников (0.6 мм). Дважды щёлкните по 
горизонтального проводника на 0.1 мм
ру и сдвиньте нижнюю сторону гори
гично отредактируйте все резонаторы ткройте окно гра-
фика LdB и щёлкните по значку Analyz
казана на рис. 3.103. Удалите предыду
к дальнейшему редактированию стру
стика имеет широкую полосу пропускания ование в полосе пропуска-
ния. 

Очевидно, на следующем шаге нужно
ширину полосы пропускания. Выполняя да
лучить топологию с размерами, указанные 
заны соответственно на рис. 3.106 и 3.107. 

 сдвиньте нижнюю сторону гори
гично отредактируйте все резонаторы ткройте окно гра-
фика LdB и щёлкните по значку Analyz
казана на рис. 3.103. Удалите предыду
к дальнейшему редактированию стру
стика имеет широкую полосу пропускания ование в полосе пропуска-
ния. 

Очевидно, на следующем шаге нужно
ширину полосы пропускания. Выполняя да
лучить топологию с размерами, указанные 
заны соответственно на рис. 3.106 и 3.107. 

ла симметрична левой. Также сделаем ши-
шпильках равной ширине вертикальных провод-
второму резонатору и сдвиньте верхнюю сторону 
 вверх. Дважды щёлкните по третьему резонато-
зонтального проводника на 0.1 мм вниз. Анало-
 кроме первого и последнего. О
зонтального проводника на 0.1 мм вниз. Анало-
 кроме первого и последнего. О

e на панели инструментов. Характеристика по-
щую структуру Fil43_48. Теперь можно перейти 
ктуры по графику KstU (рис. 3.104). Характери-

 и хорошее соглас

e на панели инструментов. Характеристика по-
щую структуру Fil43_48. Теперь можно перейти 
ктуры по графику KstU (рис. 3.104). Характери-

 и хорошее соглас

 увеличить величину зазоров, чтобы уменьшить 
льнейший подбор размеров топологии, можно по-
на рис. 3.105. Графики ослабления и КСВн пока-

 увеличить величину зазоров, чтобы уменьшить 
льнейший подбор размеров топологии, можно по-
на рис. 3.105. Графики ослабления и КСВн пока-

Рис. 3.103 Рис. 3.104 

Рис. 3.105

Рис. 3.106 Рис. 3.107 
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Meas. Type отметьте Port Parameters в 
подгруппе Linear, в области Measurement 
отметьте S, в поле To Port Index введите 2, 
в поле From Port Index введите 1, отметь-
те dB, нажмите Apply и OK. Щёлкните по 
значку Analyze. Щёлкните по графику пра-
вой кнопкой мышки и выберите Properties. 
Для оси x снимите “галочку” в Auto divs и 
в поле Step введите 0.2. Для оси Left 1 
снимите “галочку” в Auto limits и Auto 
divs, в поле Min введите -80, в поле Max 
введите 0, в поле Step введите 5. На вклад-
ке Fonts нажмите кнопку Axis number, в 

ер шрифта 14, нажмите OK и зате Apply и OK. По-
обы увеличить ослаблен м краю диапа-

зона за

В качестве заграждающего фильтра используем два четвертьволновых разомкнутых 
шлейфа на расстоянии четверти волны. С помощью TXLine (команда меню Tools>TXLine) 
определим, что четверть волны на частоте 7.4 ГГц равна примерно 3.8 мм. 

1. Щёлкните по значку New EM Structure на панели инструментов и создайте электро-
магнитную структуру с именем FZ. Щёлкните по значку Substrate Information на па-
нели инструментов. На вкладке Enclosure открывшегося окна в поле X-Dimension 
(mm) введите 11, в поле X-Divisions введите 220, в поле Y-Dimension (mm) введите 8, в 
поле Y-Divisions введите 160. На вкладке Dielectric Layers для слоя 1 введите толщину 
6. для слоя 2 введите толщину 0.5, диэлектрическую проницаемость 10.3, тангенс по-
терь 0.0001 и масштаб отображения 4, нажмите OK. 

2. Щёлкните по значку Rectangle Conductor на панели инструментов, поместите курсор 
на левый край созданной электромагнитной структуры и нажмите клавишу Tab. В поле 
x введите 0 и в поле y ведите 3.8, нажмите OK. Снова нажмите клавишу Tab. В поле dx 
введите 11 и в поле dy ведите 0.45, нажмите OK. 

3. Чтобы не увеличивать ширину платы, шлейфы свернём. Щёлкните по значку Polygon 
Conductor на панели инструментов, переместите курсор в окно электромагнитной 
структуры, щёлкните левой кнопкой мышки, затем перемещайте курсор, щёлкая мыш-
кой, следующим образом: вниз на 1.45, вправо на 3.15, вверх на 0.45, влево на 2.7, 
вверх на 1 и здесь дважды щёлкните мышкой. Подключите созданный шлейф к нижней 
стороне входного проводника на расстоянии 3 мм от входа структуры. Щёлкните по 
значку Copy и затем по значку Paste на панели инструментов, два раза щёлкните пра-
вой кнопкой мышки, чтобы развернуть скопированный шлейф и подключите его к 
верхней стороне входного проводника на расстоянии 3.8 мм от первого шлейфа. Щёлк-
ните по вх воднику, затем щёлкните по значку  на панели инстру-
ментов, ус рт на входе фильтра и сдвиньте реф плоскость порта на 

Характеристика удовлетворяет требованиям в полосе пропускания, но, вероятно, не 
будет удовлетворять требованиям на верхней частоте полосы запирания из-за её близости ко 
второй полосе пропускания фильтра. Чтобы проверить это, добавьте в проект частоты поло-
сы заграждения. Удалите из проекта уже не нужную схему Fil. Дважды щёлкните по Project 
Options, на вкладке Frequencies отметьте Add, в поле Start(GHz) введите 5.4, в поле Stop 
введите 7.4, в поле Step введите 0.2, нажмите Apply и OK. Чтобы иметь возможность точнее 
наблюдать изменения характеристики в полосе пропускания, сохраним имеющийся график 
ослабления с фиксированными свойствами, а для более широкого диапазона создадим новый 
график. Щёлкните по значку New Graph и создайте график с именем LdBZ. Щёлкните по 

имени этого графика в левом окне проекта 
и выберите Add Measurement. В области 

лученный график показан на рис. 3.108. Чт

Рис. 3.108 

области Размер введите разм м нажмите 
ие на право

граждения, добавим к топологии заграждающий фильтр на этот участок диапазона. 

3.4.7. Моделирование заграждающего фильтра. 

 Edge Port
еренсную 

одному про
тановите по
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1 мм вправо. Аналогично установите порт 

 график
ждающего фильтра можно считать приемлем
сование в полосе пропускания. 

ели 
 соответственно на рис. 3.112 и 

на выходе фильтра. Должна получиться то-
пология, показанная на рис. 3.109. Выделите 
все элементы топологии, щёлкните по лю-
бому элементу правой кнопкой мышки, вы-
берите Mesh/Material Properties и выберите 
материал 1/2oz Cu и нажмите OK. 

4. Сделайте активным окно графика LdBZ и 
щёлкните по значку Analyze на панели инструментов. График ослабления показан на 

а KstU (рис. 3.111). Характеристику загра-
ой, но можно и несколько улучшить согла-

5. Откройте окно электромагнитной структуры FZ. Установите курсор на верхний 
шлейф, нажмите левую кнопку мышки и переместите этот шлейф влево на 0.2, умень-
шив расстояние между шлейфами до 3.6 мм. Щёлкните по значку Analyze на пан

Рис. 3.109

рис. 3.110. Сделайте активным окно

Рис. 3.110 Рис. 3.111 

инструментов. Графики ослабления и КСВн показаны
3.113. 

Рис. 3.112 Рис. 3.113 

3.4.8. Создание и редактирование структуры фильтра с заграждением. 
1. Установите курсор на имя полосового фильтра Fil43_48 в левом окне проекта, нажми-
те левую кнопку мышки и переместите курсор на группу EM Structures и переименуй-
те созданную копию структуры в Fil43_48Z. 

2. Щёлкните по значку Substrate Information на панели инструментов, на вкладке En-
closure открывшегося окна в поле X-Dimension (mm) введите 30, в поле X-Divisions 
введите 600, нажмите OK. 

3. Щёлкните по значку View All на панели инструментов, чтобы отобразить всю струк-
туру. Щёлкните по значку View Area на панели инструментов и выделите правую часть 
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структуры, чтобы её увеличить. Дважды
вите курсор на ромбик посередине
кнопку мышки и сдвиньте эту сторон

4. Сделайте активным окно структуры
рёдно по заграждающим шлейфам
панели инструментов. 

5. Сделайт м окно структуры
инструментов и установите скопир

уктура должна выглядеть, как показано на рис. 

струментов. График (рис. 3.115) показывает хорошее совпадение характе
данными требованиями. На рис. 3.116 показан график расчётной характеристики

абления и измеренной характеристики макета. 

3.5. Шпилечный фильтр с полосой пропускания 875 – 1125 
МГц. 

Требуется спроектировать 5-ти резонаторный фильтр с полосой пропускания от 875 
до 1125 МГц. Ф ен иметь минимальные размеры и п сти малую ширину 

 проницаемостью 100, толщину подложки возьмём равной 1 мм. Чтобы про-
щью 

 

 диэлектрической проницаемости или не работают, или не 

 щёлкните по выходному проводнику, устано-
 правой стороны этого проводника, нажмите левую 
у вправо до правого края корпуса. 
 FZ. Нажмите клавишу Shift и щёлкните пооче-

, чтобы выделить их. Щелкните по значку Copy на 

 Fil43_48Z, щелкните по значку Paste на панели 
ованные шлейфы на расстоянии 1 мм от последнего 

резонатора полосового фильтра. Стр

е активны

3.114. 

на панели ин-
ристики с за-

 вно-

6. Сделайте активным окно графика LdBZ и щелкните по значку Analyze 
Рис. 3.114

симого осл

Рис. 3.115 Рис. 3.116 

ильтр долж о возможно
платы. 

Чтобы получить малые габариты платы, для подложки будем использовать материал с 
диэлектрической
водники не были слишком тонкими, выберем их ширину предварительно 0.5 мм. С помо
TXLine определим, что такая ширина проводников соответствует примерно 21.5 Ом, а длина
половины длины волны равна примерно 19.2 мм. Для согласования с 50-омной линией выбе-
рем кондуктивную связь крайних резонаторов с входным и выходным проводниками и опре-

 её параметры так, чтобы одновременно выделим полнялась и роль трансформатора сопро-
тивлений. Чтобы удовлетворить требование малой ширины платы, свернём резонаторы в ви-
де, показанном на рис 3.117. Создать схему такого фильтра довольно сложно. Кроме того, 
многие элементы схем при такой



гарантируют результаты анализа. Поэтому сразу приступим к созданию электромагнитной 
структуры. 

3.5.1. Создание электромагнитной структуры. 
Создадим топологию свёрнутого резонатора из отрезка линии шириной 0.5 мм как по-

казано на рис. 3.117 так, чтобы его полная длина была равна примерно 19.2 мм. Ширина ре-
зонатора получилась 4.4 мм. Величину зазора предварительно выберем равной 0.2 мм, длину 

вх
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1. Создайте новый проект и сохраните его с именем F875-
1125. 

2. Щёлкните по значку New EM Structure на панели инстру-
ментов и создайте электромагнитную структуру с именем 
F875_1125. 

3. Щёлкните по значку Substrate Information на панели инст-
 Enclosure отрывшегося окна в поле X-Dimension (mm) введите 

28.8, в поле X-Divisions введите 576 
(размер сетки по оси X будет 0.05 
мм), в поле Y-Dimension (mm) вве-

70 (размер сетки по оси Y будет 0.1 

слоя 2 введите толщину слоя 1, ди-
электрическую проницаемость 100, 
тангенс потерь 0.001 и масштаб ото-
бражения 4 (рис. 3.118). Нажмите 
OK. 

4. Щёлкните по значку Rectangle 
Conductor, переместите курсор в окно электромагнитной структуры и нажмите клави-
шу Tab. В поле x открывшегося окна ведите 0, а в поле y введите 3.2, нажмите OK и 
снова клавишу Tab. В поле dx открывшегося окна ведите 3, а в поле dy введите 0.5, 
нажмите OK. 

5. Щёлкните по значку Polygon Conductor, поместите курсор на свободном месте внизу 
и щёлкните мышкой. Затем  курсор, щёлкая 
мышкой после каждого пер на 5.9 вверх, на 1.8 

ево, на 5.4 вверх, на 0.8 вле-
на 
те 

курсор на созданный резонатор, сдвиньте его так, чтобы 

одных и выходных проводников выберем равной 3 мм. При этих 
размерах длина платы для 5-ти резонаторного фильтра получается 
равной 28.8 мм. Ширину платы выберем равной 7 мм. 

дите 7, в поле Y-Divisions введите 

Рис. 3.117 
рументов. На вкладке

мм). На вкладке Dielectric Layer для 
слоя 1 введите толщину слоя 4. Для 

вправо, на 3.9 вниз, на 0.8 вправо, на 3.9 вверх, на 1.8 
вправо, на 5.9 вниз, на 0.5 вл

Рис. 3.118 

 перемещайте
емещения, 

во, на 3.9 вниз, на 1.8 влево, на 3.9 вверх, на 0.8 влево, 
5.4 вниз и здесь дважды щёлкните мышкой. Помести

расстояние от верхней границы корпуса до резонатора 
было 0.6 мм, и соедините резонатор со входным провод-
ником. Созданная топология должна быть такой, как по-
казано на рис. 3.119. 

6. Щёлкните мышкой по резонатору и затем щёлкните по значкам Copy и Paste на пане-
ли инструментов. Переместите курсор в окно топологии, дважды щёлкните мышкой, 
чтобы развернуть резонатор, и поместите его рядом с первым резонатором на расстоя-
нии 0.2 мм. 

7. Снова щёлкните по значку Paste на панели инструментов и поместите скопированный 
резонатор рядом со вторым на расстоянии 0.2 мм. 

8. Аналогично добавьте ещё два резонатора. 

Рис. 3.119 
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ните мышкой по входному проводнику, затем щёлкните по значку Edge Port на 
панели инструментов, установите порт на входе фильтра и, щёлкнув по порту мышкой, 

мм. Аналогично установите порт 
н

11. Выделите
пологическому элеме
открывшегося окна в
казанная на рис. 3.12

1. Дважды щёлкните по Project Options
поле Start(GHz) введите 0.6, в 
0.05, нажмите Apply и OK. 

2. Щёлкните по значку New Graph
Щёлкните правой кнопкой мышки

 Add Measurement. S, в 
To Port Index 2

авой 

близкой к требуемой. 

easurement. В от-

начку Analyze на панели инструмен-
 и выберите Properties. Для оси x снимите 

9. Щёлкните мышкой по входному проводнику, скопируйте его и подключите к послед-
нему резонатору на таком же расстоянии от верха резонатора, как и входной проводник 
(2.6 мм). 

10. Щёлк

переместите его референсную плоскость вправо на 1 
а выходе фильтра. 

 все элементы топологии, щёлкните правой кнопкой мышки по любому то-
нту и выберите Mesh/Material Properties. В поле Select Material 
ведите 1/2oz Cu, нажмите OK. Должна получиться топология, по-
0. 

Рис. 3.120

3.5.2. Определение частот, создание графика и выполнение анализа. 
, в открывшемся окне на вкладке Frequencies в 

поле Stop(GHz) введите 1.4 и в поле Step(GHz) введите 

 на панели инструментов и создайте график LdB. 
 по имени созданного графика в левом окне проекта 

В открывшемся окне отметьте Port Parи выберите ameters и 
поле  введите , в поле From Port Index введите 1, установите “галочку” 

в dB, нажмите Apply и OK. 
3. Щёлкните по значку Analyze на па-
нели инструментов. Щёлкните пр
кнопкой по графику и выберите Prop-
erties. Для оси x снимите “галочки” в 
Auto limits и в Auto divs, в поле Min 
введите 0.6, в поле Max введите 1.4 и в 
поле Step введите 0.05. Для оси Left 1 
снимите “галочки” в Auto limits и в 
Auto divs, в поле Min введите -60, в 
поле Max введите 0 и в поле Step вве-
дите 5. Нажмите Apply и OK. График 
характеристики ослабления показан на 
рис. 3.121. 

4. Характеристика получилась довольно 
Перейдём к графику коэффициента стоячей волны. Щёлкните по 

значку New Graph и создайте график с именем KstU. Щёлкните правой кнопкой мыш-
ки по имени это графика в левом окне проекта и выберите Add M

Рис. 3.121 

крывшемся окне отметьте Linear и VSWR, в поле Port Index введите 1, снимите “га-
лочку” в dB, нажмите Apply и OK. Щёлкните по з
тов. Щёлкните правой кнопкой по графику
“галочки” в Auto limits и в Auto divs, в поле Min введите 0.8, в поле Max введите 1.2 и 
в поле Step введите 0.05. Для оси Left 1 снимите “галочки” в Auto limits и в Auto divs, 
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зан на рис. 3.122. 

1125 в левом окне проекта, нажмите ле-
вую кнопку мышки и переместите кур-

ереиме-

Дважды щёлкните по первому резона-
тору, установите курсор на ромбик по-
середине левой стороны левого провод-

ника первого резонатора, нажмите левую 
кнопку мышки и переместите эту сторону на 
0.2 вправо (рис. 3.123). Поскольку входной 
проводник является частью трансформатора 
сопротивлений, изменение его длины также 
будет влиять на характеристику. Мы пока 
ставим его длину без изменений. Чтобы со-

ите левую кнопку 

ментов. Рассчитанный график показан на рис. 3.125. 

в поле Min введите 0, в поле Max вве-
дите 10 и в поле Step введите 0,5. На-
жмите Apply и OK. График КСВн пока-

Рис. 3.122

5. Изменим параметры элементов кон-
дуктивной связи. Установите курсор на 
имя электромагнитной структуры F875-

сор на группу EM Structures. П
нуйте копию структуры в F875-1125A. 

единить входной проводник с первым резо-
натором, сделаем следующее. Установите 

о

курсор мышки левее и выше первого резона-
тора, нажмите левую кнопку мышки и, не 
отпуская кнопки, переместите курсор правее 
и ниже правой стороны корпуса, чтобы вы-
делить все элементы топологии, кроме вход-

Рис. 3.123 

Рис. 3.124 

ного проводника. Установите курсор на лю-
бой выделенный элемент топологии, нажми-
те левую кнопку мышки и переместите все 
выделенные проводники влево на 0.2 мм до 
соединения их с входным проводником. 
Дважды щёлкните по последнему резонато-
ру, установите курсор на ромбик посередине 
правой стороны правого проводника послед-
него резонатора, нажм
мышки и переместите эту сторону на 0.2 
влево. Установите курсор на выходной про-
водник, нажмите левую кнопку мышки и пе-

реместите это проводник на 0.2 влево 
до соединения с последним резонато-
ром (рис. 3.124). Чтобы выходной порт 
фильтра был расположен на правой 
стороне корпуса, уменьшим соответст-
венно длину корпуса. Щёлкните по 
значку Substrate Information на панели 
инструментов. На вкладке Enclosure 
отрывшегося окна в поле X-Dimension 
(mm) введите 28.4, в поле X-Divisions 
введите 568, нажмите OK. Сделайте ак-
тивным окно графика KstU и щелкните 
по значку Analyze на панели инстру-Рис. 3.125



6. Удалите предыдущую структуру F875_1125, создайте копию оставшейся 
структуры F875_1125A и переименуйте копию в прежнее имя F875_1125. Нажмите 

клавишу Shift и щёлкните по входному 
и выходному проводникам, чтобы вы-
делить их. Установите курсор на один 
из этих проводников и сдвиньте их на 
0.5 вверх. Сделайте активным окно 
графика KstU и щелкните по значку 
Analyze на панели инструментов. Рас-
считанный график показан на рис. 
3.126. 

7. Удалите предыдущую структуру 
F875_1125A, создайте копию оставшей-
ся структуры F875_1125 и переименуй-
те её в прежнее имя F875_1125A. В 

скопированной структуре уменьшим зазоры между первым и вторым резонаторами, 
а также между последним и предпоследним. Остальные зазоры увеличим. Установи-

те курсор на первый резонатор, нажми-
те левую кнопку мышки и сдвиньте 
этот резонатор вправо на 0.05. Анало-
гично сдвиньте последний резонатор 
влево на 0.05. Нажмите клавишу Shift и 
щёлкните по первому и второму резо-
наторам, установите курсор на один из 
них, нажмите левую кнопку мышки и 
сдвиньте эти резонаторы влево на 0.05. 
Аналогично сдвиньте предпоследний и 
последний резонаторы вправо на 0.05. 
Сделайте активным окно графика KstU 
и щелкните по значку Analyze на пане-

ли инструментов. Рассчитанный график показан 
на рис. 3.127. 

Рис. 3.126

Рис. 3.127 

8. Уменьшим длину крайних резонаторов. Уда-
лите предыдущую структуру F875_1125, создайте 
копию оставшейся структуры F875_1125A и пере-
именуйте её в прежнее имя F875_1125. Дважды 
щёлкните по первому резонатору, установите кур-
сор на ромбик посередине правой стороны второ-
го вертикального проводника первого резонатора 
и сдвиньте эту сторону на 0.05 вправо (рис. 3.128). 
Затем также сдвиньте левую сторону этого про-
водника. Аналогично сдвиньте обе стороны пер-

вого вертикального проводника этого резонатора вправо на 0.05. Таким же образом 
укоротите последний резонатор, сдвинув его последние вертикальные проводники 
влево на 0.05. Выделите все элементы топологии, кроме входного проводника, и 
сдвиньте их влево на 0.05, чтобы соединить с входным проводником. Щёлкните по 
выходному проводнику и сдвиньте его влево, чтобы соединить с последним резона-
тором. Щёлкните по значку Substrate Information и укоротите корпус, введя размер 
28.3 по оси X и количество клеток сетки 566 по этой оси. Чтобы точнее отобразить 
характеристику в полосе пропускания, увеличим число частотных точек. Дважды 
щёлкните мышкой по Project Options в левом окне проекта. На вкладке Frequencies 
отметьте  Add,  в поле  Start(GHz)  введите  0.875, в поле Stop(GHz) введите 1.125 и 
в поле  Step(GHz)  введите  0.05,  нажмите  Apply  и  OK.   Сделайте  активным окно 

Рис. 3.128 
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графика KstU и щелкните по значку Analyze 
на панели инструментов. Рассчитанный 
график показан на рис. 3.129. Эта характе-
ристика удовлетворяет предъявляемым тре-
бованиям. Расчётная характеристика вноси-
мого ослабления и экспериментальные ха-
рактеристики до настройки и после показа-
ны на рис. 3.130. 

 Замечание. В приводимых в преды-
дущих разделах примерах внутреннее со-
противление резонаторов было равно сопро-
тивлению подводящих линий. Поэтому дли-
на входного и выходного проводников не 

имела особого значения. В этом примере 
эта длина является частью трансформа-
тора сопротивлений, поэтому не должна 
изменяться в реальной конструкции 
фильтра. Поскольку Microwave Office 
рассчитывает S-параметры между уста-
новленными референсными плоскостя-
ми, то в конструкции платы расстояния 
от края корпуса до референсных плос-
костей должны быть удалены. Конст-
рукция платы с топологией фильтра 
должна быть такой, как показано на рис. 
3.131. 

Рис. 3.129 

Рис. 3.130 

Рис. 3.131

3.6. Встречноштыревой фильтр с полосой пропускания 865 – 
880 МГц. 

Требуется спроектировать фильтр на встречных штырях с кондуктивной связью и с 
полосой пропускания от 865 до 880 МГц. Ослабление на частотах 830 и 910 МГц должно 
быть не менее 30 дБ.  

3.6.1. Создание схемы фильтра. 
Для определения схемы фильтра в первом приближении воспользуемся мастером син-

теза фильтров. 
1. Создайте новый проект и сохраните его под именем F865-880. 
2. Выберите в меню команду Options>Layout Options. На вкладке Layout открывшегося 
окна в поле Grid spacing введите 0.05, а в поле Database введите 0.001, нажмите OK. 
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3. На вкладке Proj раскройте группу Wizards и дважды щёлкните по Filter Synthesis 
Wizard. В открывшемся окне нажмите кнопку Далее. В следующем окне отметьте 
Bandpass и нажмите кнопку Далее. Отметьте аппроксимацию Chebyshev и нажмите 
кнопку Далее. В следующем окне Bandpass Parameter Specifications (рис. 3.132) вве-
дите порядок фильтра N=7, нижнюю частоту полосы пропускания FL=0.865, верхнюю 
частоту полосы пропускания FH=0.880, пульсации в полосе пропускания PV=0.5, со-
противление источника RS=50 и сопротивление нагрузки RL=50, нажмите Далее. От-
метьте тип структуры фильтра Intrdigital Resonators (Встречноштыревые резонаторы) 

и нажмите Далее. В следующем окне Bandpass Filter Constraints (рис. 3.133) отметьте 
Odd Mode Center Resonator (Нечётная мода центрального резонатора), введите импе-
данс нечётной моды 50, отметьте Short-Circuited Transformer (Короткозамкнутый 
трансформатор), нажмите Далее. Выберите планарную физическую структуру Micro-
strip и нажмите Далее. В следующем окне Microstrip Substrate Parameter Specifica-
tions (рис. 3.134) в поля Predefined Microstrip Substrate Selection (Выбор предопреде-
лённой подложки микрополоски) и в Microstrip Substrate Name (Имя подложки мик-
рополоски) оставьте по умолчанию User Defined (Определяется пользователем). Вве-
дите диэлектрическую проницаемость Er=10.22, тангенс потерь Tand=0.0001, толщину 
подложки H=1, толщину проводника 0.005. В поле Metal Selection введите Copper 

(Медь, щёлкнув по кнопке в правом конце этого поля). Нажмите Далее. В следующем 
окне Schematic Specification (рис. 3.135) в поле Schematic Name введите Filter, в поле 
Design Name (Имя проекта) оставьте имя  Design  по умолчанию (это имя будет отобра- 

Рис. 3.132 Рис. 3.133 

Рис. 3.134 Рис. 3.135 
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жаться в группе Filter Synthesis Wizard), в поле 
Graph Name введите LdB. Отметьте Include 
Optimization Goals (Включить цели оптимиза-
ции), Round Size To Grid (Округлить до разме-
ра сетки), Create Graph (Создать график). В об-
ласти Graph Type отметьте Rectangular и в об-
ласти Measurements отметьте Forwa d Trans-
fer (S21). Нажмите Далее. В следующем окне 
нажмите Готово. 

4. Щёлкните по значку Analyze на панели 
инструментов. Щёлкните правой кнопкой 
мышки по графику и выберите Properties. 
В открывшемся окне свойств графика на 
вкладке Axes для оси x снимите “галочку “ 

в Auto divs, и в поле Step введите 0.01. Для оси Left 1 снимите “галочки “ в Auto limits 
и Auto divs, в поле Min введите -65, в поле Max введите 0, в поле Step введите 5. На-
жмите Apply и OK. График характеристики вносимого ослабления схемы фильтра, 
созданной мастером синтеза, показана на рис. 3.136. 

Рис. 3.136 

3.6.2. Настройка схемы фильтра. 
Характеристика синтезированного фильтра 

далека от желаемой, но мастер синтеза подготовил 
всё для проведения оптимизации и настройки. Сна-
чала попробуем выполнить оптимизацию. 

1. Выберите в меню команду Simu-
late>Optimize. В открывшемся окне (рис. 
3.137) выберите метод оптимизации Ran-
dom(Local), в поле Maximum Iterations 
введите 500 и нажмите Start. Характеристи-
ка, полученная после оптимизации, показана 
рис. 3.138. Рис. 3.137

2. Для дальнейшего приближения к 
требуемой характеристике воспользуемся 
инструментом настройки схемы. Изме-
ним установленный мастером диапазон 
частот. Дважды щёлкните по Project Op-
tions в левом окне проекта и установите 
диапазон частот от 0,82 до 0.92 с шагом 
0.01 ГГц. Чтобы отобразить характери-
стику в полосе пропускания точнее, до-
бавьте частоты 0.865, 0.875 и 0.885. 
Щёлкните правой кнопкой мышки по 
имени схемы Filter в левом окне проекта 
и выберите Options. В открывшемся окне 
на вкладке Frequencies отметьте Use pro-
ject defaults, чтобы при анализе схемы 
использовались частоты проекта. Нажми-
те OK. Щёлкните по значку Analyze на 
панели инструментов. График показан на 
рис. 3.139. Сделайте активным окно схе-
мы. В схеме, созданной мастером синтеза, 
добавлены переменные (рис. 3.140) так, 
что ширины средних резонаторов и зазо-
ры  между  ними  остаются  одинаковыми  

Рис. 3.138 

Рис. 3.139



при оптимизации и настройке. Возможно, это явилось одной из причин не-
удачи оптимизации. Добавим в схему следующие переменные: W2=0.8, 
W3=0.8, W4=0.8, S2=4.5 и S3=4.5. Дважды щёлкните по элементу M9CLIN. 
В открывшемся окне свойств этого элемента введите W2=W1, W3=W2, 
W4=W3, W5=W4, W6=W3, W7=W2, W8=W1, S2=S1, S3=S2, S4=S3, 
S5=S3, S6=S2 и S7=S1. Нажмите OK. Щёлкните по значку Tune Tool на 

панели инструментов и, 
щёлкая по вновь добав-
ленным переменным, на-
значьте их для настройки. 
Отредактированная схема 
показана на рис. 3.141. 
Сделайте активным окно 
графика и щёлкните по 
значку Analyze. Можно 
добавленные переменные 
назначить для оптимиза-
ции и попробовать повто-
рить оптимизацию. Мы 
воспользуемся блоком 
настройки. 

 Рис. 3.140 

3. Щёлкните по знач-
ку Tune на панели 
инструментов. Дви-

гая движки переменных 
на блоке настройки, до-
бейтесь приемлемой ха-
рактеристики (рис.3.142). 
В результате настройки 
переменные получили 
следующие значения: 
L0=32.4, S0=1, S1=4.2, 
S2=5.4, S3=5.8, W0=1.3, 
W1=1.4, W2=1,0, W3=0.8, 
и W4=0.8. 

Рис. 3.141 

4. Сделайте активным окно 
схемы и щёлкните по 
значку New Schematic 
Layout View на панели 
инструментов, чтобы ото-

бразить топологию схемы (рис.143). 
Измерив расстояния между 
соответствующими крайними точ-
ками топологии с помощью 
инструмента Measure, получим 
размер топологии 42.6х32.4. 

Рис. 3.142 

 
 
 Рис. 3.143 
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3.6.3. Создание и редактирование электромагнитной структуры. 
Электромагнитную структуру будем создавать в редакторе электромагнитной струк-

туры. При этом вместо входного и выходного возбуждающих проводников будем использо-
вать кондуктивную связь. Исходя из измеренных размеров топологии, возьмём корпус дли-
ной 44 мм и шириной 34 мм. 

1. Щёлкните по значку New TM Struc-
ture на панели инструментов и создай-
те электромагнитную структуру с име-
нем F865_880. 

2. Щёлкните по значку Substrate Infor-
mation на панели инструментов. В от-
крывшемся окне на вкладке Enclosure 
в поле X-Dimension(mm) введите 44, в 
поле X-Divisions введите 220 (по оси X 
размер клеток сетки 0.2), в поле Y-
Dimension(mm) введите 34, в поле Y- 
Divisions введите 340 (по оси Y размер 
клеток сетки 0.1). На вкладке Dielectric 
Layers для слоя 1 введите толщину 

слоя 7; для слоя 2 введите толщину слоя 1, диэлектрическую проницаемость 10.22, тан-
генс потерь 0.0001, масштаб просмотра 4 (рис 3.144), Нажмите OK. 

Рис. 3.144 

3. Щёлкните по значку Polygon Conductor на панели инструментов. Установите курсор 
на верхнюю сторону корпуса электромагнитной структуры вблизи левой стороны и 
щёлкните левой кнопкой мышки. Затем перемещайте курсор и щёлкайте мышкой после 
каждого перемещения следующим образом: вниз на 32.4, вправо на 1.4, вверх на 31.4, 
вправо на 10,6, вниз на 31.4. вправо на 0.8, вверх на 31.4, вправо на 12,4, вниз на 31.4, 
вправо на 0.8, вверх на 31.4, вправо на 10,6, вниз на 31.4, вправо на 1.4, вверх на 32.4 и 
здесь дважды щёлкните мышкой. Щёлкните по значку Polygon Conductor на панели 
инструментов. Установите курсор на нижнюю сторону корпуса электромагнитной 
структуры между первым и вторым стержнями и щёлкните левой кнопкой мышки. За-
тем перемещайте курсор и щёлкайте мышкой после каждого перемещения следующим 
образом: вверх на 32.4, вправо на 1.0, вниз на 31.4, вправо на 12.0, верх на 31.4, вправо 
на 0.8, вниз на 31.4, вправо на 12.0, вверх на 31.4, вправо на 1.0, вниз на 32.4 и здесь 
дважды щёлкните мышкой. Установите курсор на любой штырь последней штыревой 
структуры и сдвиньте её по оси X так, чтобы зазор между первым и вторым штырями 
был равен 4.2 мм. Выберите в меню команду Edit>Select All и сдвиньте всю созданную 
топологию по оси X так, чтобы от левого края она была на расстоянии 3 мм. 

4. Т.к. фильтр узкополосный, то связь крайних резонаторов с входным и выходным про-
водниками должна быть достаточно слабой, т.е. эти проводники должны быть подклю-
чены ближе к заземлённым концам крайних резонаторов. Щёлкните по значку Rectan-
gle Conductor на панели инструментов. Переместите курсор на электромагнитную 
структуру и нажмите клавишу Tab. В открывшемся окне введите в поле x введите 0, в 
поле y введите 4.5, нажмите OK и снова клавишу Tab. В открывшемся окне в поле dx 
введите 3, в поле dy введите 1, нажмите OK. Скопируйте созданный проводник и под-
ключите созданную копию к последнему резонатору на расстоянии 4.5 мм от верхней 
границы корпуса. Выделите все элементы топологии, щёлкните правой кнопкой мышки 
по любому проводнику и выберите Mesh/Material Properties. В открывшемся окне в 
выпадающем списке  Selected Material выберите 1/2oz Cu и нажмите OK. Щёлкните по 
входному проводнику, затем щёлкните по значку Edge Port на панели инструментов, 
установите порт на входе фильтра и сдвиньте его референсную плоскость на 1 мм 
вправо. Аналогично установите порт на выходе фильтра и сдвиньте его референсную 
плоскость на 1 мм влево. 
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5. Сделайте активным окно графика. Щёлкните по имени характеристики 
Filter:DB(|S(2,1)|) в левом окне проекта и 
выберите Properties. В открывшемся ок-
не в поле Data Source Name введите All 
Sources. Щёлкните по значку Analyze на 
панели инструментов. График показан на 
рис. 3.145. Полученная характеристика 
очень далека от характеристики, полу-
ченной для схемы в линейном моделиро-
вании. Видимо, это объясняется тем, что 
модель при слабых связях, которые тре-
буются для узкополосных фильтров, име-
ет большую погрешность и, кроме того, 
схема не совсем точно отражает создан-
ную электромагнитную структуру. Из 

графика ясно, что нужно увеличить связи между резонаторами, т.е. уменьшить зазоры 
между резонаторами. 

Рис. 3.145 

6. Установите курсор на имя электромагнитной структуры в левом окне проекта и, нажав 
левую кнопку мышки, переместите курсор на группу EM Structures. Переименуйте 
созданную копию структуры в F865_880A. Дважды щёлкните по третьему резонатору. 
Установите курсор на ромбик посередине правой стороны этого резонатора и сдвиньте 
её вправо на 1 мм. Затем установите курсор на ромбик посередине левой стороны этого 

резонатора и сдвиньте его также вправо на 
1 мм. Таким образом, мы уменьшили зазор 
между третьим и четвёртым резонаторами 
на 1 мм, сохранив ширину резонатора. Два-
жды щёлкните по второму резонатору и 
сдвиньте его вправо на 2 мм, уменьшив за-
зор между вторым и третьим резонаторами 
на 1 мм. Дважды щёлкните по первому ре-
зонатору и сдвиньте его вправо на 3 мм. 
Аналогично сдвиньте влево пятый резона-
тор на 1 мм, шестой резонатор на 2 мм и 
седьмой резонатор на 3 мм. Дважды щёлк-
ните по входному проводнику, установите 

курсор на ромбик посередине правой стороны и сдвиньте эту сторону вправо до соеди-
нения с первым резонатором. Аналогично соедините выходной проводник с последним 
резонатором. Сделайте активным окно графика и щёлкните по значку Analyze на пане-
ли инструментов. График показан на рис. 3.146, характеристика приближается к тре-

буемой. 

Рис. 3.146 

7. Удалите предыдущую структуру 
F865_880, создайте копию оставшейся 
структуры F865_880A и переименуйте её в 
прежнее имя F865_880. Сдвиньте вправо 
третий резонатор на 1 мм, второй на 1.8 мм 
и первый на 2.2 мм так, чтобы зазор между 
первым и вторым резонаторами был равен 
2.8 м, между вторым и третьим – 3.6 мм и 
между третьим и четвёртым – 3.8 мм. Ана-
логично сдвиньте влево пятый, шестой и 
седьмой резонаторы. Удлините входной и 
выходной проводники до соединения с 

крайними резонаторами. Сделайте активным окно графика и щёлкните по значку Ana-
lyze на панели инструментов. График показан на рис. 3.147. 

Рис. 3.147
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8. Изменим ширину резонаторов. Удалите предыдущую структуру F865_880A, создайте 
копию оставшейся структуры F865_880 и переименуйте её в прежнее имя F865_880A. 
Дважды щёлкните по среднему (четвёртому) резонатору, установите курсор на ромбик 

посередине левой стороны и 
сдвиньте её влево на 0.6 мм, что-
бы ширина этого резонатора была 
равна 1.4 мм. Аналогично сделай-
те ширину третьего и пятого ре-
зонаторов равной 1.6 мм, второго 
и шестого – 1.8 мм, первого и 
седьмого – 2.2 мм. Теперь раз-
двиньте резонаторы так, чтобы 
зазоры между ними были равны 
установленным ранее. Соответст-
венно измените длину входного и 
выходного проводников, чтобы 
восстановить соединение этих 
проводников с крайними резона-
торами. Сделайте активным окно 
графика и щёлкните по значку 
Analyze на панели инструментов. 

График показан на рис. 3.148. 

Рис. 3.148 Рис. 3.149 

Рис. 3.150 

9. Удалите предыдущую структуру 
F865_880, создайте копию оставшейся 
структуры F865_880A и переименуйте её в 
прежнее имя F865_880. Укоротим длину 
резонаторов. Дважды щёлкая по резонато-
рам, укоротите первый и последний резо-
наторы на 0,8 мм, второй и шестой – на 0,7 
мм, третий и пятый на 0,4 мм и четвёртый 
на 0,2 мм. Сделайте активным окно графи-
ка и щёлкните по значку Analyze на пане-
ли инструментов. График показан на рис. 
3.149, его уже можно считать удовлетво-
рительным. Смоделированная топология 
фильтра показана на рис. 3.150, а расчёт-

ный и экспериментальный графики показаны на рис. 3.151. 
Замечание. Поскольку фильтр узкополосный, при изготовлении шаблона макета все 

резонаторы фильтра были укорочены на 0.2 мм, чтобы иметь запас для настройки. 

Рис. 3.151
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3.7. Встречноштыревой фильтр с полосой пропускания 925 – 
960 МГц. 

Спроектировать фильтр с полой пропускания от 925 до 960 МГц. При отстройке от 
граничных частот на величину полосы пропускания ослабление должно быть не менее 40 дБ. 

Этот фильтр по предъявляемым требованиям и по частоте близок к фильтру, описан-
ному в разделе 3.6 и его можно моделировать точно так же, как описано в указанном разделе. 
Однако мы будем считать, что фильтр раздела 3.6 уже смоделирован и возьмём его в качест-
ве первого приближения. 

3.7.1 Редактирование смоделированной топологии. 
1. Загрузите проект F865-880, выбрав в меню File>Open Project. Затем выберите в меню 

File>Save Project As и сохраните проект под именем F925-960. 
2. Щёлкните правой кнопкой по имени электромагнитной структуры F865_880 в левом 
окне проекта и переименуйте её в F925_960. 

3. Дважды щёлкните по Project Options в левом окне проекта. В открывшемся окне на 
вкладке Frequencies отметьте Replace, в поле Start(GHz) введите 0.9, в поле 
Stop(GHz) введите 1, в поле Step(GHz) введите 0.01, нажмите Apply и OK. 
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йте активным окно графика LdB и щёлкните по значку Analyze на панели инст-

ещё 

4. Воспользовавшись инструментом Tools>TXLine, определим, что четверть длины вол-
ны в заданной полосе пропускания равна примерно 30.4 мм. Сделайте активным окно 
электромагнитной структуры. Щёлкнув мышкой по значку Measure и измерив длину 
резонаторов, определим, что их нужно укоротить примерно на 1 мм. Дважды щёлкнув 

мышкой по резонаторам, укоротите все резонато-
ры на 1 мм. Установите курсор на нижний зазем-
ляющий проводник, нажмите левую кнопку мыш-
ки и сдвиньте этот проводник с подключёнными к 
нему резонаторами вверх на 1 мм. Щёлкните 
мышкой по значку Substrate Information. В от-
крывшемся окне на вкладке Enclosure в поле Y-
Dimension (mm) уменьшите размер на 1 мм (раз-
мер должен получиться 33), в поле Y-Divisions со-
ответственно введите 330, нажмите OK. Должна 
получиться топология, показанная на рис. 3.152. 

5. Сдела

Рис.3.152

рументов. Из графика (рис. 3.153) видно, что резонаторы укорочены недостаточно. 

6. Сделайте активным окно электромагнитной структуры, укоротите все резонаторы 
Рис.3.153 Рис.3.154 

на 1 мм, сдвиньте нижний заземляющий проводник с резонаторами на 1 мм вверх. За-
тем уменьшите размер Y-Dimension (mm) тоже на 1 мм и соответственно измените ко-
личество клеток в поле Y-Divisions. Выполните анализ. Характеристика (рис. 3.154) 



близка к заданной полосе пропускания, но её нужно расширить и сдвинуть вверх по 
частоте. Т.е. нужно уменьшить зазоры между резонаторами и укоротить резонаторы. 
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сдвиньте его вправо на 1.2 мм. 

ым окно графика LdB и 

ей фильтра получают-

ромагнитной структуры в 

у Substrate Information на пане-

натору, затем щёлкните 

7. Уменьшим все зазоры на 0.6 мм. Дважды щёлкните по третьему резонатору, установи-
те курсор мышки на ромбик посередине правой стороны, нажмите кнопку мышки и 
сдвиньте эту сторону вправо на 0.6 мм, затем также сдвиньте левую сторону этого ре-
зонатора, чтобы его ширина не изменилась. Дважды щёлкните по второму резонатору и 

Аналогично сдвиньте первый резонатор вправо на 1,8 
мм. Таким же образом сдвиньте влево послед-
ние три резонатора. Укоротите все резонаторы 
на 0.6 мм. Соедините входной и выходной про-
водники с крайними резонаторами. Сдвиньте 
нижний заземляющий проводник вместе с под-
ключёнными к нему резонаторами на 0.6 мм 
вверх. Щёлкните мышкой по значку Substrate 
Information на панели инструментов и умень-
шите размер Dimension (mm) тоже на 0.6 мм и 
соответственно измените количество клеток в 
поле Y-Divisions. 

8. Сделайте активн
щёлкните по значку Analyze на панели инстру-

ментов. Полученная характеристика (рис. 3.155) удовлетворя-
ет поставленным требованиям и расположена несколько выше 
по частоте, что обеспечивает запас для настройки. 
Габаритные размеры платы с топологи

Рис.3.155 

ся равными 44х31,4. С целью более эффективного использования 
стандартных подложек размером 48х60 потребуем, чтобы на одной 
подложке размещалась топология двух фильтров. При этом ширина 
электромагнитной структуры (т.е. размер по оси Y) должны быть 
несколько меньше 30 мм. Для выполнения этого требования резо-
наторы сделаем ступенчатыми. 

1. Установите курсор на имя элект
левом окне проекта, нажмите левую кнопку мышки и пере-
местите курсор на группу EM Structures. Щёлкните правой 
кнопкой мышки по имени полученной копии структуры и пе-
реименуйте её в F925_960A. 

2. Щёлкните мышкой по значк

Рис.3.156

ли инструментов. На вкладке Enclosure в поле Y-Dimension 
(mm) введите 29, в поле Y-Divisions введите 290, нажмите OK. 

3. Уменьшите длину всех резонаторов на 2.4 мм. Затем сдвиньте 
нижний заземляющий проводник вместе с подключёнными к 
нему резонаторами на 2,4 мм вверх. 

4. Щёлкните мышкой по первому резо
по значку Notch Conductor на панели инструментов. Устано-
вите курсор на нижний левый угол резонатора, нажмите кноп-
ку мышки и сдвиньте курсор влево на 0.2 и вверх на 6.5 (рис. 
3.156). Снова щёлкните по значку Notch Conductor, установи-
те курсор на нижний правый угол резонатора, нажмите кнопку 

мышки и сдвиньте курсор вправо на 0.2 и вверх на 6.5. Дважды щёлкните мышкой по 
первому резонатору, установите курсор на ромбик посередине левой стороны узкой 
части резонатора и сдвиньте эту сторону на 0.4 мм вправо. Аналогично сдвиньте влево 
на 0.4 мм правую сторону узкой части резонатора. Первый резонатор должен иметь 
вид, показанный на рис. 3.157. Его ширина в узкой части равна 1,4 мм, а в широкой 
части – 2.6 мм. 

Рис.3.157 



5. Аналогично отредактируйте все резонаторы и удлините входной и выходной провод-
ники до соединения с крайними резонаторами. 
Сделайте активным окно графика LdB и щёлк-
ните по значку Analyze на панели инструмен-
тов. Полученный график показан на рис. 3.158. 

6. Из полученной характеристики видно, что её 
нужно сдвинуть вверх и расширить, т.е. нужно 
уменьшить зазоры между резонаторами и повы-
сить резонансную частоту. Изменять резонанс-
ную частоту резонаторов можно, изменяя соот-
ношение размеров между индуктивной и емко-
стной частями резонаторов. Путём подбора раз-
меров топологии можно получить электромаг-
нитную структуру, показанную на рис. 3.159. 
Характеристика этой структуры – на рис. 3.160. 

Она получилась шире требуемой. Сузить полосу можно, уменьшая зазоры между резо-
наторами. Или уменьшить расстояние до верхней крышки. В этом случае обычно в 
большей мере сдвигается вверх по частоте нижний скат характеристики, что и требует-
ся в нашем случае. Откройте окно структуры F925_960A. Щёлкните мышкой по значку 

Substrate Information на панели инструментов. 
На вкладке Dielectric Layers для слоя 1 измени-
те толщину на 5 мм. 

Рис.3.158 

Рис.3.160 Рис.3.159 

7. Сделайте активным окно графика LdB и щёлк-
ните по значку Analyze на панели инструмен-
тов. Полученный график показан на рис. 3.161.  
Характеристика удовлетворяет требованиям в 

полосе пропускания, но недостаточное ослабление на 
частотах заграждения. Поэтому добавим в электро-
магнитную структуру ещё два резонатора. Добавлять 
резонаторы нужно в центре структуры. Размеры до-
бавляемых резонаторов и зазоры должны быть таки-
ми же, что имеет средний резонатор. Это не должно 

сильно повлиять на характеристику в полосе пропускания, хотя потери увеличатся. Затем 
размеры средних резонаторов можно подкорректировать, если потребуется. 

Входной и выходной проводники нашей структуры имеют большие размеры. Их 
можно уменьшить и за счёт этого разместить топологию с добавленными резонаторами в том 
же корпусе или даже уменьшить его длину. Удалите структуру F925_960 и переименуйте ос-
тавшуюся структуру F925_960A в F925_960. 

Рис.3.161 
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1. Сделайте активным окно электромагнитной структуры. Дважды щёлкните по входно-
му проводнику и укоротите его, сместив правую сторону влево так, чтобы длина вход-

ного проводника была равна 3 мм. Анало-
гично укоротите выходной резонатор. Вы-
делите все резонаторы и сдвиньте их влево 
до соединения с входным проводником. 
Сдвиньте последние три резонатора вправо 
на 8.4 мм. 

2. Щёлкните по значку Polygon Conductor 
на панели инструментов. Поместите курсор 
на нижнюю сторону верхнего заземляюще-
го проводника справа от четвёртого резона-
тора, щелкните мышкой и затем переме-
щайте курсор, щёлкая мышкой, на 19.6 

вниз, на 0.6 влево, на 6.0 вниз, на 2.2 вправо, на 6.0 вверх, на 0.6 влево, на 19.6 вверх и 
здесь дважды щёлкните мышкой. Топология будет иметь вид, показанный на рис. 
3.162. Щёлкните по добавленному резонатору правой кнопкой мышки и выберите 
Mesh/Material Properties. В открывшемся окне выберите материал 1/2oz Cu. Устано-
вите курсор на добавленный резонатор, нажмите левую кнопку мышки и, сдвинув его 
вправо или влево, сделайте зазор между четвёртым и пятым резонаторами таким же, 
как и между третьим и четвёртым. 

Рис.3.162

3. Скопируйте добавленный резонатор, два раза щёлкните правой кнопкой мышки и 
подключите его к нижнему заземляющему проводнику. Затем сдвиньте его так, чтобы 
зазор между пятым и шестым резонаторами был равен зазору между четвёртым и пя-
тым резонаторами. Пользуясь инструментом Measure, убедитесь, что все симметрич-
ные элементы топологии фильтра имеют одинаковые размеры. Полученную топологию 
фильтра можно сдвинуть так, чтобы она располагалась симметрично относительно 
корпуса, а входной и выходной проводники имели одинаковую или примерно одинако-
вую длину. Можно также изменить длину корпуса при необходимости. 

4. Чтобы точнее отобразить характеристику в полосе пропускания, дважды щёлкните по 
Project Options в левом окне проекта и добавьте частоты 0.925, 0.935 и 0,965. Выпол-
ните анализ. 

Окончательная топология показана на рис. 3.163. На рис. 3.164 показаны расчётная 
характеристика (сплошная линия) и характеристика макета после настройки (пунктирная ли-
ния). 

Рис.3.164 

Рис.3.163 
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3.8. Встречноштыревой фильтр с полосой пропускания 5 – 7 
ГГц. 

Требуется спроектировать фильтр с полосой пропускания от 5 до 7 ГГц. В полосе час-
тот от 8 до 19 ГГц ослабление должно быть не менее 40 дБ. 

3.8.1. Синтез фильтра. 
Для синтеза фильтра воспользуемся мастером синтеза Microwave Office. Поскольку 

крутизна скатов требуется высокой, синтезируем фильтр с 9-ю резонаторами. 
1. Создайте новый проект и сохраните его под име-
нем F5-7. 
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2. Раскройте группу Wizards и дважды щёлкните по 
подгруппе Filter Synthesis Wizard. 

3. В открывающихся окнах последовательно выбе-
рите Bandpass, Chebyshev, количество резонаторов 
N=9, нижняя частота полосы пропускания FL=5, 
верхняя частота полосы пропускания FH=7, Inter-
digital Resonators, Short-Circuited Transformer, 
Microsctrip, Name=Fil, Er=10.35, Tand=0.0001, 
H=0.5, T=0.005, выберите материал Copper, сни-
мите “галочку” в Input Return Loss (S11). 

4. Щёлкните по значку Analyze. Полученный график 
показан на рис. 3.165. Как видно из полученной характеристики, мас-
теру синтеза на удалось синтезировать фильтр с характеристикой, 
близкой к требуемой. Можно попытаться настроить фильтр, исполь-
зуя блок настройки, или создать свою схему, отличную от созданной 
Мастером синтеза. Мы сделаем второе, создав схему фильтра с кон-
дуктивной связью. 

Рис. 3.165 

5. Щёлкните правой кнопкой мышки по имени схемы Fil в левом окне проекта и выбери-
те Delete Schematic. Аналогично удалите созданные мастером график, цели оптимиза-
ции и подгруппу фильтра Design в группе Filter Synthesis Wizard. 

Рис. 3.166

6. Элемент подложки поместим в Global Definitions (Глобальные определения), откуда 
она будет доступна для всех схем в проекте, которые могут потребоваться. Дважды 
щёлкните по Global Definitions в левом окне проекта. Откройте вкладку Elem в левом 
окне проекта, щёлкните мышкой по Substrates и перетащите в правое окно элемент 

MSUB. Дважды щёлкните по этому эле-
менту и введите Er=10.35, H=0.5, T=0.005, 
Tand=0.0001 и ErNom=10.35, нажмите 
OK (рис. 3.166). 

7. Щёлкните по значку New Schematic и 
создайте схему с именем Fil. 

8. Раскройте группу Microstrip, щёлкните 
левой кнопкой по Lines и перетащите в 
окно схемы элемент MLIN. В левом окне 
проекта щёлкните по Junctions, перетащи-
те в окно схемы элемент MTEE, разверни-

те его, щёлкая правой кнопкой мышки, и подключите плечо 3 этого элемента к MLIN. 
В левом окне проекта щёлкните по Coupled Lines, перетащите в окно схемы элемент 
M9CLIN, разверните его и подключите плечо 1 этого элемента к плечу 1 элемента 
MTEE. Должна получиться схема, показанная на рис. 3.167. 

Рис. 3.167

9. Нажмите клавишу Shift и щёлкните по элементам MLIN и MTEE. Щёлкните по знач-
кам Copy и Paste на панели инструментов, разверните скопированные элементы на 180 
градусов и подключите к плечу 9 элемента M9CLIN. Аналогично скопируйте элемент 
M9CLIN и подключите его плечом 10 к плечу 2 первого элемента MTEE. Перетащите 



в окно схемы элемент M7CLIN и подключите его между элементами M9CLIN. Должна 
получиться схема, показанная на рис. 3.168. 

Рис. 3.168

10. Щёлкните по подгруппе Other в левом окне проекта и, перетаскивая элемент MOPEN 
в окно схемы, подключите его к нечётным плечам верхнего и нижнего элементов 
M9CLIN. 

11. Щёлкая по значку Ground, подключите землю к чётным плечам верхнего и нижнего 
элементов M9CLIN. 

12. Щёлкая по значку Port, установите порты на входе и выходе схемы. Окончательная 
схема показана на рис. 3.169. 

Рис. 3.169
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3.8.2. Добавление переменных и редактирование схемы. 
1. Щёлкните по значку Equation на панели инструментов и введите переменную LR=4.7 

(длина резонаторов, равная примерно четверти длины волны на частоте 6 ГГц), L1=1.8 
(расстояние от заземлённого конца крайних резонаторов до точки подключения кон-
дуктивной свзи), L2=LR-L1-0.5, W1=0.5, W2=0.5, W3=0.5, W4=0.5, W5=0.5, S1=0.2, 
S2=0.2, S3=0.2, S4=0.2. 

LR=4.7 
(длина резонаторов, равная примерно четверти длины волны на частоте 6 ГГц), L1=1.8 
(расстояние от заземлённого конца крайних резонаторов до точки подключения кон-
дуктивной свзи), L2=LR-L1-0.5, W1=0.5, W2=0.5, W3=0.5, W4=0.5, W5=0.5, S1=0.2, 
S2=0.2, S3=0.2, S4=0.2. 

2. Дважды щёлкните по первому элементу MLIN и введите W=0.5 и L=3. Такие же па-
раметры введите для последнего элемента MLIN. 

2. Дважды щёлкните по первому элементу MLIN и введите W=0.5 и L=3. Такие же па-
раметры введите для последнего элемента MLIN. 

3. Дважды щёлкните по верхнему элементу M9CLIN и введите W1=W1, W2=W2, 
W3=W3, W4=W4, W5=W5, W6=W4, W7=W3, W8=W2, W9=W1, S1=S1, S2=S2, S3=S3, 
S4=S4, S5=S4, S6=S3, S7=S2, S8=S1 и L=L1. Такие же параметры введите для нижнего 
элемента M9CLIN, только длину введите L=L2. 

3. Дважды щёлкните по верхнему элементу M9CLIN и введите W1=W1, W2=W2, 
W3=W3, W4=W4, W5=W5, W6=W4, W7=W3, W8=W2, W9=W1, S1=S1, S2=S2, S3=S3, 
S4=S4, S5=S4, S6=S3, S7=S2, S8=S1 и L=L1. Такие же параметры введите для нижнего 
элемента M9CLIN, только длину введите L=L2. 

4. Дважды щёлкните по элементу M7CLIN и введите W1=W2, W2=W3, W3=W4, 
W4=W5, W5=W4, W6=W3, W7=W2, S1=S2, S2=S3, S3=S4, S4=S4, S5=S3, S6=S2 и 
L=0.5. 

4. Дважды щёлкните по элементу M7CLIN и введите W1=W2, W2=W3, W3=W4, 
W4=W5, W5=W4, W6=W3, W7=W2, S1=S2, S2=S3, S3=S4, S4=S4, S5=S3, S6=S2 и 
L=0.5. 

5. Дважды щёлкните по элементу MTEE и введите W1=W1, W2=W1 и W3=0.5. Такие 
же параметры введите для последнего элемента MTEE. 

5. Дважды щёлкните по элементу MTEE и введите W1=W1, W2=W1 и W3=0.5. Такие 
же параметры введите для последнего элемента MTEE. 

6. Дважды щёлкая по элементам MOPEN, введите для каждого из них значение пара-
метра W, такое же, как у подключённого плеча элемента M9CLIN. Отредактированная 
схема показана на рис. 3.170. 

6. Дважды щёлкая по элементам MOPEN, введите для каждого из них значение пара-
метра W, такое же, как у подключённого плеча элемента M9CLIN. Отредактированная 
схема показана на рис. 3.170. 

Рис. 3.170 

3.8.3. Анализ и настройка схемы. 3.8.3. Анализ и настройка схемы. 
1. Откройте вкладку Proj в левом окне проекта. Дважды щёлкните по Project Options. 
На вкладке Frequencies в поле Start(GHz) введите 4, в поле Stop(GHz) введите 8, в по-
ле Step(GHz) введите 0.25, нажмите Apply и OK. 

1. Откройте вкладку Proj в левом окне проекта. Дважды щёлкните по Project Options. 
На вкладке Frequencies в поле Start(GHz) введите 4, в поле Stop(GHz) введите 8, в по-
ле Step(GHz) введите 0.25, нажмите Apply и OK. 

2. Щёлкните по значку New Graph на панели инструментов и создайте график с именем 
LdB. Щёлкните правой кнопкой мышки по имени созданного графика в левом окне 
проекта и выберите Add Measurement. В открывшемся окне отметьте Port Parameters 

2. Щёлкните по значку New Graph на панели инструментов и создайте график с именем 
LdB. Щёлкните правой кнопкой мышки по имени созданного графика в левом окне 
проекта и выберите Add Measurement. В открывшемся окне отметьте Port Parameters 
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и S, в поле To Port Index введите 2, в поле From Port Index введите 1, отметьте dB, 
нажмите Apply и OK. 
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3. Щёлкните по значку Analyze на панели инст-
рументов. Щёлкните по графику правой кноп-
кой мышки и выберите Properties. На вкладке 
Axes открывшегося окна для оси x снимите 
“галочки” в Auto limits и в Auto divs, в поле 
Min введите 4, в поле Max введите 8, в поле 
Step введите 0.5. Для оси Left 1 снимите “га-
лочки” в Auto limits и в Auto divs, в поле Min 
введите -60, в поле Max введите 0, в поле Step 
введите 5. Нажмите Apply и OK. Полученный 
график показан на рис. 3.171. 

4. Сделайте активным окно схемы. Щёлкните 
по значку Tune Tool на панели инструментов, 

переместите курсор в окно схемы и, щёлкая по переменным, назначьте для настройки 
все переменные, кроме L2. 

Рис. 3.171 

5. Сделайте активным окно 
графика. Щёлкните по 
значку Tune и, двигая 
движки переменных на 
блоке настройки, добей-
тесь приемлемой характе-
ристики (рис. 3.172). Ок-
руглите полученные зна-
чения переменных до пя-
ти сотых. Это можно сде-
лать или в окне схемы, 
или на блоке настройки, 
отредактировав значения 
в строке Nom-> блока на-
стройки. Переменные по-
лучили значения (после 
округления): LR=4.4, 
L1=1.8, W1=0.9, W2=0.5, 

W3=0.45, W4=0.45, W5=0.4, S1=0.2, S2=0.35, S3=0.45 и S4=0.45. 

Рис. 3.172 

3.8.4. Создание электромагнитной структуры. 
1. Сделайте активным окно схемы и щёлкните по значку New Schematic Layout View на 
панели инструментов. Затем выделите все элементы топологии, выбрав в меню коман-
ду Edit>Select All, и щёлкните по значку Snap Together на панели инструментов. По-

лученная топология схемы пока-
зана на рис. 3.173. Щёлкая по 
значку Measure на панели инст-
рументов, определим размер то-
пологии 13.9х4.4 мм. 

2. Электромагнитную структуру 
создадим в редакторе электро-
магнитной структуры. Выберем 
ширину заземляющих проводни-

ков 0.8 мм и зазор между резонаторами и заземляющими проводниками 0.3 мм. Тогда 
ширина корпуса должна быть равна 4.4+2*0.8+0.3=6.3 мм. Щёлкните по значку New 
EM Structure и создайте электромагнитную структуру с именем F5_7. 

Рис. 3.173 



3. Щёлкните по значку Substrate Information на панели инструментов. В открывшемся 
окне на вкладке Enclosure в поле X-Dimension(mm) введите 13.9, в поле X-Divisions 

введите 278, в поле Y-
Dimension(mm) введите 6.3, в поле 
Y-Divisions введите 126. На вклад-
ке Dielectric Layers для слоя 1 
введите толщину слоя 6 мм. Для 
слоя 2 введите толщину слоя 0.5, 
диэлектрическую проницаемость 
10.35, тангенс потерь 0.0001, мас-
штаб отображения 4 (рис. 3.174), 
нажмите OK. 

4. Щёлкните по значку Rectangle 
Conductor, поместите курсор в 
поле электромагнитной структуры 
и нажмите клавишу Tab. В от-

рывшемся окне в поле x введите 3, в поле y введите 0, нажмите OK и затем клавишу 
Tab. В отрывшемся окне в поле dx введите 7.9, в поле y введите 0.8, нажмите OK. 

Рис. 3.174 

5. Щёлкните по значку Rectangle Conductor, поместите курсор в поле электромагнитной 
структуры и нажмите клавишу Tab. В отрывшемся окне в поле x введите 4.1, в поле y 
введите 6.3, нажмите OK и затем клавишу Tab. В отрывшемся окне в поле dx введите 
5.7, в поле dy введите -0.8, нажмите OK. 

6. Щёлкните по значку Rectangle Conductor на панели инструментов, поместите курсор 
в поле электромагнитной структуры и нажмите клавишу Tab. В отрывшемся окне в по-
ле x введите 3, в поле y введите 0,8, нажмите OK и затем клавишу Tab. В отрывшемся 

окне в поле dx введите 0.9, в поле dy введите 4.4, 
нажмите OK. Щёлкните по значкам Copy и Paste 
на панели инструментов (созданный резонатор 
должен быть выделен). Подключите скопирован-
ный резонатор к правому краю верхнего зазем-
ляющего проводника. 

7. Щёлкните по значку Rectangle Conductor на па-
нели инструментов, поместите курсор в поле элек-
тромагнитной структуры и нажмите клавишу Tab. 
В отрывшемся окне в поле x введите 4.1, в поле y 
введите 5.5, нажмите OK и затем клавишу Tab. В 
отрывшемся окне в поле dx введите 0.5, в поле dy 
введите -4.4, нажмите OK. Скопируйте созданный 
резонатор и подключите его к правому краю ниж-
него заземляющего проводника. Должна получить-
ся топология, показанная на рис. 3.175. 

Рис. 3.175 

8. Щёлкните по значку Rectangle Conductor на па-
нели инструментов, поместите курсор в поле элек-
тромагнитной структуры и нажмите клавишу Tab. 
В отрывшемся окне в поле x введите 4.95, в поле y 
введите 0.8, нажмите OK и затем клавишу Tab. В 
отрывшемся окне в поле dx введите 0.45, в поле dy 
введите 4.4, нажмите OK. Щёлкните по значкам 

Copy и Paste на панели инструментов. Подключите скопированный резонатор левее 
предпоследнего резонатора на расстоянии 0.35 мм. Должна получиться топология, по-
казанная на рис. 3.176. 

Рис. 3.176 

9. Снова щёлкните по значку Paste на панели инструментов и подключите резонатор к 
нижнему заземляющему проводнику на расстоянии 0.45 мм правее третьего резонато-
ра. Повторите этот шаг и подключите резонатор к нижнему заземляющему проводнику 
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на таком же расстоянии от третьего резонатора справа. Снова повторите этот шаг и 
подключите резонатор к верхнему заземляющему проводнику на расстоянии 0.45 мм 
правее четвёртого резонатора. Дважды щёлкните по этому резонатору, установите кур-
сор на ромбик посередине его правой стороны, нажмите левую кнопку мышки и 
сдвиньте эту сторону влево на 0.05 мм. 

10. Щёлкните по значку Rectangle Conductor на панели инструментов, поместите курсор 
в поле электромагнитной структуры и нажмите клавишу Tab. В отрывшемся окне в по-
ле x введите 0, в поле y введите 1.8, нажмите OK и затем клавишу Tab. В отрывшемся 

окне в поле dx введите 3, в поле dy введите 
0.5, нажмите OK. Скопируйте созданный 
входной проводник и подключите его к по-
следнему резонатору на расстоянии 1.8 мм от 
верхнего края электромагнитной структуры. 

11. Щёлкните по входному проводнику, чтобы 
выделить его. Затем щёлкните по значку 
Edge Port на панели инструментов и устано-
вите порт на входе фильтра. Щёлкните мыш-
кой по квадратику порта, установите курсор 
на правую сторону квадратика так, чтобы 

курсор отображался в виде двойной стрелки, и сдвиньте референсную плоскость порта 
на 1 мм вправо. Аналогично установите порт на выходе фильтра. Созданная топология 
должна быть такой, как показано на рис. 3.177. 

Рис. 3.177

3.8.5. Анализ и редактирование электромагнитной структуры. 
1. Установите курсор левее и выше электромагнитной структуры, нажмите левую кноп-
ку мышки и, не отпуская кнопки, переместите курсор правее и ниже электромагнитной 
структуры, чтобы выделить все элементы топологии. Щёлкните по любому элементу 

топологии правой кнопкой мышки и выберите 
Mesh/Material Properties. В открывшемся 
окне в выпадающем списке Selected Material 
выберите 1/2oz Cu и нажмите OK. 

2. Сделайте активным окно графика и щёлкни-
те по значку Analyze на панели инструментов. 
График показан на рис. 3.178. 

3. Чтобы сдвинуть характеристику вверх по 
частоте, укоротим резонаторы. Сделайте ак-
тивным окно электромагнитной структуры. 
Дважды щёлкните по первому резонатору, ус-
тановите курсор на ромбик посередине ниж-
ней стороны резонатора, нажмите левую 
кнопку мышки, и сдвиньте эту сторону на 0.2 
мм вверх. На столько же укоротите длину по-
следнего резонатора. Аналогично укоротите 
все внутренние резонаторы на 0,4 мм. Нажми-
те клавишу Shift и, щёлкая мышкой по ниж-
нему заземляющему проводнику и резонато-
рам, соединённым с этим проводником (рис. 
3.179), выделите указанные топологические 
элементы. Установите курсор на любой выде-
ленный элемент и, нажав левую кнопку мыш-
ки, переместите все выделенные элементы 
вверх на 0.4 мм. Щёлкните по значку Sub-
strate Information на панели инструментов. 

Рис. 3.178

Рис. 3.179 
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На вкладке Enclosure открывшегося окна в поле Y-Dimension(mm) введите 5.9, в поле 
Y-Divisions введите 118, нажмите OK. 

4. Сделайте активным окно графика и щёлк-
ните по значку Analyze на панели инстру-
ментов. График показан на рис. 3.180. 

5. Сделайте активным окно электромагнит-
ной структуры. Укоротите, как описано вы-
ше, следующие резонаторы: второй и вось-
мой резонаторы на 0.25, третий, четвёртый, 
шестой и седьмой на 0.1. Выделите, как 
описано в п.3 нижний заземляющий про-
водник и резонаторы, соединённые с ним, и 
сдвиньте их вверх на 0.1. Щёлкните по 
значку Substrate Information на панели ин-
струментов. На вкладке Enclosure открыв-
шегося окна в поле Y-Dimension(mm) вве-
дите 5.8, в поле Y-Divisions введите 116, 
нажмите OK. 

Рис. 3.180 

6. Сделайте активным окно графика и щёлк-
ните по значку Analyze на панели инстру-
ментов. Чтобы лучше отобразить график в 
переходной области, можно добавить ещё 
пару частот. Дважды щёлкните по Project 
Options в левом окне проекта. В открыв-
шемся окне на вкладке Frequencies отметь-
те Add и Single point, в поле Point(GHz) 
введите 4.85 и нажмите Apply. Затем в это 
поле введите 7.15, нажмите Apply и OK. 

Щёлкните по значку Analyze на панели 
инструментов. График показан на рис. 
3.181. 

Рис. 3.181

7. Создайте график коэффициента отра-
жённой волны. Для этого щёлкните по 
значку New Graph на панели инстру-
ментов и создайте график с именем 
KstU. Щёлкните по имени созданного 
графика в левом окне проекта и выбе-
рите Add Measurement. В области 
Meas. Type отметьте Linear, в области 
Measurement отметьте VSWR, в поле 
Port Index введите 1, снимите “галоч-
ку” в dB, нажмите Apply и OK (рис. 

3.182). Щелкните по значку Analyze на па-
нели инструментов. Щёлкните правой 
кнопкой мышки по полученному графику и 
выберите Properties. В открывшемся окне 
для оси x снимите “галочки” в Auto limits 
и в Auto divs, в поле Min введите 4.6, в по-
ле Max введите 7.4, в поле Step введите 
0.2. Для оси Left 1 снимите “галочки” в 
Auto limits и в Auto divs, в поле Min вве-
дите 0, в поле Max введите 10, в поле Step 
введите 0.5. Нажмите Apply и OK. Полу-
ченный график показан на рис. 3.183. 

Рис. 3.182 
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Полученные характеристики в основном удовлетворяют требованиям в заданной по-
лосе пропускания, однако согласование фильтра можно ещё улучшить. Обратите внимание, в 
отличие от всех ранее приводимых примеров, в этом примере моделирования фильтра мы 
редактировали одну и ту же топологию, не создавая её копий. Это можно делать, если есть 
уверенность, что отредактированная структура будет лучше предыдущей. Что нужно сделать 
теперь для улучшения согласования, определить не просто. Поэтому создадим копию струк-
туры, чтобы можно было сравнивать получаемые результаты с предыдущими. 

8. Установите курсор на имя структуры в левом окне проекта, нажмите левую кнопку 
мышки и переместите курсор на группу EM Structures. Щёлкните по имени копии 
структуры правой кнопкой мышки, выберите Rename EM Structure и переименуйте её 
в F5_7A. 

9. Дважды щёлкните мышкой по пятому резонатору, установите курсор на ромбик посе-
редине левой стороны и сдвиньте эту сторону на 0.05 мм вправо, сделав ширину сред-
него резонатора 0.35 мм. Выделите первые четыре резонатора, нажав клавишу Shift и 
щёлкая по ним мышкой. Сдвиньте эти резонаторы вправо на 0.05 так, чтобы расстояние 
между четвёртым и пятым резонаторами было равно 0.45 мм. Дважды щёлкните по 
четвёртому резонатору, установите курсор на ромбик посередине левой стороны и 
сдвиньте эту сторону на 0.05 мм вправо, сделав ширину среднего резонатора 0.4 мм. 
Выделите первые три резонатора и сдвиньте эти резонаторы вправо на 0.1 так, чтобы 
расстояние между третьим и четвёртым резонаторами было равно 0.4 мм. Дважды 

щёлкните по шестому резонатору, установите 
курсор на ромбик посередине правой стороны 
и сдвиньте эту сторону на 0.05 мм влево, сде-
лав ширину этого резонатора 0.4 мм. Выделите 
седьмой, восьмой и девятый резонаторы, 
сдвиньте эти резонаторы на 0.1 влево, чтобы 
расстояние между шестым и седьмым резона-
торами было равно 0.4 мм. Дважды щёлкните 
по верхнему заземляющему проводнику и 
сдвиньте его левую сторону вправо до первого 
резонатора, затем сдвиньте правую сторону 
влево до последнего резонатора. То же самое 
сделайте с нижним заземляющим проводни-
ком, совместив его крайние стороны со вторым 
и предпоследним резонаторами. Дважды 

щёлкните по входному проводнику и соедините его правую сторону с первым резона-
тором, затем соедините выходной проводник с последним резонатором. Сделайте ак-
тивным окно графика KstU и щёлкните по значку Analyze на панели инструментов. 
Рассчитанный график показан на рис. 3.184. Согласование можно ещё улучшить, если 

сделать следующее. 

Рис. 3.184 

10. Удалите предыдущую структуру F5_7, создайте копию ос-
тавшейся структуры F5_7A и переименуйте её в F5_7. Вы-
делите входной и выходной проводники, нажав клавишу 
Shift и щёлкая по ним мышкой. Сдвиньте эти проводники 
вниз на 0.05. Выделите первый резонатор, щёлкнув по нему 
мышкой. Щёлкните по значку Notch Conductor (Выемка 
проводника), установите курсор на нижний левый угол про-
водника, нажмите левую кнопку мышки, переместите кур-
сор на 0.45 вверх и на 0.25 вправо (рис. 3.185), отпустите 
кнопку. Аналогично сделайте выемку на последнем резона-
торе со стороны выхода. Выделите второй резонатор. 
Щёлкните по значку Notch Conductor. Установите курсор 

на верхней стороне этого резонатора на расстоянии 0.15 мм от левой стороны резона-
тора, нажмите левую кнопку мышки, переместите курсор на 0.1 вниз и на 0.2 вправо. 

Рис. 3.185 
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Должна получиться 

ьная топология фильтра показана на рис. 
3.187.  

ной структуры 
удовле

е   

выемка, показанная на рис. 3.186. Аналогичную выемку сделайте 
на предпоследнем резонаторе. Сделайте активным окно 
графика KstU и щёлкните по значку Analyze на панели 
инструментов. Удалите больше ненужные схему Fil и 
электромагнитную структуру F5_7A. 
Окончател
График характеристики ослабления на рис. 3.188, а гра-

фик коэффициента стоячей волны на рис. 3.189. 
Характеристики созданной электромагнит
творяют заданным требованиям в полосе пропускания. 

Чтобы просмотреть характеристику в полосе заграждения, два-
жды щёлкните по Project Options в левом окне проекта. В от-

крывшемся окне на вкладке Frequencies от-
метьте Add, в поле Start(GHz) введите 9, в 
пол  Stop(GHz) введите 19, в поле 
Step(GHz) введите 1, нажмите Apply и OK. 
Сделайте активным окно графика LdB, 
щёлкните по графику правой кнопкой мыш-
ки и выберите Properties. В открывшемся 
окне на вкладке Axes для оси x в поле Max 
введите 19, в поле Step введите 1, нажмите 
Apply и OK. Щёлкните по значку Analyze 
на панели инструментов. Из полученного 
графика (рис. 3.190, сплошная линия) видно, 
что следующая полоса пропускания фильтра 

Рис. 1.186 

Рис. 3.187

Рис. 3.188 Рис. 3.189 

Рис. 3.190 



попадает в заданную полосу заграждения и её нужно подавить. Следует также иметь ввиду, 
что при увеличении частоты увеличивается и диэлектрическая проницаемость, т.е. вторая 
полоса пропускания будет начинаться на частоте более низкой. Чтобы убедиться в этом, соз-
дайте копию электромагнитной структуры и переименуйте её в F5_7A. Щёлкните по значку 
Substrate Information на панели инструментов и на вкладке Dielectric Layers для слоя 2 из-
мените диэлектрическую проницаемость на 10.75. Сделайте активным окно графика LdB и 
щёлкните по значку Analyze на панели инструментов. Характеристика показана на рис. 3.190 
пунктирной линией. Эта характеристика более точна в верхней части диапазона. Удалите 
структуру F5_7A. 

3.8.6. Проектирование фильтра нижних частот. 
1. Щёлкните по значку New Schematic на панели инструментов и создайте схему с име-
нем Fn. 

2. Откройте вкладку Elem в левом окне проекта. Раскройте группу Microstrip, и щёлк-
ните по подгруппе Lines. Перетащи-
те элемент MLIN в окно схемы. За-
тем перетащите ещё один такой же 
элемент и соедините его с первым. 
Выделите оба элемента, скопируйте 
их, щёлкнув по значку Copy и затем 
по значку Paste на панели инстру-
ментов, и подключите к первым 
двум элементам. Снова перетащите 
элемент MLIN в окно схемы, щёлк-
ните три раза правой кнопкой мыш-
ки, чтобы развернуть его, и подклю-

чите к последнему элементу схемы. Выделите четыре первых элемента, скопируйте их, 
щёлкните два раза правой кнопкой мышки и подключите скопированные элементы к 
последнему элементу схемы. 

Рис. 3.191 

3. Щёлкните по значку Port на панели инструментов и подключите порт ко входу схемы. 
Аналогично подключите порт к выходу схемы. Должна получиться схема, показанная 
на рис. 3.191. 

4. Добавьте к схеме следующие переменные, щёлкая по значку Equation на панели ин-
струментов: LI1=1, LI2=1 (длины индуктивностей), LC1=1, LC2=1 (длины емкостей), 
WC1=1 и WC2=1 (ширины емкостей). 

5. Дважды щёлкните по первому элементу MLIN и введите параметры W=0.5 и L=3. Та-
кие же параметры введите для последнего элемента MLIN. 

6. Дважды щёлкните по второму элементу MLIN и введите параметры W=0.1 и L=LI1. 
Такие же параметры вве-
дите для предпоследнего 
элемента MLIN. 
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7. Дважды щёлкните по 
третьему элементу 
MLIN и введите пара-
метры W=WC1 и 
L=LC1. Такие же пара-
метры введите для седь-
мого элемента MLIN. 

8. Дважды щёлкните по 
четвёртому элементу 
MLIN и введите пара-
метры W=0.1 и L=LI2. 

Такие же параметры введите для шестого элемента MLIN. 
Рис. 3.192 



9. Дважды щёлкните по пятому элементу MLIN и введите параметры W=WC2 и L=LC2. 
Отредактированная схема показана на рис. 3.192. 

10. Щёлкните по значку Tune Tool на панели инструментов и, щёлкая по переменным, на-
значьте все переменные для настройки. 

11. Откройте вкладку Proj в левом окне проекта. Сделайте активным окно графика LdB и 
щёлкните по значку Analyze на панели инструментов. График показан на рис. 3.193. 

Рис. 3.193 

12. Щёлкните по значку Tune на панели инструментов и, двигая движки переменных на 
блоке настройки, добейтесь подходящей характеристики фильтра нижних частот (рис. 
3.194). Переменные получили значения: LI1=1.2, LI2=1.9, LC1=1.3, LC2=1.5, WC1=2.4 
и WC2=2.9. 

Рис. 3.194 

13. Сделайте активным окно схемы Fn и щёлкните по значку New Schematic Layout View 
на панели инструментов. Топология схемы показана на рис. 3.195. Щёлкнув по значку 

Measure на панели ин-
струментов, определим 
длину топологии 16.3 
мм. 

14. Выделите все элемен-
ты топологии и щёлк-
ните по значку Copy на 

панели инструментов. 

Рис. 3.195 

15. Щёлкните по значку New EM Structure на панели инструментов и создайте электро-
магнитную структуру с именем FilN. 

16. Щёлкните по значку Substrate Information на панели инструментов. В открывшемся 
окне на вкладке Enclosure в поле X-Dimension(mm) введите 16.3, в поле X-Divisions 
введите 326, в поле Y-Dimension(mm) введите 5.8, в поле Y-Divisions введите 116. На 
вкладке Dielectric Layers для слоя 1 введите толщину 6 мм. Для слоя 2 введите толщи-

ну 0.5, диэлектрическую про-
ницаемость 10.35, тангенс по-
терь 0.0001. Нажмите OK. 

17. Щёлкните по значку Paste на 
панели инструментов и вставь-
те скопированную топологию в 
электромагнитную структуру 
так, чтобы её края точно сов-
падали с краями корпуса. 

Щёлкните по входному проводнику топологии, затем щёлкните по значку Edge Port на 
панели инструментов, установите порт на входе фильтра и сдвиньте его референсную 
плоскость вправо на 1 мм. Аналогично установите порт на выходе фильтра и сдвиньте 

Рис. 3.196 
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его референсную плоскость влево на 1 мм. Выделите все элементы топологии, щёлкни-
те правой кнопкой мышки по любому элементу и выберите Mesh/Material Properties. 
В открывшемся окне на вкладке Conductor Material в выпадающем списке Selected 
Material выберите 1/2oz Cu и нажмите OK. Должна получиться структура, показанная 
на рис. 3.196. 

18. Сделайте активным окно графика LdB 
и щёлкните по значку Analyze на панели 
инструментов. График показан на рис. 
3.197. Полученную характеристику элек-
тромагнитной структуры необходимо 
сдвинуть вверх по частоте. Чтобы это 
сделать, нужно уменьшить ёмкости. 

19. Сделайте активным окно электромаг-
нитной структуры FilN. Дважды щёлк-
ните по первому емкостному проводни-
ку. Установите курсор на ромбик посе-
редине верхней стороны, нажмите левую 
кнопку мышки и переместите курсор на 
0.3 мм вниз. Аналогично сдвиньте ниж-

нюю сторону на 0.3 мм вверх. Ширина первого емкостного проводника должна стать 
равной 1,8 мм. Точно так же укоротите ширину последнего емкостного проводника. 

Рис. 3.197

20. Дважды щёлкните по второму емкостному проводнику. Сдвиньте его верхнюю сторо-
ну вниз на 0.2 мм, а нижнюю сторону – на 0.2 мм вверх. Ширина этого емкостного про-

водника должна стать равной 2,5 мм. Устано-
вите курсор на ромбик посередине левой сто-
роны этого проводника и сдвиньте его вправо 
на 0.5 мм. Выделите первый емкостной про-
водник и два первых индуктивных, нажав 
клавишу Shift, и щёлкая по проводникам 
мышкой, сдвиньте эти проводники вправо до 
соединения со средним емкостным провод-
ником. Дважды щёлкните по входному про-
воднику и, установив курсор на середину его 
правой стороны, сдвиньте эту сторону вправо 
до соединения с первым индуктивным про-
водником.  

21. Сделайте активным график LdB и щёлкните 
по значку Analyze на панели инструментов. График показан на рис. 3.198. Его можно 
считать удовлетворительным. 

Рис. 3.198

3.8.7. Добавление фильтра нижних частот к полосовому и анализ. 
1. Сделайте активным окно электромагнитной структуры FilN. Выделите все проводни-
ки топологии, кроме входного. Для этого установите курсор левее первого индуктивно-
го проводника и выше всех проводников, нажмите левую кнопку мышки и переместите 
курсор правее выходного проводника и ниже всех проводников так, чтобы все провод-
ники, кроме входного, попали в образующийся прямоугольник. Отпустите кнопку 
мышки и щёлкните по значку Copy на панели инструментов. 

2. Сделайте активным окно электромагнитной структуры F5_7. Чтобы следить за влия-
нием добавленного фильтра нижних частот на характеристику в полосе пропускания, 
создайте копию этой электромагнитной структуры. Для этого установите курсор на имя 
структуры F5_7 в левом окне проекта, нажмите левую кнопку мышки и переместите 
курсор на группу EM Structures. Переименуйте созданную копию структуры в F5_7N. 
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3. В созданной структуре щёлкните мышкой по порту 2 и удалите этот порт, нажав кла-
вишу Delete.Дважды щёлкните по выходному проводнику, установите курсор на сере-



дину его правой стороны и сдвиньте эту сторону влево так, чтобы длина выходного 
проводника была равна 0.5 мм. 

4. Щёлкните по значку Paste на панели инст-
рументов и подключите скопированную то-
пологию к выходному проводнику. Щёлкнув 
правой кнопкой в окне электромагнитной 
структуры и выбрав Measure, измерьте дли-
ну всей получившейся топологии, она равна 
24.1 мм. Щёлкните по значку Substrate In-
formation на панели инструментов. В от-
крывшемся окне на вкладке Enclosure в поле 
X-Dimension(mm) введите 24.1, в поле X-
Divisions введите 482, нажмите OK. Щёлкни-
те мышкой по выходному проводнику, затем 
щёлкните по значку Edge Port на панели ин-

струментов и добавьте порт к выходному проводнику. 
Рис. 3.199 

5. Сделайте активным окно графика LdB. Удалите из проекта схему Fn и электромаг-
нитную структуру FilN, щёлкая по их именам правой кнопкой мышки, чтобы не затем-
нять график ненужными больше характеристиками. Щёлкните по значку Analyze на 
панели инструментов. Характеристика показана на рис. 3.199. Подавление в верхней 
части диапазона получилось недостаточным. Добавим заграждающий фильтр. 

3.8.8. Проектирование заграждающего фильтра. 
1. Используя встроенный инструмент Tools>TXLine, определим, что длина четверть-
волновых отрезков при диэлектрической проницаемости 10.75 и толщине подложки 0.5 
мм на частоте 18 ГГц равна примерно 1.5 мм. 

2. Щёлкните по значку New EM Structure на панели инструментов и создайте электро-
магнитную структуру и именем Fz. 

3. Щёлкните по значку Substrate Information на панели инструментов. В открывшемся 
окне на вкладке Enclosure в поле X-Dimension(mm) введите 8.5, в поле X-Divisions 
введите 170, в поле Y-Dimension(mm) введите 5.8, в поле Y-Divisions введите 116. На 
вкладке Dielectric Layers для слоя 1 введите толщину 6. Для слоя 2 введите толщину 
0.5, диэлектрическую проницаемость 10.75 и тангенс потерь 0.0001, Нажмите OK. 

4. Щёлкните по значку Rectangle Conductor на панели инструментов, переместите кур-
сор на электромагнитную структуру и нажмите клавишу Tab. В открывшемся окне в 
поле x введите 0, в поле y введите 2, нажмите OK и затем снова клавишу Tab. В от-
крывшемся окне в поле dx введите 8.5, в поле dy введите 0.5, нажмите OK. 

5. Снова щёлкните по значку Rectangle Conductor на панели инструментов, переместите 
курсор на электромагнитную структуру и нажмите клавишу Tab. В открывшемся окне 
в поле x введите 3, в поле y введите 2.5, нажмите OK и затем снова клавишу Tab. В от-
крывшемся окне в поле dx введите 0.5, в поле dy введите 1.5, нажмите OK. 

6. Скопируйте полученный резонатор и подключите его к нижней стороне общей линии 
на расстоянии 1.5 мм от первого. 

7. Щёлкните мышкой по общему проводнику и 
затем, щёлкая по значку Edge Port на панели 
инструментов, установите порты на входе и вы-
ходе фильтра и сдвиньте их референсные плос-
кости на 1 мм внутрь электромагнитной струк-
туры. 

Рис. 3.200 

8. Выделите все элементы топологии, щёлкните правой кнопкой мышки по любому из 
выделенных элементов, выберите Mesh/Material Properties и назначьте проводникам 
материал 1/2oz Cu. Должна получиться структура, показанная на рис. 3.200. 
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9. Сделайте активным окно графика LdB и щёлкните по значку Analyze на панели инст-
рументов. График вносимого ослабления показан на рис. 3.201, а график коэффициента 



отражения на рис. 3.202. Из графиков видно, что нужно улучшить согласование загра-
ждающего фильтра в полосе пропускания. 

Рис. 3.201 
10. Сделайте активным окно электромагнитной структуры 
заграждающего фильтра Fz. Дважды щёлкните по перво-
му резонатору, установите курсор на ромбик посередине 
правой стороны этого резонатора и сдвиньте эту сторону 
влево на 0.3 мм. Дважды щёлкните по второму резонато-
ру, установите курсор на ромбик посередине левой 
стороны этого резонатора и сдвиньте эту сторону вправо 
на 0.3 мм. Ширина резонаторов будет 0.2 мм. Установите 

курсор на первый резонатор, нажмите левую кнопку мышки и сдвиньте этот резонатор 
вправо на 0.1 мм, чтобы расстояние между резонаторами было равно 2 мм. Щёлкните 
по общему проводнику, затем щёлкните по значку Notch Conductor, установите курсор 
на верхнюю границу общего проводника напротив левой стороны первого резонатора, 

нажмите левую кнопку мышки и сдвиньте курсор на 0.2 мм вниз и вправо до правой 
стороны второго резонатора (рис. 3.203). 

Рис. 3.202 

Рис. 3.203 

Рис. 3.204 Рис. 3.205 

11. Сделайте активным окно графика LdB и щёлкните по значку Analyze. График вноси-
мого ослабления показан на рис. 3.204, а график коэффициента отражения на рис. 
3.202. Эти характеристики можно считать приемлемыми. 

3.8.9. Добавление заграждающего фильтра к полосовому и анализ. 
1. Сделайте активным окно электромагнитной структуры Fz. 
2. Щёлкните правой кнопкой мышки по имени этой структуры в левом окне проекта и 
выберите Toggle Enable (Переключатель блокировки), чтобы заблокировать выполне-
ние анализа этой структуры. 
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3. Щёлкните мышкой по квадратику порта 1 и нажмите клавишу Delete, чтобы удалить 
этот порт. Аналогично удалите другой порт. 

4. Дважды щёлкните по входному проводнику, уста-
новите курсор на ромбик посередине левой стороны 
этого проводника и сдвиньте эту сторону вправо 
так, чтобы длина входного проводника была равна 
0.3 мм. Должна получиться топология, показанная 
на рис. 3.206. Выделите всю эту топологию и щёлк-
ните по значку Copy на панели инструментов. 

Рис. 3.206 

5. Сделайте активным окно электромагнитной структуры F5_7N. Щёлкните мышкой по 
квадратику выходного порта 2 и удалите его. Щёлкните по значку Substrate Informa-
tion на панели инструментов. В открывшемся окне на вкладке Enclosure в поле X-
Dimension введите 27, в поле X-Divisions введите 540, нажмите OK. Дважды щёлкните 
по последнему (выходному) проводнику топологии, установите курсор на ромбик по-

середине правой стороны этого провод-
ника и сдвиньте его влево так, чтобы 
длина этого проводника была равна 0.2 
мм. Щёлкните по значку Paste на панели 
инструментов и подключите скопиро-
ванную топологию к выходному про-
воднику фильтра. Правый край скопи-
рованной топологии должен точно сов-
пасть с правым краем корпуса. В про-
тивном случае измените длину выход-
ного проводника так, чтобы его правый 
край совпадал с краем корпуса. Щёлк-
ните по выходному проводнику, затем 
щёлкните по значку Edge Port на пане-

ли инструментов и установите порт на выходе фильтра. 
6. Сделайте активным окно графика LdB и щёлкните по значку Analyze на панели инст-
рументов. Характеристика показана на рис. 3.207. Эта характеристика удовлетворяет 
предъявляемым требованиям, однако имеется выброс на частоте 16 ГГц, довольно 
близко доходящий до предельно допустимого значения. Этот выброс можно умень-
шить, точнее подобрав расстояние между фильтрами, и тем самым увеличить запас по 
величине ослабления в диапазоне заграждения. 

Рис. 3.207 
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7. Сделайте активным окно электромагнитной структуры F5_7N. Щёлкните по значку 
Substrate Information на панели инструментов. В открывшемся окне на вкладке Enclo-
sure в поле X-Dimension введите 27.5, в поле X-Divisions введите 550, нажмите OK. 
Выделите все элементы топологии фильтра нижних частот и заграждающего фильтра 
вместе с выходным проводником (рис. 3.208). Установите курсор на любой выделен-
ный элемент топологии, нажмите левую кнопку мышки и сдвиньте выделенную топо-
логию вправо на 0.15 мм. Дважды щёлкните по проводнику между полосовым фильт-
ром и фильтром нижних частот, сдвиньте правую сторону этого проводника вправо до 

Рис. 3.208 



соединения с фильтром нижних частот. Выделите элементы топологии заграждающего 
фильтра, нажав клавишу Shift и щёлкая по элементам мышкой (рис. 3.209). Сдвиньте 

эти элементы вправо на 0.3 мм. 
Дважды щелкните по выходному 
проводнику и сдвиньте его левую 
сторону влево до соединения с за-
граждающим фильтром, а правую - 
вправо до края электромагнитной 
структуры. Рис. 3.209 

Сделайте активным окно графика LdB и щёлкните по значку Analyze на панели инструмен-
тов. Расчётная характеристика показана на рис. 3.210. Характеристика макета, измеренная на 
Р2М-18 – на рис. 3.211. Окончательная топология на рис. 3.212. 

Рис. 3.210

Рис. 3.211 
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Рис. 3.212 
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